
INFORMATION 
COMMUNICATION 

TECHNOLOGY

STUDENT TEXTBOOK

Grade 10

Authors

Dixit J.B.

Saurabh Gupta

Evaluators

Gelan Tulu

Genene Tadesse

Zekarias Kebede

Federal Democratic Republic of Ethiopia
Ministry of Education

Laxmi Publications



Acknowledgements

The development, printing and distribution of this student textbook has been funded through the General Education 
Quality Improvement Project (GEQIP), which aims to improve the quality of education for Grades 1-12 students in 
government schools throughout Ethiopia.

The Federal Democratic Republic of Ethiopia received funding for GEQIP through credit/financing from the 
International Development Associations (IDA), the Fast Track Initiative Catalytic Fund (FTICF) and other development 
partners—Finland, Italian Development Cooperation, the Netherlands and UK aid from the Department for 
International Development (DFID).

The Ministry of Education wishes to thank the many individuals, groups and other bodies involved—directly and 
indirectly—in publishing the textbook and accompanying teacher guide.

© Federal Democratic Republic of Ethiopia, Ministry of Education

First edition, 2002 (E.C.)

ISBN: 978-99944-2-247-0

Developed, printed and distributed for the Federal Democratic Republic of Ethiopia, Ministry of Education by  Laxmi 
Publications Pvt. Ltd., India under GEQIP Contract No. ET-MoE/GEQIP/IDA/ICB/G-02/09-D

All rights reserved; no part of this publication may be reproduced, stored in a retrieval system, or transmitted in 
any form or by any means, electronic, mechanical, photocopying, recording, or otherwise without the prior written 
permission of the copyright owner or a licence permitting restricted copying in Ethiopia by the Federal Democratic 
Republic of Ethiopia, Federal Negarit Gazeta, Proclamation No. 410/2004 Copyright and Neighboring Rights Protection 
Proclamation, 10th year, No. 55, Addis Ababa, 19 July 2004.

Disclaimer

Every effort has been made to trace the copyright owners of material used in this document. We apologise in advance 
for any unintentional omissions. We would be pleased to insert the appropriate acknowledgement in any future 
edition.

Printed in India.



Contents

Unit 1:	 Introduction to ICT________________________________________________________________ 	 1

	 1.1	 Basics of ICT.................................................................................................................................. 	 1

	 1.2	 Computer System.......................................................................................................................... 	 9

		  Review Questions............................................................................................................................ 	 16

Unit 2:	 Application Software_______________________________________________________________ 	 18

	 2.1	 Key Features of Word Processing.............................................................................................. 	 18

	 2.2	 Key Features of Presentation Software and Techniques........................................................ 	 36

	 2.3	 Desktop Publishing....................................................................................................................... 	 44

		  Review Questions............................................................................................................................ 	 63

Unit 3:	 Information and Computer Security_________________________________________________ 	 65

	 3.1	 Information and Computer Security......................................................................................... 	 65

		  Review Questions............................................................................................................................ 	 73

Unit 4:	 Application Software_______________________________________________________________ 	 75

	 4.1	 Key Features of Spreadsheets..................................................................................................... 	 75

	 4.2	 Database Application.................................................................................................................... 	 89

		  Review Questions............................................................................................................................ 	 114

Unit 5:	 Using Internet_____________________________________________________________________ 	116

	 5.1	 Overview of the Internet.............................................................................................................. 	 116

	 5.2	 Definition of WWW...................................................................................................................... 	 123

	 5.3	 Planning and Developing Web Pages........................................................................................ 	 127

		  Review Questions............................................................................................................................ 	 134

Unit 6:	 Control and Learning with Logo__________________________________________________ 	136

	 6.1	 Control and Learning with Logo........................................................................................... 	 136

		  Review Questions............................................................................................................................ 	 143

	G lossary__________________________________________________________________________ 	145



PREFACE
Information and Communication Technology (ICT) is so important in the world today that it makes 
it imperative for every person to be competent in the use of ICT for the many tasks that one will have 
to accomplish. This book is written to provide the basic skills in ICT for Grade 10 students of Federal 
Democratic Republic of Ethiopia. It is expected that the knowledge and skills gained through this book 
will help the students to use ICT in almost all their courses at school. The book covers selected basic 
topics in ICT which offer hands-on activities to help students in acquiring the required ICT skills.
	 The key features of this book will help the students to:
	 l	 develop the basic ICT skills.
	 l	 understand the components of ICT and computer system.
	 l	 understand the application of word processing, presentation software and desktop publishing.
	 l	 understand the application of ICT & its elements for different purposes.
	 l	 understand  information and computer security and be aware with the copyright issues.
	 l	 understand the use of spreadsheet in creating charts, graphs and for different applications.
	 l	 learn database and use of Query, Form and Report in it.
	 l	 learn the uses of internet, download, upload files using the Internet and list some uses of the 

WWW.
	 l	 plan and develop a simple webpage.
	 l	 use variables in writing procedures and create a recursive procedure using LOGO language.
	 l 	follow basic ethics in the use of ICT.
	 l	 have excellent ICT skills which will serve them well in their future studies.
	 The text has been designed in a simple and user friendly way. This text focuses on the fundamentals 
of ICT, which change slowly. This not only makes the information remain useful to a student when 
one graduates, but also makes the student focus on the foundation concepts of ICT. This book also 
illustrates the latest developments in the rapidly changing world of ICT. Review questions have also 
been given at the end of each unit.
	 Suggestions for the improvement of this book will be gratefully acknowledged.

Authors
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Introduction  
to ICT

   Unit Outcome
	 Students will be able to:

	 	 understand the components of ICT;

	 	 recognize the major system unit components;

	 	 recognize the major motherboard components.

1.1 Basics of ICT

Let us revise some basic concepts of ICT that we have learned in the earlier grade.

l	R evision
When computer and communications technologies are combined, the result is Information and 
Communications Technology.

Fig. 1.1: Communications Technology—An important part of ICT

	 Information and Communications Technology (ICT) refers to the concept of using technology to get 
information. ICT involves the use of computers and other electronic devices to access information easily 
and quickly. Almost all the countries of the world, including Ethiopia, have recognized ICT as an important 
source to promote computer literacy and enhance the overall knowledge level of students. As evident 
from the above definition of ICT, this concept merges computing with high-speed communication links 
carrying data, sound and video. Examples of Information and Communications Technology include not 
only personal computers but also new forms of telephones, televisions, appliances, and various hand held 
devices.

Unit 1   
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l Components of ICT
ICT refers to technologies that provide access to information through  telecommunications. It is similar 
to  Information Technology  (IT), but focuses primarily on communication technologies. This includes 
the Internet, wireless networks, cell phones, and other communication media.
	 Modern Information and Communication Technologies have created a “global village”, in which people 
can communicate with others across the world, as if they were living next door. For this reason, ICT is 
often studied in the context of how modern communication technologies affect society.

What is an ICT System?

An ICT system is a set-up consisting of hardware, software, data and the people who use them. It commonly 
includes communications technology, such as the Internet.
	 ICT and computers are  not  the same thing. Computers are the  hardware  that is often part of an ICT 
system.

Input, Output and System Diagrams
What comes out of an ICT system is largely dependent on what you put into the system to begin with.
	 ICT systems work by taking inputs (instructions and data), processing them and producing outputs that 
are stored or communicated in some way. The better the quality of inputs, the more useful the outputs.

Garbage In, Garbage Out (GIGO)
ICT systems cannot function properly if the inputs are inaccurate or faulty; they will either not be able to 
process the data at all, or will output data which is erroneous or useless.
	 GIGO  is a useful term to remember in the examination—it can help explain many issues such as 
why validation is needed and why accurate data is valuable.

GIGO stands for Garbage In, Garbage Out.

An ICT System Diagram

A system is an assembly of parts that together make a whole. ICT systems are made-up of some or all of 
the parts shown in Fig. 1.2. Various devices are used for input, processing, output, and communication.

Fig. 1.2: ICT system diagram
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Feedback
It is sometimes good to have feedback in an ICT system. This is when the  output from a system  feeds 
back to influence the input and the process repeats itself.

Media Integration
Methods used for input to and output from ICT systems vary a lot. So, you should be familiar with examples 
of input and output formats.
	 Input and output formats are the different kinds of media that are used to either gather and collect data and 
instructions or to display, present or issue the outputs of processing.
	 Up until recently, most media formats required dedicated devices—for example, digital cameras to 
take  digital  photographs, scanners to digitise images for use on a computer, or  DVD  players for video 
playback—so the correct devices are needed in order to work with each media format.
	 There is now a growing tendency for multi-purpose ICT devices or 
convergence. The driving force is the communication power of the  Internet, 
and the increasing availability of small high-powered electronic technology. 
This means that you can now get an all-in-one box that can do the same thing 
as several different ones did before it. Some examples are:
	 (i)	 Combined printers, scanners and photocopiers
	 (ii)	 Televisions with built-in Internet connections and web browsers
	 (iii)	 Mobile phones (see Fig. 1.3) that can take photos, record video, access 

the Internet and playback music.

The Internet
The Internet is a worldwide system of interconnected computer networks. When you connect your computer 
to the Internet via your Internet Service Provider (ISP), you become part of the ISPs network, which is 
connected to other networks that make up the Internet.

Fig. 1.4: Working of Internet

Connecting to the Internet
To connect to the Internet, the following are needed:
	 (i)	 a computer
	 (ii)	 telephone line (cable being the exception)
	 (iii)	 modem and/or router

Fig. 1.3: Mobile phones—
Multipurpose ICT devices
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	 (iv)	 an ISP (Internet Service Provider)
	 (v)	 Web browser, e.g., Internet Explorer, Mozilla Firefox, Google Chrome, Safari, Opera, etc.

Intranet
An intranet is a network that works like the Internet but is only available within a particular organization, 
not to the public. An intranet may have web pages used to share company specific data within that company, 
such as internal telephone numbers or details of employee benefits.

Network
A computer network (see Fig. 1.5) consists of a number of computers linked together to allow them to share 
resources. Networked computers can share hardware, software and data.

Fig. 1.5: A computer network

	 Most computer networks have at least one server. A server is a powerful computer that provides one 
or more services to a network and its users, for example, file storage and e-mail.

Types of Networks
The two main types of network are Local Area Network (LAN) and Wide Area Network (WAN).

Local Area Network (LAN)
A LAN (see Fig. 1.6) covers a small area such as one site or building, e.g., a school or a university 
campus.

Fig. 1.6: LAN—Local Area Network

	 A school network is usually a LAN.
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Wide Area Network (WAN)
A WAN (see Fig. 1.7) covers a large geographical area. Most WANs are made from several LANs connected 
together.

Fig. 1.7: WAN—Wide Area Network

	 Some important points about WANs are:
	 (i)	 The Internet is a WAN.
	 (ii)	 A network of bank cash dispensers is a WAN.

	 (iii)	 LANs are often connected to WANs, for example, a school or college network could be connected 
to the Internet.

	 (iv)	 WANs can be connected together using the Internet, leased lines or satellite links.

The main components of Information and Communication Technology (ICT) are computer and 
communication networks.

l C haracteristics of Valuable Information

All the information is not helpful to a business or an organization. It might be detailed, but has been 
obtained for too much cost. What are the main features of a good quality information in a business or an 
organization?

	 Table 1.1 summarizes the key characteristics of good quality information, and suggests ways in which 
information can be improved if it is not quite up to the standard.
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Table 1.1: Characteristics of Valuable Information

Quality Required Purpose

Relevant The information obtained and used should be needed for decision-making. It does 
not matter how interesting it is. Businesses or organizations are often criticized 
for producing too much information simply because their information systems can 
“do it”. A good way of ensuring relevance is to closely define the objectives of the 
information reports. Another way to improve relevance is to produce information 
that focuses on “exceptions,” e.g., problems, high or low values, where limits have 
been exceeded.

Up-to-date Information needs to be timely if it is to be used. For example, the manager of a large 
retail business needs daily information on how stores are performing, which products 
are selling well (or not) so that immediate action can be taken to improve business. To 
improve the speed with which information is produced, businesses or organizations 
usually need to look at upgrading or replacing their information systems.

Accurate As far as possible, information should be free from errors (e.g., the figures 
add up; data is allocated to the correct categories). The users of information 
should be informed whenever assumptions or estimates have been used. 
Accurate information is usually a function of accurate data collection.

If information needs to be extremely accurate, then more time needs to be allocated 
for it to be checked. However, businesses or organizations need to guard against 
trying to produce “perfect” information—it is often more important for the information 
to be up-to-date than perfect.

Meet the needs of 
the user

Users of information have different needs. The managing director does not have time 
to trawl through thick printouts of each week’s production or sales listings—he or she 
wants a summary of the key facts. The quality control supervisor will want detailed 
information about quality testing results rather than a brief one-line summary of how 
things are going. It is a good idea to encourage users to help develop the style and 
format of information reporting that they require.

Easy to use and 
understand

Information should be clearly presented (e.g., use summaries, charts) and not too long. 
It also needs to be communicated using an appropriate medium (e.g., e-mail, printed 
report, presentation). Businesses should also consider developing “templates” which 
are used consistently throughout the organization—so that users get used to seeing 
information in a similar style.

Worth the cost Often forgotten. Information costs money. Data is costly to collect, analyze and report. 
Information takes time to read and assimilate. All users should question whether the 
information they receive/have requested is worthwhile.

Reliable Information should come from authoritative sources. It is a good practice to quote the 
source used—whether it be internal or external source. If estimates or assumptions 
have been applied, these should be clearly stated and explained.
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Integration of Information Services
Alongside the joining together of technologies, there is also a tendency toward the integration of common 
public information services.
	 Digital  television by satellite,  cable  or terrestrial aerial now gives access to many channels that have 
interactive content, which can be used in a way similar to the web. The digital radio provides large 
amounts of text data to be transmitted along with the signal.
	 The  Internet  now enables broadcasts from radio and TV stations to be ‘time-shifted’ by the user, who 
watches or listens to the programme whenever required.
	 News services and the mass media such as newspapers, radio, and television are making themselves 
available so that people can access them when they want and wherever they are. Two of the key reasons for 
this are:

	 1.	 The growth of  broadband  Internet access that allows lots of information to be viewed quickly and 
effectively.

	 2.	 The success of  digital broadcasting, the signals of which can carry very much more content than old 
style analog TV and radio.

Activity 1.1
The Characteristics of Valuable Information

Students will discuss in small groups the characteristics of valuable information.

Fig. 1.8: Students discussing the characteristics of valuable information

	 In order for information to be valuable, it must have the following characteristics:

	 1.	 Accurate. Accurate information is free from error.

	 2.	 Complete. Complete information contains all of the important facts.

	 3.	 Economical. Information should be relatively inexpensive to produce.

	 4.	 Flexible. Flexible information can be used for a variety of purposes, not just one.

	 5.	 Reliable. Reliable information is dependable information.

	 6.	 Relevant. Relevant information is important to the decision-maker.

	 7.	 Simple. Information should be simple to find and understand.

	 8.	 Timely. Timely information is readily available when needed.

	 9.	 Verifiable. Verifiable information can be checked to make sure it is accurate.
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	   Key Concepts

	 	 ICT refers to technologies that provide access to information through telecommunications. It focuses 
primarily on communication technologies. This includes the Internet, wireless networks, cell phones, and other 
communication media.

	 	 An ICT system is a set-up consisting of hardware, software, data and the people who use them. It commonly 
includes communications technology, such as the Internet.

	 	 The Internet is a worldwide system of interconnected computer networks.

	 	 A computer network is a number of computers linked together to allow them to share resources. The two main 
types of network are Local Area Network (LAN) and Wide Area Network (WAN).

	 	 The main components of ICT are computer and communication networks.

	 	 The characteristics of valuable information are: relevant, up-to-date, accurate, meet the needs of the user, easy 
to use and understand, worth the cost, reliable.

Assessment 1.1

Fill in the Blanks
	 1.	 When computer and communications technologies are combined, the result is ............................... .
	 2.	 ICT refers to technologies that provide access to information through ........................... .
	 3.	 An ICT system is a set-up consisting of ..........................., ..........................., ........................... and people who 

use them.
	 4.	 ........................... is a worldwide system of interconnected computer networks.

State Whether True or False
	 1.	 There are two important components of ICT—computers and communications.
	 2.	 Communications technology is not called telecommunications technology.
	 3.	 ICT and computers are the same thing.
	 4.	 GIGO stands for Go In, Go Out.
	 5.	 All the information is helpful to a business or an organization.

Answer the Following
	 1.	 Identify and explain the components of ICT.
	 2.	 List the characteristics of valuable information.

Suggested Activity
	 Identify the components of Information and Communications Technology such as computer, communication 

networks, etc.

Field Trip
	 Organize a field trip to various places like Cyber Cafe’s, Universities, Private Colleges, or Ethiopian 

Telecommunication Corporation (ETC) stations to find out and report on: Components of ICT.
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1.2 Computer System

Computer is perhaps the most powerful and versatile tool ever created by human being. In today’s world, 
the use of computers has increased so rapidly that we can no longer ignore them. Computers influence our 
lives in one way or the other. These days we see computers being used to perform several functions that 
have made our life easy. The list of services for which computers are used is a long one.

What is a Computer?
Computer is an electronic device that can accept, store and process data under the control of a set of 
instructions. The instructions, called a program, are stored in the computer when in use, so they can be 
executed automatically.
	 A computer appears to be far more intelligent and informed than human beings but the fact is, it cannot 
perform any task on its own. We need to give the computer instructions on exactly what it has to do.
	 If an unanticipated situation arises, computers will either produce wrong results or abandon the task 
altogether. They do not have the potential to work out alternative solutions.
	 Figure 1.9 shows some of the main components of a computer system:

Fig. 1.9: Main components of a computer system

l  Major System Unit Components
The System Unit is also called a case. It is a box that houses the motherboard (into which processor and 
RAM chips are plugged), power supply, as well as secondary storage 
devices—floppy disk drive, hard disk drive, and CD or DVD drive. 
The case comes in desktop or tower models. It includes a power 
supply unit and a fan to keep the circuitry from overheating. The 
number of buttons on the outside of the computer case will vary, 
but the on/off power switch will appear somewhere, either front or 
back. Figure 1.10 illustrates the front side of system unit.

Fig. 1.10: Front side of System Unit
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	 Figure 1.11 shows the inside of system unit.

Fig. 1.11: Inside of system unit
(The arrangement of the components varies among different models)

	 Let us discuss the major system unit components and their functions:

Motherboard
The motherboard, or system board, is the main circuit board in system 
unit. The motherboard (see Fig. 1.12) consists of a flat board that fills 
one side of the case. It takes care of the entire system task in one way 
or the other. The primary function of the motherboard is to serve as 
the base upon which a computer’s components are built. It contains 
both soldered, non-removable components and sockets or slots for 
components that can be removed—microprocessor chip, RAM chips, 
and various expansion cards.

Power Supply
The electricity available from a standard wall outlet is Alternating Current (AC), but a computer runs on 
Direct Current (DC). The power supply is a device that converts AC to DC to run the computer. The on/off 
switch in your computer turns on or shuts off the electricity to the power supply. Because electricity can 
generate a lot of heat, a fan inside the computer keeps the power supply and the other components from 
becoming too hot.
		 Electrical power drawn from a standard AC outlet can be quite uneven. For example, a sudden surge, or 
“spike,” in AC voltage can burn out the low-voltage DC circuitry in your computer (“fry the motherboard”). 
Instead of plugging your computer directly into the wall electrical outlet, it is a good idea to plug it into a 
power protection device. One of the principal types is UPS.

A UPS (Uninterruptible Power Supply) is a battery-operated device that provides a computer with 
electricity if there is a power failure. The UPS will keep a computer going for 5 to 30 minutes or 
more. It goes into operation as soon as the power to your computer fails. It also stabilizes any sudden 
fluctuation in the power supply.

Fig. 1.12: Motherboard
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Hard Disk
Hard disks are thin but rigid metal, glass, or ceramic platters covered with a substance that allows data to 
be held in the form of magnetised spots. Most hard disk drives have at least two platters; the greater the 
number of platters, the larger the capacity of the drive. The platters in the drive are separated by spaces and 
are clamped to a rotating spindle that turns all the platters in unison. Hard disks are tightly sealed within 
an enclosed hard disk drive unit to prevent any foreign matter from getting inside. Data may be recorded 
on both sides of the disk platters (see Fig. 1.13). In a microcomputer, the hard disk is enclosed within the 
system unit. Unlike a floppy disk, it is not accessible.

Fig. 1.13: Hard disk

CD-ROM Drive
A CD (Compact Disk) drive, or its more recent variant, a DVD 
(Digital Video Disk) drive, is a storage device that uses laser 
technology to read data from optical disks (see Fig. 1.14). (Some 
companies call a DVD a “Digital Versatile Disk.”) These days 
new software is generally supplied on CDs rather than on floppy 
disks.

Floppy Drive
A floppy disk drive is a storage device that stores data on removable 3.5-inch-diameter disks (see  
Fig. 1.15). These diskettes do not seem to be “floppy,” because 
they are encased in hard plastic, but the mylar disk inside is 
indeed flexible or floppy. Each can store 1.44 MB or more data. 
Using the floppy disk drive you can insert a diskette through a 
slot in the front and remove it by pushing the eject button.

You must not remove the diskette from floppy disk drive until its light goes off, or else you risk 
damage to both the disk and the drive.

l Major Motherboard Components
The major motherboard components are CPU, RAM, ROM, Slots, Chips and CMOS battery, etc. Let us 
discuss these components and their functions:

CPU
The most fundamental part of a motherboard is the microprocessor chip or the Central Processing Unit (CPU) 
(see Fig. 1.16). A microprocessor is the miniaturised circuitry of a computer processor. It consists of mainly an 

Fig. 1.14: CD/DVD drive and a CD

Fig. 1.15: Floppy drive and floppy
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integrated circuit of semiconductor devices and other electronic components 
manufactured on a thin sheet of semiconductor material. CPU executes and stores 
program instructions that process or manipulate data into information. The CPU 
is often referred to as the ‘‘brain’’ of the computer.
		 CPUs have to communicate with the rest of the PC. This is accomplished 
through a collection of interconnected chips on the motherboard called a 
chipset. Chipsets determine what types of processors, memory, and video card 
ports will work on the same motherboard.

Memory
So far we have described only the kinds of chips known as microprocessors. But other silicon chips called 
memory chips are also attached to the motherboard. There are two types of memory storage—primary and 
secondary. Primary storage is temporary or working storage and is often called the memory or the main 
memory; secondary storage, usually called just storage, is relatively a permanent storage. Memory refers to 
storage media in the form of chips, and storage refers to media such as disks and tape. The two principal 
types of memory chips are RAM and ROM.

	 RAM chips—to temporarily store program instructions and data: RAM (Random Access Memory) chips 
(see Fig. 1.17) temporarily hold (1) software instructions, and (2) data before and after it is processed by the 
CPU. You can think of memory (RAM) chips as a collection of boxes, each of which, holds a single byte of 
data.
	 Because its contents are temporary, RAM is said to be 
volatile—the contents are lost when the power goes off or is 
turned off. This is why you should frequently—say, every  
5 minutes, save your work to a secondary storage 
medium such as your hard disk—in case the electricity 
goes off while you are working.

		 RAM allows the stored data to be accessed in any order, that is, at random.

RAM is a volatile form of storage. It is the working memory of the computer. Having enough RAM is 
critical for the user to run many software programs.

	 	ROM chips—to store fixed start-up instructions: Unlike RAM, to which data is constantly being added 
and removed, ROM (Read Only Memory) cannot be written upon or erased by the computer user. ROM 
chips contain fixed start-up instructions.
		 ROM chips are loaded, at the factory, with programs containing special instructions for basic computer 
operations, such as those that start the computer (BIOS) or put characters on the screen. These chips are 
non-volatile; their contents are not lost when power to the computer is turned off.
		 In computer terminology, read means to transfer data from an input source into the computer’s memory 
or CPU. The opposite is write—to transfer data from the computer’s CPU or memory to an output device. 
Thus, with a ROM chip, read-only means that the CPU can retrieve programs from the ROM chip but 
cannot modify or add to those programs. A variation is PROM (Programmable Read Only Memory), which 
is a ROM chip that allows you, the user, to load read-only programs and data. However, this can be done 
only once.

Fig. 1.16: Microprocessor chip

Fig. 1.17: Random Access Memory (RAM) chips
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Slots
The motherboard has expansion slots—for expanding the PC’s capabilities—which give you places to plug 
in additional circuit boards, such as those for video, sound and communications (modem).

CMOS Battery
This is a battery that maintains the time, date, hard disk and other configuration settings in the CMOS 
(Complementary Metal Oxide Semiconductor) memory. CMOS batteries are small and attached directly to 
the motherboard.

l Memory Capacity and Computer Speed
Memory is a part of the computer that holds data and instructions for processing. As mentioned 
earlier, memory chips deal only with temporary storage, secondary storage or permanent storage, 
stores the data for as long as you want. Although closely associated with the central processing unit, 
memory is separated from it. A computer system’s storage capacity is represented by bytes, kilobytes, 
megabytes, gigabytes and terabytes. The computer speed, that is, the CPU speed is measured in 
gigahertz (GHz).

Memory Capacity
Memory capacity is the maximum or minimum amount of memory a computer or hardware device is 
capable of having or it is the required amount of memory for a program to run or execute.
	 The storage capacity of a computer is measured in bytes. The hierarchy of byte memory capacity is as 
follows:
	 (i)	 Bit. It is the smallest unit of memory. A bit has the value 0 or 1. This is determined by no voltage 

or high voltage.
	 (ii)	 Byte. One byte means 8-bits.
	 (iii)	 Kilobyte. Kilo means one thousand, so a kilobyte (KB) is approximately one thousand bytes. Actually, 

a kilobyte is 1,024 bytes.
	 (iv)	 Megabyte. Mega means one million, so a megabyte (MB) is approximately one million bytes (1,048,576 

bytes, or 1,024 kb or 1,024 × 1,024 bytes, to be exact). Most personal computers have hundreds of 
megabytes of RAM.

	 (v)	 Gigabyte. Giga means one billion. A gigabyte (GB) is actually 1,073,741,824 bytes  or 1,024 MB  
(i.e., 1,024 × 1,024 × 1,024 bytes). The storage capacity of a hard drive in modern personal computers 
is often many gigabytes.

	 (vi)	 Terabyte. One trillion bytes (actually, 1,099,511,627,776 bytes) is a terabyte (TB).

		 Table 1.2 summarizes the units of memory capacity.
Table 1.2: Units of Memory Capacity

Unit Abbreviation Size Symbol Equivalent

Bit – – – An atom or speck, the smallest 
unit of memory.

Byte – 8 bits A single letter, a number, or a 
symbol.
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Kilobyte K or KB 1,024 bytes A one-page, double-spaced 
letter.

Megabyte M or MB 1,024 KB or 1,048,576 
bytes

A best-selling novel.

Gigabyte G or GB 1,024 MB or  
1,024 × 1,024 KB or 
1,073,741,824 bytes

An encyclopaedia set.

Terabyte T or TB 1,024 GB or 1,024 × 
1,024 MB or 1,024 × 
1,024 × 1,024 KB or 
1,099,511,627,776 bytes

A bookstore.

	 Table 1.3 summarizes the characteristics of the various kinds of data storage. 
Table 1.3: Characteristics of Various Kinds of Data Storage

Storage Speed Capacity Relative Cost (Birr) Permanent?

Registers Fastest Lowest Highest No

RAM Very Fast Low/Moderate High No

Floppy Disk Very Slow Low Low Yes

Hard Disk Moderate Very High Very Low Yes

Computer Speed
When we refer to the speed of a computer, we are talking about the speed of CPU. The microprocessor 
(CPU) is the “brain” of a computer. One of the most important things about CPUs is speed. The speed of 
CPU is measured in Hertz or Hz, i.e., number of operations that can be done per second. Nowadays, we 
usually use Giga-Hertz or  GHz (e.g., 2.8 GHz, 3.06 GHz) because the CPUs are too fast to be measured 
in Hz.
	 Because of the extremely high speed of CPU, computers can do millions of operations in a very short 
time.
	 Heat is released when a CPU is run. High temperature, however, decreases the performance of CPU. 
You, therefore, need a fan to cool down the CPU.

Tip: Do not play with the CPU speed
You can change the speed of CPU in BIOS of your computer. Some people change the speed of 
their CPU to a very high GHz. This can increase the speed of the computer but would make the 
CPU overloaded and overheated. Finally, the whole computer may break down. Therefore, it is not 
recommended to do so.
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Activity 1.2
Identification of Various Components of a Computer System

Students to form groups in their class and identify the following components.

Fig. 1.18: Main components of a computer system

	   Key Concepts
	 	 Computer is an electronic device that can accept, store and process data under the control of a set of 

instructions.

	 	 The System Unit is also called a case. It is a box that houses the motherboard (into which processor and RAM 
chips are plugged), power supply, as well as secondary storage devices —floppy disk drive, hard disk drive, and 
CD or DVD drive.

	 	 The motherboard, or system board, is the main circuit board in the system unit.

	 	 The most fundamental part of a motherboard is the microprocessor chip or the Central Processing Unit 
(CPU). It is often referred to as the “brain” of the computer.

	 	 Memory capacity means the amount of program instructions and data that can be stored on it.

	 	 Computer speed means the speed of the CPU.

	 (i) ....................................	 (ii) ....................................	 (iii) ....................................

	 (iv) ....................................	 (v) ....................................	 (vi) ....................................

	 (vii) ....................................	 (viii) ....................................	 (ix) ....................................
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Review Questions

Fill in the Blanks
	 1.	 ........................... is perhaps the most powerful and versatile tool ever created by human being.
	 2.	 The ........................... is also called a case.
	 3.	 A CD (Compact Disk) drive, is a storage device that uses ........................... technology to read data from 

optical disks.
	 4.	 The contents of ........................... are lost when the power goes off or is turned off.
	 5.	 Memory is the part of the computer that holds ........................... and ........................... for processing.

State Whether True or False
	 1.	 A computer can perform any task on its own.
	 2.	 The motherboard is the main circuit board in the system unit.
	 3.	 The power supply is a device that converts DC to AC.
	 4.	 The CPU is often referred to as the “brain” of the computer.
	 5.	 The two principal types of memory chips are RAM and ROM.

Multiple Choice Questions
	 1.	 Which of the following is/are multipurpose ICT device(s) or convergence? 
		  (a)	 Combined printers, scanners and photocopiers
		  (b)	 Televisions with built-in Internet connections and web browsers
		  (c)	 Mobile phones that can take photos, record video, access the Internet and playback music
		  (d)	 All of these
	 2.	 Which of the following is not a characteristic of valuable information? 
		  (a)	 Irrelevant			   (b)	 Up-to-date
		  (c)	 Accurate			   (d)	 Reliable
	 3.	 Which of the following is not enclosed in System Unit of a PC?
		  (a)	 UPS			   (b)	 Hard disk	
		  (c)	 Motherboard			   (d)	 Power Supply
	 4.	 Which of the following is another name for primary storage?
		  (a)	 CPU			   (b)	 ROM	
		  (c)	 RAM		  	 (d)	 CD drive

Match the Following

Column A Column B
1. A characteristic of valuable information (a) The most fundamental part of the motherboard
2. Intranet (b) Worth the cost
3. Read Only Memory (c) A network only available within a particular 

organization, not to public
4. CPU (d) Non-volatile storage
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Answer the Following 
	 1.	 Name major components of the system unit.
	 2.	 Identify function of the system unit and its components.
	 3.	 Name major components of the motherboard.
	 4.	 Identify function of the motherboard components.
	 5.	 Write a short note on the memory capacity and computer speed.

Suggested Activities
	 1.	 Cut out an advertisement from a newspaper or a magazine that features a new microcomputer system. 

Circle all the terms that are familiar to you. Define these terms on a separate sheet of paper. Is this 
computer expandable? How much does it cost? Is the monitor included in the price? Is a printer included 
in the price?

	 2.	 Consider the secondary storage components for a new system you are planning to buy. Using the 
advertisements in a computer magazine or a newspaper, pick out particular examples of each of the 
following devices and write a brief description of why you would want them and how much they would 
cost. Keep in mind that many of these components are already part of many systems, so you will concern 
yourself with adding them only after the system has been purchased.

	 (i)	 Hard disk drive	 (ii)	 Floppy disk drive
	 (iii)	 Floppy disks	 (iv)	 Removable disks
	 (v)	 CD-ROM drive	 (vi)	 DVD drive
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Application 
 Software

   Unit Outcome
	 Students will be able to:

	 	 understand the application of word processing, and presentation software;

	 	 apply word processing, and presentation software packages for different purposes;

	 	 recognize the major features of desktop publishing;

	 	 know how to organize, format and publish various types of publication.

Software, or programs, consists of all the electronic instructions that tell the computer how to perform a 
task. The term software was coined by John Tukey. Application software is a set of programs designed for 
specific uses or applications such as word processing, graphics or spreadsheet analysis. These software 
are designed to satisfy a particular need of a particular environment. An application software, designed 
to satisfy one purpose may not be able to solve other purpose of the same user. For example, software for 
financial management cannot be used for designing two-dimensional graphics. Similarly, we have word 
processors for letter writing and presentation software for presentations. We cannot interchange the use of 
two application software with each other.
	 Application software can be custom-made but are usually purchased from a software store. Some of the 
popular application packages are Word processors, Spreadsheets, Database system, Accounting packages, 
DTP packages, Graphic packages and Antivirus software. In this unit, we will study application software.

2.1 Key features of Word Processing

Word processing software allows you to create, edit, format, print, and store text material, among other things. 
Word processor is the most common application software. The well known word processing programs are 
Microsoft Word, Writer, Wordpad, Text Editor and Star Word.
	 The advantages of using a word processor to create documents over typed documents are given in 
Table 2.1.

Table 2.1: Advantages of Word Processor

Typed Documents Documents Created Using a Word Processor
Slow creating process Can be created quickly and easily
Difficulty in inserting pictures and images Pictures and images can be inserted easily
Look messy after making corrections Error correction is simple and neat.

Unit 2   
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Microsoft Word—An Example of a Word Processing Software Package
Microsoft Word (MS-Word) is the most popularly used word processing application software that provides 
you with a number of useful and fabulous features to process the text. A word processor, in general, can 
be used to manipulate the text in a variety of ways. In addition to it, you can save your documents in a 
word processor and use them according to the need, whenever required. The features that are provided 
by any word processor (as editing, formatting text) are available in MS-Word, which also supports some 
additional and special features (e.g., mail merge).

l Revision
Let us revise some key features of Word Processing, which we have studied in Grade 9, i.e., Opening a 
Word processing software, Creating new document, Saving a document, Closing a document, Editing a 
document and Formatting a document, etc.

Importance of Word Processing
Word processing is by far the most widely used computer application because it is used for communication, 
our most common activity. Word processor is used to write, edit and format memos, letters, reports, 
manuscripts, contracts, and every imaginable type of documents. No matter what the information is, or what 
form it takes, the chances are it was initially composed and written using a word processing program.
		 A word processor is a software which provides a graphical user interface with better capabilities than 
a text editor does. The main advantage of a word processor is that it provides WYSIWYG (What You See 
Is What You Get) interface which helps you make changes quickly and easily. The main features of today’s 
word processing packages are:

Creating Documents
It means entering text using the keyboard. Word processing software has three features that affect this 
process—the cursor, scrolling and word wrap.
	 1.	 Cursor: The cursor is a movable symbol on the display screen (monitor) that shows us where we 

may next enter data or commands. It is often a blinking rectangle or an I-beam. We can move the 
cursor by using the keyboard’s directional arrow keys or a mouse. The point where the cursor lies 
at a particular instant is known as the insertion point.

	 2.	 Scrolling: Scrolling means moving quickly upward, 
downward or sideways through the text or other 
screen display. A standard computer monitor displays 
only 20–22 lines of standard-size text at a time. 
Generally, the documents are longer than that. Using 
the directional arrow keys, or the mouse and scroll 
bars located at the side and bottom of the screen, we 
can move or “scroll” through the display screen and 
into the text above and below, and even sideways.

	 3.	 Word Wrap: Word wrap automatically continues text 
on to the next line when we reach the right margin, 
i.e., the text “wraps around” to the next line. We do 

not need to hit a “Carriage return key” or  (Enter) key, like in a typewriter.

Fig. 2.1: Scrolling
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Editing Documents

When editing a document to correct mistakes, we can move the insertion point where we wish to enter new 

text and then just type it in. To delete characters, we press  (Backspace) or  (Delete) key. 

Pressing Backspace key deletes characters to the left of the insertion point and pressing Delete key deletes 
those to the right. We can also drag the mouse to highlight any section of the text and then copy/cut and 
paste it to another file, or to some other place in the document being used or cut (delete) it all at once.

		 The Undo command allows us to change our mind and restore text that we have just deleted. Inserting 
is the act of adding to the document. The  (Insert) key plays an important role in the replacement of 

text and exiting from Insert mode.

		 In addition to the insert and delete, cut/copy and paste features of editing explained above, some other 
features of editing are:
	 1.	 Find and Replace: The Find or Search, command allows us to find any word, phrase or number that 

exists in our document being edited. It can be replaced automatically with something else with the 
help of Replace command.

	 2.	 Spelling Checkers: Spelling checkers compare all words in a document with a list of words in the 
program’s dictionary. Words not available in the dictionary are highlighted and we can then decide 
whether to change them, leave them as such or add them to the dictionary. We must note that a 
highlighted word is not always necessarily mis-spelled. It just means that the word is not available 
in the dictionary. Any word that is added into the program’s dictionary is not highlighted again (if 
found next time). Spelling checkers help users prepare accurate documents.

	 3.	 Grammar Checkers: Grammar checkers are programs that check the grammar incomplete sentences 
and awkward phrases. The grammar checker does not fix things automatically, but it will flag 
(perhaps with a different colour of squiggly line) possible incorrect word usage and sentence 
structure. Grammar checkers help users produce better-written documents.

	 4.	 Thesaurus: Thesaurus is a word processing feature that presents the user with the appropriate word 
or alternative words. The thesaurus feature helps users prepare well-written documents.

 Tip: Use Short Cut Keys
You do not always need to use the mouse to pull down menus to perform functions. These menus provide 
information about which short cut keys serve the same mouse-click function. Most commands have a short 
cut key, and common functions usually have the same short cut command in different programs. Some 
examples of shortcut keys in MS-Word are:
	 Short cut Key	 Purpose
	 Ctrl + A	 Select all the text
	 Ctrl + X	 Cut the text
	 Ctrl + C	 Copy the text
	 Ctrl + V	 Paste the text
	 Ctrl + O	 Open a file
	 Ctrl + S	 Save a file
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Formatting Documents with the Help of Templates and Wizards

Formats are used to make a document both more attractive and easier to read. All word processing programs 
have built-in format settings known as defaults, which are designed so we can easily override them. 
		 Templates: These are pre-formatted documents that provide basic tools for shaping a final document—
the text, layout and style for a letter, for example.
		 Wizards and Helpers: These answer the user questions and use the answers to layout and format a 
document. In Word, we can use the Memo Wizard to create professional looking memos or the Resume 
Wizard to create a resume.
	 Following are a few apsects of formatting amongst many:
	 1.	 Margins: These are the white spaces on all four sides of the text block. They set off the text and 

make it more attractive visually.
	 2.	 Headers and Footers: These can be entered at the top or bottom of pages to identify sections or 

provide other useful information.
	 3.	 Numbers: These can be used to set off lists so when you insert or delete items, the numbers adjust 

automatically.
	 4.	 Bullets: We can use bullets to set off lists where the order is not important.
	 5.	 Fonts: These can be changed by selecting a new one from a list of those available on the system. We 

can then use bold, italic, underline formats to provide emphasis on the text.
	 6.	 Tables: These are used to present tabular materials.
	 7.	 Indents: These specify how much space the paragraph should be indented from the left and right 

margins.
	 8.	 Page Numbers: These can be positioned almost anywhere on the page and printed in either Roman 

numerals (i, ii, iii etc.) or Arabic numbers (1, 2, 3 etc.).

 Tip: When Several Word Documents are Open
You can write with several Word documents open simultaneously. To go (“toggle”) back and forth, hold 
down Ctrl and press F6. To go backward, press Ctrl, Shift and press F6. You can cut and paste text from one 
document to another.

Printing, Faxing or E-Mailing Documents
We have several options for printing in most of the word processing software. For example, we can print 
several copies of a document, individual pages or a range of pages can also be printed. We can even preview a 
document before taking its hard copy or print out. Previewing (print previewing) means viewing a document 
on the screen to see what it will look like in the printed form before printing it. Whole pages are shown 
in reduced size.
	 We can also send out a document off to someone else by fax or as an e-mail attachment, if the computer 
has the appropriate communication link.
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Saving Documents
It means storing, or preserving, a document as an electronic file permanently—on floppy disk or hard disk 
(say). This feature is available in nearly all application softwares. The saved document can be retrieved and 
used when needed.

Creating Document Using a Word Processor
As mentioned earlier, MS-Word is a member of the MS-Office family provided by Microsoft. It is a Windows 
based application. Let us assume that your computer has MS-Word 2007 installed on it. Remember that 
there are differences in MS-Word 2003 and MS-Word 2007.

Starting Microsoft Word 2007

To start MS-Word or Word:

	 1.	 Click the Start button on the task bar.

Fig. 2.2: Starting MS-Word 2007

	 2.	 Choose the All Programs option in the Start menu (see Fig. 2.2).
	 3.	 Click the Microsoft Office option from the All Programs menu.
	 4.	 Click the Microsoft Office Word 2007 option.
		 This opens a blank new document (see Fig. 2.3 on next page).
	 Office Button displays Microsoft Office logo and, when clicked, displays a list of options and most 
recently opened documents.
	 Quick Access Toolbar contains buttons for commonly used commands.
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Fig. 2.3: Components of a Document window

Creating a Document
When you start MS-Word, a blank document window appears. MS-Word, by convention, names newly 
created documents as DOCUMENT1, DOCUMENT2, DOCUMENT3, ... and so on. Thus, each new 
document, when created, is given a name DOCUMENT <serial number>. The various parts of that window 
are shown in Fig. 2.3.
		 The important features of MS-Word are:
	 1.	 Outline features: It enables you to view headings in your document.
	 2.	 Cut-and-paste feature: It enables you to move blocks of text. 
	 3.	 Formatting feature: It enables you to change type font and size. 

Microsoft Word 2007 is a word processing application software used to create documents such as 
memos, letters, reports, research papers, brochures, announcements, newsletters, envelops, labels and 
much more.

Case Study
Producing a Descriptive Article on Photosynthesis

Let us revise and demonstrate the various tasks performed in MS-Word by producing a descriptive article on 
photosynthesis.

Creating a New Document
If you are already working in MS-Word and you want to create a new document, then:

	 1.	 Click the Office Button (see Fig. 2.4).
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Fig. 2.4: Creating a new document

	 2.	 Click on the New option. It displays the following window (see Fig. 2.5).

Fig. 2.5: On clicking the New option

	 3.	 Click on the Create button. It displays the newly created document (see Fig. 2.6).

Fig. 2.6: Newly created Word document
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Typing a Passage Using MS-Word

To insert text in your document, place the cursor at the position where you want to enter the text and start 
typing.

		 To insert a paragraph you have to press the enter key and start typing.

		 When you type text, MS-Word automatically inserts the text in the document area.

		 Figure 2.7 shows a descriptive article on photosynthesis using MS-Word 2007. 

Fig. 2.7: Producing a descriptive article on Photosynthesis using MS-Word

	 Useful Tips

When Several Word Documents are Open

You can write with several Word documents open simultaneously. To go (“toggle”) back and forth, held 
down Ctrl and press F6. To go backward, press Ctrl, Shift and press F6. To display several documents at 
once, go to the Window group in the View tab and select Arrange All button. You can copy/cut and paste text 
from one document to another.

Microsoft Word Help

Word help is an extensive on-line help application that provides useful “how to” and “what is” information 
on every aspect of the Word program. Word help can be easily accessed by clicking on Word Help  located 
in the upper right corner of the screen or pressing F1.

Saving Document Using the ‘Save As’ Command
When you type in a document, the document is stored in the internal memory of the computer. 
	 Once you have created a document, you have to save it for future use and you must save it on a disk. 
To save means to preserve the document safely for further use.
	 To save a word document:
	 1.	 Click the Office Button.
	 2.	 Click the Save option (see Fig. 2.8).
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Fig. 2.8: Selecting the Save option

		  The ‘Save As’ dialog box is displayed as shown in Fig. 2.9.

Fig. 2.9: The ‘Save As’ dialog box

		  The ‘Save As’ dialog box is displayed only under the following circumstances:
	 (i)	 When you have clicked ‘Save As’.
	 (ii)	 If you have clicked Save and you are saving the document for the first time.
	 3.	 Identify the location where you want to save. You must enter the name by which you want to save 

the document. Here, we have selected My Documents and given the file name doc1.docx.
	 4.	 Click the Save button.

MS-Word, by default, saves all the documents in the folder ‘My Documents’ with extensions 
.docx. However, you can save them elsewhere by selecting the desired location, from the ‘Save in:’ 
drop-down list provided in the ‘Save As’ dialog box.
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 Caution: When you are using the ‘Save As’ option, make sure that you do not overwrite the existing 
copy of the file.

Closing a Document
After your work is complete you need to close the document without exiting from the MS-Word.
 To close a document without exiting the MS-Word,
 1. Click the Office Button.
 2. Click the Close option.
 If you have not saved the document before closing, MS-Word gives you warning asking to save the 
document (see Fig. 2.10).

Fig. 2.10: The warning dialog box

 From the above shown dialog box:
 (i) If you want to Save the document, click the Yes button.
 (ii) If you do not want to Save the document, click the No button.
 (iii) If you want to remove the message box, click the Cancel button.

Exiting Microsoft Word
When the Word Processing work is over, you must exit properly from MS-Word.
 To exit MS-word:
 1. Click the Office Button.
 2. Click the Exit Word button.
 If you have not saved the document, Word prompts you to save changes before closing the application 
(see Fig. 2.10).

 Useful Tip

 You can close the document using Close button  available in the Title bar.

l tables and pictures in word processing

Tables
MS-Word’s Table feature is useful for displaying data in columns and rows. This data may be text, values, 
and/or formulas.
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Inserting or Creating a table
MS-Word offers a set of commands for creation, modification and formatting of tables.
	 The tables can be inserted in a word document in the following way:
	 1.	 Open the document.
	 2.	 Create the table.
	 3.	 Insert data in the table.
	 4.	 Identify the format of the table.
	 5.	 Change the format of the table.
	 6.	 Save the document.
	 Let us implement this in MS-Word 2007.
	 To insert a table in your document, follow these steps:
	 1.	 Open a document and enter some text in it.
	 2.	 Select the Insert tab.
	 3.	 Select the Table option from Tables panel.
	 4.	 On clicking the Table option, a list will be displayed. Select the desired table size by moving the 

cursor on the table cells (see Fig. 2.11). Here, we select 2 × 6 table.

Fig. 2.11: Selecting the Table size
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	 5.	 After clicking on the last cell of the selected table size, a table is inserted into the document at the 
insertion point below the text (see Fig. 2.12).

		  Now fill the table as per your requirement.

Fig. 2.12: A document after inserting data in table

You can also insert table using Draw Table option from Insert Table list, available in Table option of the 
Tables panel under Insert tab.

Table Manipulation
It includes selection, insertion, deletion, adjustment etc. of the basic elements of a table.

Selecting 
To select cell, row, column or table, click the Select button in the Table Tools Layout tab (see Fig. 2.13). 
Now select the desired option. 

 
Fig. 2.13: Clicking Select button
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	 Alternatively, you can select the item (cell, row or column) as:

To select Do this

A cell Click the left edge of the cell. 

A row Click to the left of the row. 

A column Click the column’s top gridline or top border. 

	 To select all cells in the table, click the table move handle that displays in the upper left corner of the 
table (square with a four-headed arrow inside).
	 Besides using the mouse, you can select cells using keyboard shortcuts as given in  
Table 2.2.

Table 2.2: Selecting Cells Using the Keyboard

Key(s) To Select

Tab The next cell’s contents

Shift + Tab The preceding cell’s contents

Hold Shift key and then press the arrow key repeatedly Adjacent cells

Position insertion point in top cell of column, hold down 
the Shift key, and then press Down Arrow key until column 
is selected

A column

Alt + 5 (on the numeric keypad with Num Lock off) The entire table

Click anywhere outside the table to deselect the cells.

Adding a cell
To add a cell in a table, perform the following steps:
	 1.	 Click in a cell that is to the right of or above where you want to insert a cell. 
	 2.	 Under Table Tools, on the Layout tab, click the Rows & Columns Dialog Box Launcher. 
	 3.	 Click one of the following options. 

Click To

Shift cells right Insert a cell and move the selected cell and all other cells to the right of the 
selected cell in that row to the right. 

Shift cells down Insert a cell and move the selected cell and the existing cells below the 
selected cell down one row. A new row is added at the bottom of the 
table.

Insert entire row Insert a row above the cell that you clicked in.

Insert entire column Insert a column to the left of the cell that you clicked in.
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Word does not insert a new column. Using the Shift cells right option may result in a row that has more 
cells than the other rows.

Adding a row 
To add a row in a table, perform the following steps:
	 1.	 Click in a cell above or below where you want to add a row. 
	 2.	 Under Table Tools, on the Layout tab, do one of the following: 
	 (i)	 To add a row above the cell, click Insert Above in the Rows & Columns group. 
	 (ii)	 To add a row below the cell, click Insert Below in the Rows & Columns group.

Adding a column
To add a column in a table, perform the following steps:
	 1.	 Click in a cell to the left or right of where you want to add a column. 
	 2.	 Under Table Tools, on the Layout tab, do one of the following: 
	 (i)	 To add a column to the left of the cell, click Insert Left in the Rows & Columns group. 
	 (ii)	 To add a column to the right of the cell, click Insert Right in the Rows & Columns group.

Deleting a cell
To delete a cell from a table, perform the following steps:
	 1.	 Select the cell that you want to delete by clicking its left edge. 
	 2.	 Under Table Tools, click the Layout tab. 
	 3.	 In the Rows & Columns group, click Delete, and then click Delete Cells. 
	 4.	 Click one of the following options: 

Click To do this

Shift cells left Delete a cell and shift all other cells to the right of the deleted cell in that row 
to the left. 

Shift cells up Delete a cell and move the remaining existing cells below the deleted cell in 
that column up one row each. A new, blank cell is added at the bottom of the 
column.

Delete entire row Delete the entire row that contains the cell that you clicked in.

Delete entire column Delete the entire column that contains the cell that you clicked in.

Word does not insert a new column. Using the Shift cells left option may result in a row that has fewer 
cells than the other rows.

Deleting a row
To delete a row from a table, perform the following steps:
	 1.	 Select the row that you want to delete by clicking its left edge. 
	 2.	 Under Table Tools, click the Layout tab. 
	 3.	 In the Rows & Columns group, click Delete, and then click Delete Rows.
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Deleting a column
To delete a column from a table, perform the following steps:
	 1.	 Select the column that you want to delete by clicking its top gridline or top border. 
	 2.	 Under Table Tools, click the Layout tab. 
	 3.	 In the Rows & Columns group, click Delete, and then click Delete Columns.

Deleting a table 
To delete a table, perform the following steps:
	 1.	 Click in the table. 
	 2.	 Under Table Tools, click the Layout tab. 
	 3.	 In the Rows & Columns group, click Delete, and then click Delete Table. 

Merging cells
You can combine two or more table cells located in the same row or column into a single cell. For example, 
you can merge several cells horizontally to create a table heading that has several columns.
	 To merge cells in a table, perform the following steps:
	 1.	 Select the cells that you want to merge by clicking the left edge of a cell and then dragging across 

the other cells that you want. 
	 2.	 Under Table Tools, on the Layout tab, in the Merge group, click Merge Cells.

Splitting cells
To split cell(s) in a table, perform the following steps:
	 1.	 Click in a cell, or select multiple cells that you want to split. 
	 2.	 Under Table Tools, on the Layout tab, in the Merge group, click Split Cells.
	 3.	 Enter the number of columns or rows that you want to split the selected cells into.

Moving or copying items in a table
To move or copy items in a table, perform the following steps:
	 1.	 On the Home tab, in the Paragraph group, click Show/Hide 

(see Fig. 2.14). 
	 2.	 Select the item (cell, row or column) that you want to move 

or copy. 
	 3.	 Do one of the following: 
	 (i)	 To move the selected item, drag it to the new location. 
	 (ii)	 To copy the selected item, hold down Ctrl key while you 

drag it to the new location.

Pictures
Pictures are bitmaps, scanned photographs or clipart images. In MS-Word documents, pictures are used to 
visually represent things, emotions, and objects.

Fig. 2.14: Clicking Show/Hide in the 
Paragraph group
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Inserting Pictures
Clipart or pictures are inserted to create effective documents. MS-Word supports many popular picture 
formats, for example .wmf (Window Meta Files). You can insert pictures from the disk as well as cliparts 
from the clipart gallery of MS OFFICE. You can also insert downloaded pictures or pictures taken by your 
web cam or digital camera, into your documents.
	 The pictures can be inserted in a word document in the following way:
	 1.	 Open the document.
	 2.	 Identify the pictures to be inserted in the document.
	 3.	 Insert pictures in the document.
	 4.	 Determine the appearance of the pictures.
	 5.	 Change the appearance of the graphics.
	 6.	 Save the document.
	 Let us implement this in MS-Word 2007.
	 The steps for inserting pictures are given below:
	 1.	 Open a document. Here, we are working in an already open document (refer to Fig. 2.12).
	 2.	 Click the Insert tab.
	 3.	 Select the Picture option from Illustrations panel (see Fig. 2.15).

Fig. 2.15: Inserting picture

	 4.	 On clicking this button the Insert Picture dialog box will appear. Select the desired picture and click 
Insert button (see Fig. 2.16). Here, we have selected Ethiopian Treasures.
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Fig. 2.16: Insert Picture dialog box

	 5.	 The selected picture will be inserted in the document at the insertion point (see Fig. 2.17)

Fig. 2.17: A document after inserting a picture

	 6.	 Save and close the document.
The picture may not move properly in your document, unless you select a wrapping style. To resize a 
picture, always stretch them from corners. This will increase the height and width equally.

l W ord Processing Activities
As mentioned earlier, Microsoft Word 2007 is a word processing application software used to create 
documents such as letters, reports, memos, research papers, brochures, announcements, newsletters, 
envelops, labels, and much more. It provides a wide variety of editing and formatting features as well as 
sophisticated visual elements.
	 While working in word, you can perform various word processing activities.

Activity 2.1
Writing a Piece about Irrigation and Water Distribution in Ethiopia

Students will perform the following steps for doing the activity:

	 1.	 Click the Start button on the Task bar.
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	 2.	 Choose the All Programs option in the Start menu.

	 3.	 Click the Microsoft Office option from the All Programs menu.

	 4.	 Click the Microsoft Office Word 2007 option. On starting MS-Word a blank document window appears. 
MS-Word by default, names the newly created document as Document1. 

	 5.	 Figure 2.18 shows a piece about irrigation and water distribution in Ethiopia using MS-Word 2007.

Fig. 2.18: A piece about irrigation and water distribution in Ethiopia

	 6.	 Save the document with the name you wish.

	   Key Concepts
	 	 Word processing is the most widely used computer application.

	 	 When you are using the ‘Save As’ option, make sure that you do not overwrite the existing copy of the file.

	 	 When you edit text, you change the text by either inserting text, deleting text or replacing text by using mouse 
or keyboard.

	 	 Formatting text means changing the text appearance by changing the alignment, style, font and font colour. 
To format text, you need to use the Home tab.

	 	 Tables provide you an easier and effective method of arranging the data in rows and columns.

	 	 Pictures are inserted to create effective documents.

Assessment 2.1

Fill in the Blanks
	 1.	 ........................... is the most commonly used application software that creates text documents.
	 2.	 MS-Word’s ........................... feature is useful for displaying data in columns and rows.
	 3.	 In Word, ........................... means changing the text appearance by modifying the alignment, style, font 

and font color.
	 4.	 Insert Panel has Illustrations option in Word 2007 which allows you to insert ..................... into the text.
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State Whether True or False
	 1.	 MS-Word is not a member of MS-Office family provided by Microsoft.
	 2.	 You must keep on saving the document when working to avoid losing document when power goes 

off.
	 3.	 You can change the font styles to bold, italics and underline from the Font panel by clicking on the 

respective options.
	 4.	 A table cannot be inserted in a document using MS-Word.

Answer the Following 
	 1.	 What is the importance of Word Processing? Discuss.
	 2.	 Discuss the editing and saving of a Word document using the editing tools.
	 3.	 What are the steps to format a document?
	 4.	 How will you insert Tables and Pictures in Word Processing document?

Suggested Activities
	 1.	 Creating a personal C.V.
	 2.	 Keeping a logo of personal performance in physical education.
	 3.	 Writing a report on a chemical experiment.
	 4.	 Writing a report on a Physics experiment.

2.2 Key features of presentation software and techniques

Presentation is the process of presenting a topic to an audience, for example, presenting a lesson to Grade 
10 students about global warming or soil erosion in Ethiopia. Many people make use of presentation 
software to support them when they have to give a presentation to others.
	 Presentation software is a tool used to display information, normally in the form of a slide show. It 
generally includes three major functions: an editor that allows text to be inserted and formatted, a method 
for inserting and manipulating graphic images and a slide-show system to display the contents.
	 Microsoft PowerPoint is a presentation software that allows users to create presentations and slide shows 
using a variety of media, including images, video and music. The user compiles information regarding 
his/her topic presentation in any or all of these media formats and then applies effects to enhance the 
presentation. PowerPoint is often used for business presentations, but many students deliver presentations 
for class assignments. PowerPoint is simple to use, and with a little practice, you can create professional 
presentations that will effectively get your ideas across to others.

Features of Presentation Software
Following are some important key features of Presentation Software: 
	 1.	 Insert Slide Feature allows you to insert slide anywhere in the presentation, at the beginning, middle 

or end. 
	 2.	 Deletion of Inserted slides: Any slide of the presentation can be removed. 
	 3.	 Allows copy/cut and paste slides in any order. 
	 4.	 Allows animations and/or sounds manipulations on objects in the slide. 
	 5.	 Simple Find and Replace, and text editor features. 
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	 6.	 Good font specifications allows you to change and use different font faces, styles, and effects.
	 7.	 Additional features for slide allows footnotes, cross references, advanced navigation system, headers, 

and footers.
	 8.	 Good layout management system presets or Customized layout designing.
	 9.	 Spell checkers and dictionary support.
	 10.	 Allows the slide show of the presentations.
	 In this sub-unit, we will revise the concepts of Presentation Software that we have learnt in Grade 9.

l Revision
As discussed in Grade 9, PowerPoint is a presentation graphics program you can use to organize and 
present information. With PowerPoint, you can create visual aids for a presentation and then print copies 
of the aids as well as run the presentation.
	 A presentation in PowerPoint generally follows a presentation cycle. The general steps of this cycle 
include opening PowerPoint, creating and editing slides; saving, printing, running and closing the 
presentation; and then closing PowerPoint.
	 Suppose you are having MS-PowerPoint 2007 installed on your computer.
	 To start using PowerPoint:
	 Click Start → All Programs → Microsoft Office → Microsoft Office PowerPoint 2007 (see Fig. 2.19).

Fig. 2.19: Starting PowerPoint

Depending on your system configuration, the steps you perform to start PowerPoint may vary.
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	 The PowerPoint window appears as shown in Fig. 2.20.

Fig. 2.20: PowerPoint window

Steps for Creating Presentation
A presentation may contain a number of slides (a slide is a page that may have various objects like title, 
subtitle, lists, cliparts, charts and organization charts), which are arranged in a sequence. Various effects 
are applied on the slide objects and slides to improve the presentations. Generally creating a presentation 
involves the following steps:
	 1.	 Creation of slides of required types.
	 2.	 Typing the required text in the slides.
	 3.	 Arranging the slides in a proper sequence.
	 4.	 Applying different effects to the slide objects, for example, text and sound effects.
	 5.	 Applying slide transitions to slides.
	 6.	 Setup the show.
	 7.	 Presenting the slide show.
	 Let us revise the topics you have learned in Grade 9.

Creating Slides Using Text and Images
You can create slides using text and images as explained below:

Adding Text
In order to add text, the text needs a “container” — a Text Box. Make a text box by clicking on the “Text Box” 
icon in the “Insert” tab (see Fig. 2.21). Choose horizontal or vertical as you wish.

Fig. 2.21: Selecting Text Box for adding text
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	 Click or click-and-drag where you want the text to be. You should see the rectangular shape of the Text 
Box. Type your text. The box will grow automatically as you type. To copy text from another program first 
make the text box then do copy and paste into the text box.

Adding Images
The two ways to add images are with Insert Picture and with Copy and Paste. The Insert/Picture is the 
most common way of adding graphics to a PowerPoint document. If you have a file that is in one of several 
standard graphic formats (like JPEG or GIF), use the “Insert” tab and click the “Picture” icon to select and 
insert your picture (see Fig. 2.22).

Fig. 2.22: Selecting Picture icon in Insert tab for adding image

	 The image will appear on your document with handles. Use one of the corner handles to re-size it. 
(The corner handles will keep the same aspect ratio; the side handles will not.) Click and drag in the 
middle of the graphic to move it. A Picture Tools tab automatically shows up when you insert the picture  
(see Fig. 2.23). You can edit the picture by clicking the icons for the numerous options in this tab.

Fig. 2.23: Picture Tools tab for editing the picture

Formatting Text and Background
You can format text and background as explained below:

Text Format
As in many programs, you can change the font and size by highlighting the text to be changed and then making the 
changes within the “Home” tab (see Fig. 2.24). A 100-point font is about an inch high.

Fig. 2.24: Formatting text

	 If you do not see the size you want in the selection list, you can enter it in by hand. To move a Text Box, 
position your pointer over a part of the edge of the box that is not a handle. The pointer should become 
shaped like a plus sign with arrows. Click and drag the Text Box to the wanted position. You can change 
the color of the text, the edge, and the fill as well as other things with the options in the “Home” tab. Make 
a separate Text Box for each separate piece of text. “Separate text” means a portion of text that you want 
to be able to move independently from the others.
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Backgrounds
You can select a background by clicking the “Background Styles” icon in the “Design” tab (see Fig. 2.25).

Fig. 2.25: Formatting background

	 Click on the Format Background option within the dropdown menu and you can choose from even 
more color choices. If you choose Fill effects you have a choice of tabs and one is Gradient. A gradient 
background is a smooth transition from one color to another. The best gradients are very dark or very light 
so that the text can easily be read on top of it. If you want a picture background click on the Picture tab, 
then Select Picture to browse to your picture. Be careful of using too big image—large files can become 
cumbersome to work with.

Inserting and Deleting Slides
You can insert and delete slides as explained below:

Inserting a New Slide
Click on the New Slide button on the Home tab of the ribbon to add a new 
slide to your presentation (see Fig. 2.26).

Deleting a Slide
On the Slides tab of the Slides/Outline task pane on the left of your screen, click on the thumbnail  
(a thumbnail describes a miniature version of a slide or picture) of the slide you wish to delete. Press the 
Delete key on your keyboard.

Presenting a Slide Show
You can present a slide show as explained below:
	 Press F5 or on the Slide Show tab, in the Start Slide Show group, do one of the following:
	 (i)	 To start with the first slide in the presentation, click From Beginning.
	 (ii)	 To start with the slide that currently appears in the Slide pane, click From Current Slide.
	 The presentation opens in Slide Show view. Click the left mouse button to advance to the next slide.

	 Press  to return to Normal view at any time.

Creating a Slide Show using Animation and Sound

You can create the most effective visual presentations using PowerPoint because a series of slides that 
contains only bulleted lists is not the most dynamic choice. Lack of visual variety can cause your audience’s 
attention to drift. And many kinds of information are not most clearly expressed in a paragraph or a 
bulleted list.
	 MS-Office PowerPoint 2007 makes it possible to add many other kinds of audio and visual content, 
including tables, SmartArt graphics, clip art, shapes, charts, music, movies, sounds, and animations. You 
can add transitions between slides.

Fig. 2.26: Inserting a new slide
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	 Professionally designed slide shows contain all these properties to grasp the attention of the audience.

Applying Animation
To animate an individual object in a slide, use the options from the Animate button located in the Animations 
group in the Animations tab. You can also apply custom animation to selected objects in a slide by clicking 
the Custom Animation button in the Animations group in the Animations tab. This displays the Custom 
Animation task pane at the right side of the screen. Use options in this task pane to control the order in 
which objects appear on a slide, specify entrance and exit effects, choose animation direction and speed, 
and specify how objects will appear in the slide.

Adding Sound
To add sound to a presentation, perform the following steps:
	 1.	 Select the slide.
	 2.	 Click Insert tab.
	 3.	 Click Sound button arrow.
	 4.	 Click Sound from File at the drop down list.
	 5.	 Navigate to desired folder.
	 6.	 Double-click desired sound clip file.

Changing Slide Layout 
You can change the slide layout as follows:
	 Click the Layout button on the Home ribbon. This will show a contextual menu of the nine different 
slide layout choices in PowerPoint 2007 (see Fig. 2.27).

Fig. 2.27: Changing Slide Layout

	 The current slide layout will be highlighted. Hover your mouse over the new slide layout of your choice 
and that slide type will also be highlighted. When you click the mouse this new slide layout will be applied 
to the current slide.
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l P resentation Software and Techniques Activities
Now, it is the turn of your IT teacher to liase with other curriculum subject teachers to promote active learning 
in groups. For example, in geography, groups of students will prepare a presentation on a geographical 
topic such as global warming or land erosion in Ethiopia and present a slide show of the same.
	 Let us prepare in groups a presentation on “Global Warming” and present a slide show of it through 
an activity.

Activity 2.2
Presentating a Slide Show on Global Warming

Students in groups will perform the following steps:

	 1.	 Click Start → All Programs → Microsoft Office → Microsoft Office PowerPoint 2007.

	 2.	 Click on Office Button and select New.

	 3.	 Prepare a presentation on Global Warming and save it in a file.

	 4.	 Click the Slide Show tab.

	 5.	 Click the From Beginning icon in the Start Slide Show command group. PowerPoint displays the first slide 

of your presentation.

	 6.	 Click the left mouse button or press the spacebar/Enter key to view the next slide.

		  The slides in the presentation are shown in Fig. 2.28.

	 	

	 Slide 1	 Slide 2

	 	
	 Slide 3	 Slide 4
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	 Slide 5	 Slide 6

	 	

	 Slide 7	 Slide 8

Fig. 2.28: Slide Show of presentation on Global Warming

	 7.	 Press  to exit the slide show.

	   Key Concepts
	 	 Presentation software uses graphics, animation, sound and data or information to make visual presentations.

	 	 PowerPoint is a full-featured presentation software that provides a variety of editing and formatting features 
as well as sophisticated visual elements such as clipart, pictures, SmartArt, WordArt, and drawn objects.

	 	 The PowerPoint Help feature is used to display information on PowerPoint.

	 	 We can apply interesting transitions and sounds to a presentation. A transition is how one slide is removed 
from the screen during a presentation and the next slide is displayed.

	 	 Presenting a slide show is the most useful view of PowerPoint. It is used to display the slides in a desired 

sequence.

Assessment 2.2

Fill in the Blanks
	 1.	 ........................... is used to create colourful and powerful presentations.
	 2.	 ........................... can include such functions as rearranging and deleting slides; cutting, copying and 

pasting text etc.
	 3.	 To display a blank PowerPoint presentation, we click the Office button, click ..........................., and then 

double-click the Blank Presentation option at the New Presentation dialog box.

	 4.	 A ........................... is a location on a slide marked with a border that holds text or an object.
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State Whether True or False
	 1.	 Microsoft PowerPoint is not included in MS-Office suite.
	 2.	 When running a presentation, how one slide is removed from the screen and the next slide is displayed 

is called transition.
	 3.	 To run a slide show manually, we click the Slide Show Tab and then click the From Beginning button in 

the Start Slide Show group.
	 4.	 We cannot add a sound to a presentation.

Answer the Following
	 1.	 What are the key features of presentation software?
	 2.	 Give the steps to create a presentation.
	 3.	 Give the steps to insert and delete slides using PowerPoint.
	 4.	 How will you prepare and present a slide show?

Suggested Activities
	 1.	 Produce a time-line for important events in the History of Ethiopia. Prepare and present a slide show.
	 2.	 Prepare a presentation on land erosion in Ethiopia and present a slide show.

Field Trip
	 Organize a field trip to various restaurants to get useful information about foods and present the slide show 

to the class.

2.3 desktop publishing

Desktop Publishing (DTP) is an application software that involves mixing text and graphics to produce 
high-quality output for commercial printing, using a PC, scanner, laser or ink-jet printer, and DTP software.  
The most important feature of desktop publishing system is that it helps the user to see exactly how the 
design would appear when printed. This feature is called WYSIWYG, that is, “What You See Is What 
You Get”. Often the printer is used primarily to get an advance look before the completed job is sent to a 
typesetter for even higher-quality output. Offset printing is generally more expensive than laser printing.
	 Some professional DTP programs are QuarkXPress, Adobe InDesign and Adobe PageMaker. Microsoft 
Publisher is a “low-end”, consumer-oriented DTP package. Desktop publishing has the following 
characteristics:
	 1.	 Mix of text with graphics.
	 2.	 Varied type and layout styles.
	 3.	 Use of files from other programs.

DTP has reduced the number of steps, the time, and the money required to produce professional-looking 
printed projects.

Who uses DTP?
The main users of DTP are:	
	 1.	 Newspapers and Magazines: People working with newspapers and magazines use DTP to design 

the layouts to help them achieve a professional and eye catching design.
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	 2.	 Book Publishers: They create book jackets by using images drawn by artists and then incorporate 
these with text using DTP software.

	 3.	 Businesses or Charities: They use DTP software to create leaflets, posters or flyers to advertise 
their business or to publicise an event. They also use DTP to create business cards, calendars and 
letterheads.

	 4.	 Teachers: They often use DTP software to produce worksheets or exercises for students.

Features of Desktop Publishing 
The major features of desktop publishing are:

Templates
DTP packages have a wide range of templates to help the users make anything from brochures, business 
cards, flyers, calendars to party invitations.

Wizard
Most of the DTP packages provide ‘wizards’ which make it easy for the user to customize the template  
he/she has chosen, that is, change the colour scheme, change the layout of the template and include personal 
or business details such as address and contact details.

Text Frames 
These are used to hold the text on the publication. Users must identify the features about the text frames 
in the DTP which make them useful and different. The text frames can be resized, rotated, easily placed 
on top of images, borders, and other text. Text can be ‘flowed’ from one frame to another.

Be careful about Text Frames, that is, do not call these ‘text boxes’ because text boxes are available in 
Word Processing packages, Spreadsheet packages and Presentation packages. 

Borders
DTP packages allow the users to make custom borders using an image of their own choice. They can 
choose the size of the border and the spacing of the image.

Like the Text Frames, do not just say borders. Look for the borders which are available in your DTP 
software which makes them particularly suitable.

Page Tabs
If the user creates a document which has multiple pages, for example, a brochure or catalogue which 
needs to be folded, the DTP package allows him/her to access each individual page via a numbered tab. 
The page appears the ‘right way up’ whilst working on it. However, when he/she has finished, it will be 
printed in the correct order or orientation for that publication. 

l Load Publisher and Starting New Document
Microsoft Office Publisher 2007 is the business publishing program that helps you create, design, and 
publish professional-looking marketing and communication materials. You can create materials for print, 
e-mail, and the Web with an intuitive, task-based environment that guides you from initial concept to final 
delivery in-house without professional design and production expertise.
	 Suppose you are having MS-Publisher 2007 installed on your computer. 
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	 To start Microsoft Office Publisher 2007, perform the following steps:

	 Click Start → All Programs → Microsoft Office → Microsoft Office Publisher 2007 (see Fig. 2.29)

Fig. 2.29: Starting MS-Publisher

OR
	 Double click on the Microsoft Office Publisher 2007 icon on the desktop.
	 Publisher opens and the Getting Started with Microsoft Office Publisher 2007 view appears, offering many 
pre-formatted designs to use in creating your publication (see Fig. 2.30). 

Fig. 2.30: Getting Started with Microsoft Office Publisher 2007 view

	 From this window you can start a new publication or open an existing one.
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Creating a New Document 
MS-Publisher 2007 offers two options for creating a new document. The Getting Started task pane provides 
pre-formatted designs and is very useful when you need to quickly create an attractive publication. 
For a more original look, you may wish to start with a blank publication; however, this is more time 
consuming.

Creating a New Document: New from a Design 
The Getting Started task pane offers many pre-formatted designs to use in creating your publication. 
	 To start a new document, perform the following steps:
	 1.	 From the File menu, select New... OR press <Ctrl + N>.
		  The Getting Started task pane appears. 
	 2.	 From the Publication Types pane, select a category of designs.
		  The available publication types within that category are displayed below the category heading. 
	 3.	 Click a publication type. Available designs appear in the main window. 
	 4.	 Click a design. The selected design opens. 

Creating a New Document: From a Blank Publication 
To start a new document, perform the following steps:
	 1.	 From the File menu, select New... OR press <Ctrl + N>. 
		  The Getting Started task pane appears.
	 2.	 In the Popular Publication Types section, click Blank Page Sizes.
		  A selection of blank publication sizes appears. 
	 3.	 Select the size document you want to work with. 
	 4.	 Click Create.

l Exploring the Publisher Window
The MS-Publisher window contains many parts that work together for creating a document  
(see Fig. 2.31). Understanding of these elements will help you become comfortable in Publisher.
	 Let us explain the various screen elements of MS-Publisher:
	 Formatting Toolbar: This toolbar contains buttons for common text formats options in Publisher and 
throughout Microsoft Office (for example, font, text alignment, or line spacing). 
	 Objects Toolbar: This toolbar allows you to insert text boxes, tables, and shapes to your workspace. 
	 Page Boundary: Page boundaries represent the edges of the paper. Items outside or partially overlapping 
page boundaries will not appear in print.
	 Page Icons: These icons indicate which page is currently selected, how many pages the publication 
contains, and which pages are grouped into spreads. Selecting a page icon will make that page appear in 
the workspace.
	 Page Margin: Blue dotted lines represent page margins. As a general rule, all text and graphics ought 
to be placed within the page margins.
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Fig. 2.31: Screen elements of MS-Publisher window

	 Format Publication Task Pane: This task pane provides quick access to many Publisher operations. To 
view a list of categories of operations, click the task pane’s header (in Fig. 2.31, the header is titled Format 
Publication). To access the Find and Replace task pane, click the task pane’s header and then select Find and 
Replace. The Format Publication task pane refreshes to become the Find and Replace task pane.
	 Rulers: Rulers help you measure the length of your text boxes, images, and other objects relative to 
how they will appear in print. You can change the unit of measure from the Options dialog box (from the 
Tools menu, select Options).
	 Standard Toolbar: The Standard toolbar contains buttons for common functions in Publisher and 
throughout Microsoft Office (for example, saving, undoing actions, or zooming).

View menu can be used to make any of the various tools and toolbars appear or disappear.

	 The Elements of Objects Toolbar are given in Table 2.3.
Table 2.3: Elements of Objects Toolbar

Button Name Purpose

 Select Objects Selects lines, shapes, graphics, text boxes, and other objects for resizing, 
deleting, and other actions.

 Text Box Creates text boxes.

 Insert Table Creates tables.

 Insert WordArt Adds WordArt to your publication.

 Picture Frame Adds a picture frame or pictures from clip art, scanners, cameras, files.
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 Line Creates a line.

 Arrow Creates an arrow.

 Oval Creates circular and oval shapes.

 Rectangle Creates rectangular shapes.

 AutoShapes Creates a variety of unique shapes. For example, hearts, lightning bolts, 
callout boxes etc.

 Bookmark Adds a bookmark to the location you desire. Bookmarks allow you to 
link or refer to a specific location in a publication. 

 
Design Gallery Object Inserts a wide array of customizable objects from the Microsoft Publisher 

Design Gallery. For example, coupons, advertisements, logos, etc.

 Item from Content 
Library 

Inserts an item from the Content Library. The Content Library is a storage 
area for items that you use frequently in your publications (for example, 
a logo, location information, contact information).

For adding items to your Content Library, right click the item and then select Add to Content Library. 
On the dialog box that appears, click OK.

l editing a page
After adding text or other objects to MS-Publisher 2007 document, we can edit these. We can add, remove 
or change the text or objects. The font, size and style of the text can also be edited. In this section, you will 
learn how to edit in Publisher.

Adding Text to a New Page
MS-Publisher text editing is different than the word-processing program. It takes a two-step process to add 
blocks of text to new documents in Publisher 2007. First, you must create a new text box for text storage, 
and then you have to enter the text into it. This allows you to place a customized text box wherever you 
would like on the page at any time. Also, you can change the border colors of each text box you create, 
you can divide text boxes into columns, and you can even connect text boxes so that text automatically 
flows from one box to another. 

 To add text to a new page, perform the following steps:

 1. Select the Text Box icon on the Object toolbar (see Fig. 2.32).

Fig. 2.32: Selecting the Text Box icon
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	 2.	 On the page, drag your cursor to create the custom text box (see Fig. 2.33).

	 	

	 Fig. 2.33: Creating the custom text box	 Fig. 2.34: Clip Art search interface

	 3.	 Now type in the text box you have created. If you need to zoom in, press F9 key. 
	 1.	 To format the text, use the Format menu. You can change the font, the font size, the font color, 

and the font style. You can also change paragraph alignment, indentation, line spacing, and line/
paragraph breaks, as well as bullets and numbering. To format any text box, simply click the text 
box and use the icons on the Format menu.

	 2.	 To copy a text box, hold down the Ctrl key while you drag it.
	 We can insert word art and edit style, insert picture, insert auto shapes and format objects on a page. 

Inserting Clip Art 
To change the picture in an existing picture frame, perform the following steps: 
	 1.	 Right click on the picture and select Delete Object. 
	 2.	 Click Insert → Picture → Clip Art.
	 3.	 A Clip Art search interface will open in the task pane (see Fig. 2.34).
	 4.	 Enter a search term and click Go. 
	 5.	 You can choose to limit the search to a particular collection or a particular media type. 
	 6.	 Once you find the desired clip art, click on it to insert it. 

The Clip Art has a drop down arrow next to it. If you click on the drop down arrow other options are 
available. You can click on Find Similar Style for clip art of similar design. You can click on Preview/
Properties to view the original size of the clip art and what keywords were used to classify the 
picture. 

	 Table 2.4 shows the shortcuts keys for editing text and objects in Microsoft Publisher 2007.
Table 2.4: Shortcut Keys for Editing Text and Objects 

Function Shortcut Keys
Copy formatting from text Ctrl + Shift + C
Apply copied formatting to text Ctrl + Shift + V
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Copy the selected text or object Ctrl + C 
Cut the selected text or object Ctrl + X
Paste text or an object Ctrl + V
Delete the selected object Delete
Undo the last action Ctrl + Z
Redo the last action Ctrl + Y
Nudge a selected object up, down, left, or right Arrow keys
Bring object to the front Alt + F6
Send object to back Alt + Shift + F6
Select all objects on the page Ctrl + A
Group selected objects or ungroup grouped objects Ctrl + Shift + G
Clear the selection from text (if text is selected) Esc
Clear the selection from an object (if an object is selected) Esc 
Switch between making an object transparent or opaque Ctrl + T

l Brochure Building
A brochure is an effective means to provide information about your company’s products and services.  
MS-Publisher’s brochure feature allows you to design a customized brochure with text and graphics. 
	 To create a brochure from a template, perform the following steps:

Select Design
	 1.	 Start Publisher and click Brochures under Popular Publication Types (see Fig. 2.35). 

Fig. 2.35: Selecting Brochures

	 2.	 Now scroll down to Classic Designs and click Blends (see Fig. 2.36). This brings up some additional 
options.
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Fig. 2.36: Clicking Blends from Classic Designs

Select Format
	 1.	 Under Page size, click the 4-panel option (see Fig. 2.37).

	 	

	 Fig. 2.37: Clicking the 4-panel option from	 Fig. 2.38: Checking the Include customer 
	 Page size	 address checkbox
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	 2.	 Check the Include customer address checkbox (see Fig. 2.38). 

	 3.	 Click the  button available at the bottom on right side.  
		  The brochure layout template should look as shown in Fig. 2.39:

Fig. 2.39: Brochure layout template

		  The second page (back) of the brochure should look like as shown in Fig. 2.40:

Fig. 2.40: Second page of brochure
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	 4.	 Now make sure that Brochure Options is selected in the Format Publication pane (see Fig. 2.41).   

Fig. 2.41: Selecting Brochure Options in the Format Publication pane

	 5.	 Click the  button. 
	 6.	 Click Order form in the Form drop-down arrow under Options (see Fig. 2.42). 

Fig. 2.42: Clicking Order form
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	 7.	 Click the  button. This adds a mail-back form on the back of the brochure  
(see Fig. 2.43)	

Fig. 2.43: Adding a mail-back form on the back of the brochure

	 8.	 Save the brochure as My Brochure in the Practice Publisher Files folder. 
	 9.	 Close the brochure. 

l Business Cards
Business cards are most commonly used for business advertising purpose. Business cards are used to 
identify a person related to a specific business. In addition to serving as a convenient reminder of your 
contact information, a business card introduces your company and reinforces your company’s image. A 
business card is also invaluable in building and sustaining word-of-mouth marketing. The information on 
a business card needs to be clear and precise. The fonts should be clear and large enough to read.
	 Microsoft Office Publisher makes it easy to produce effective business cards, whether you create your 
own design or use one of the Publisher designs. You can use color schemes and font schemes to select 
the colors and fonts that reflect the company’s image. You can further customize your business cards for 
specific market segments or locales, and you can add names and job titles for new employees as your 
business grows.

Creating Business Cards
To create business cards, perform the following steps:
	 1.	 Start MS-Publisher 2007.
	 2.	 Click on Business Cards in the heading Publication Types on the Getting Started with Microsoft Office 

Publisher 2007 page (see Fig. 2.44). 
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Fig. 2.44: Clicking Business Cards

	 3.	 The main part of the window displays a variety of designs for the business card. Have a good look 
at each, and select your favourite (see Fig. 2.45).

Fig. 2.45: Selecting design

	 4.	 The right hand column has a number of options for your business card (see Fig. 2.46). You can 
customize it with a different color scheme, and a different font scheme.
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	 Fig. 2.46: Customize dialog box

	 5.	 Now look for the Business information drop down box. If this is the first time you have created a 
business card, your only option will be Create new….

		  Select Create new… and a dialog box will appear for you to enter your business card information 
(see Fig. 2.47).

Fig. 2.47: Dialog box to enter business card information
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	 6.	 Enter the details and click .

	 7.	 If you are satisfied with all your decisions, click  in the bottom 
right hand corner of the screen.

Printing the card in Appropriate Paper Size 
To print a card, perform the following steps:
	 1.	 Open the business card document that you wish to print.
	 2.	 In the Business Card Options task pane, under Copies per sheet, click One or Multiple.
	 3.	 Load the printer with the paper that you wish to print on.
	 4.	 On the File menu, click Print. The Print dialog box appears (see Fig. 2.48).

Fig. 2.48: Print dialog box

	 5.	 In the Print dialog box, choose the printer that you wish to print to. Make sure that the correct 
orientation and size are selected. 

	 6.	 Click OK.
	1.	 If you choose the Multiple copies option, MS-Publisher will print 10 copies per sheet by default.
	2.	 If your cards have portrait orientation, Publisher will automatically set them up to be printed 

correctly.
	3.	 Unless you customize the size of your card, Publisher defaults to the standard business card size 

of 2 by 3.5 inches.
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l Folded Card Publishing
The cards you buy from a shop are usually folded publications having text and graphic elements on all 
sides. You can print cards in MS-Publisher on both sides of the paper, or you can print the content on one 
side of the paper and then fold it in four. MS-Publisher has many templates for two types of folded cards: 
Greeting Cards and Invitation Cards. In addition, five tent-fold templates are also available in the Postcards 
category.
	 Using MS-Publisher 2007, you can quickly produce an invitation exactly as you want. To create folded 
cards, perform the following steps:
	 1.	 Start MS-Publisher, and then click Invitation Cards in the Publication Types list.
	 2.	 Under Invitation Cards, click a design theme, such as Theme Party (see Fig. 2.49).
	 3.	 Scroll through the predesigned invitation card publications. When you find one that you like, click 

it to see a larger image preview. If you do not see a design that you like, you can download from 
Microsoft Office Online.

	 4.	 On right side, under Customize and Options, you can modify many design elements before you open 
the publication, for example, the color scheme and font scheme, the business information set, the 
page size, and the layout (see Fig. 2.49).

Fig. 2.49: Customizing an invitation card

	1.	 If you use a template that you downloaded from Office Online, you cannot customize the design 
until you open the publication.

	2.	 Some of the side-fold cards, such as the Party, Event, and Housewarming designs, are set up for 
only one layout option. If you choose one of these designs, alternate page size and layout options 
are not available.
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	 5.	 Click the  button. A predesigned invitation is created  
(see Fig. 2.50).

Fig. 2.50: Predesigned Invitation

	 6.	 After you create a predesigned invitation with your layout and fold style, you are ready to customize 
the invitation, i.e., make global design changes, work with the pictures, and work with the text, 
etc.

	 7.	 When the invitation card looks the way that you want, save the file.

	 8.	 If you wish to print the card, then select File → Print and click the Publication and Paper Settings tab. 
Now, fill the various options as per your need. Click Print Preview to see how your publication will 
look on the printed page. Then you can make any necessary adjustments before you print it. Click 

the  button.  
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Activity 2.3
Explain and Demonstrate Designing a Greeting Card

Students will perform the following steps for doing the activity:

	 1.	 Open MS-Publisher 2007. Click on the Greeting Cards button in the middle of the Available Templates 
screen (see Fig. 2.51). Scroll through the available card templates, such as Holidays, Birthday, Occasions 
and Events and Thank You, or double-click a folder with more template options. Every card may be 
changed and customized to an occasion. Here, we select Birthday.

Fig. 2.51: Selecting Birthday greeting card

	 2.	 Double-click the selected card and within a few moments, the Publisher workspace will open. Scroll 
through the four pages of the card to get a feel for the text and design.

	 3.	 Click page one of the card and highlight the placeholder text, such as “Happy Birthday” and type over 
it with your own, such as For the Best Son Shibru (see Fig. 2.52). Highlight the new text, click the Home 
tab at the top of the screen and change the words’ appearance using the Font section of the toolbar or 
ribbon.

	 4.	R epeat the text changes throughout the four pages of the card, including options such as the recipient’s 
name, a favorite song lyric and a Made by section on the back of the selected card.

	 5.	 Click once on a placeholder image on the card and click the Delete key to remove it. Click the Insert tab 
at the top of the screen and click the Clip Art button below it. Type a description related to the card, 
such as “moving,” “balloons,” “soldier” or “love” into the Search for box. Click Go, scroll through the 
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results and double-click an image, which will add it to the card (see Fig. 2.52). Repeat for the other 
pages on the card if desired.

Fig. 2.52: Inserting picture on the card

	 6.	 Click the Page Design tab at the top of the screen. Hover the cursor, without clicking, over the groups of 
colored boxes in the Schemes section of the toolbar/ribbon. Watch how the card changes with the new 
color designs. Click a color group to apply the changes to the selected card.

	 7.	 Click the File tab at the top of the screen. Click “Save As,” type a name of your choice for the card and 
save it.

	   Key Concepts
	 	 Desktop Publishing (DTP) is an application software and hardware system that involves mixing text and graphics 

to produce high-quality output for commercial printing. Some professional DTP programs are QuarkXPress, 
Adobe InDesign, Adobe PageMaker and Microsoft Publisher.

	 	 The major features of desktop publishing are: Templates, Wizard, Text Frames, Borders and Page Tabs.
	 	 The various screen elements of MS-Publisher are: Formatting toolbar, Objects toolbar, Page boundary, Page 

icons, Page margin, Format Publication task pane, Rulers and Standard toolbar etc.
	 	 A brochure is an effective means to provide information about your company’s products and services.  

MS-Publisher’s brochure feature allows you to design a customized brochure with text and graphics. 
	 	 A business card contains essential information. The information on a business card needs to be clear and 

precise. The fonts should be clear and large enough to read.
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Review Questions

Fill in the Blanks
	 1.	 ........................... has reduced the number of steps, the time, and the money required to produce 

professional-looking printed projects.
	 2.	 From the ................................. window, you can create a publication based on one of the many  

purpose-specific templates that come with Publisher.
	 3.	 DTP packages have a wide range of ........................... to help the users make anything from brochures, 

business cards, flyers, calendars to party invitations.
	 4.	 In Publisher, the ........................... toolbar allows you to insert text boxes, tables, and shapes to your 

workspace. 

State Whether True or False
	 1.	 The most important feature of desktop publishing system is WYSIWYG.
	 2.	 Teachers cannot use DTP software to produce worksheets or exercises for students.
	 3.	 The Getting Started with Microsoft Office Publisher 2007 view offers many pre-formatted designs to use in 

creating your publication.
	 4.	 A business card does not contain essential information.

Multiple Choice Questions
	 1.	 Which of the following is not an advantage of creating documents using Word Processor?

		  (a)	 Slow creating process	 (b)	 Pictures and images can be inserted easily
		  (c)	 Error correction is simple and neat	 (d)	 Thesaurus
	 2.	 Which of the following is not correct about PowerPoint?
		  (a)	 Adding Sound to a Presentation	 (b)	 Applying Transition to a Presentation
		  (c)	 Cannot Run a Slide Show Automatically	 (d)	 Check Spelling in a Slide
	 3.	 Which of the following is/are DTP program(s)?
		  (a)	 Microsoft Publisher			   (b)	 Adobe InDesign
		  (c)	 QuarkXPress			   (d)	 All of these
	 4.	 Which of the following is not correct about MS-Publisher?
		  (a)	 Can create Business Cards	 (b)	 Can create Flyers	
		  (c)	 Cannot create Brochures	 (d)	 Can create Greeting Cards 

Match the Following

Column A Column B
1. Ctrl + A (a) Displays the slide and the slide contents
2. Slide pane (b) Selects all the text
3. User of DTP (c) Used to provide information about your company’s 

products and services
4. Brochure (d) Book Publishers 
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Answer the Following 
	 1.	 Give the steps to open Publisher. Also identify the major features of desktop publishing.
	 2.	 How will you organize, format and publish various types of publication using DTP? Explain.
	 3.	 Give the steps to create and format a brochure effectively using DTP.
	 4.	 How will you create and print a business card effectively using DTP? Explain.

Suggested Activities
	 1.	 Create textbox and edit content, insert word art and edit style, insert picture, insert auto shapes, and 

auto format objects in Publisher.
	 2.	 Explain the purpose of brochure and demonstrate the steps in designing an A5 size brochure with 4 sides 

of text/images.
	 3.	 Create or open brochure, add text, format text, insert picture and choose text flow around the picture. 

Copy, move, rotate, resize, fill with color, or delete an object. Insert and delete pages, create page border 
and print preview and print.

	 4.	 Explain and demonstrate how to create or open business card, add a Logo, and design a business 
card.

	 5.	 Explain and demonstrate designing Greetings and Invitation Cards.
	 6.	 Create or open the greeting card or invitation.

Field Trip
	 Organize a field trip to various business houses around you to get useful information about Desktop 

Publishing packages being used currently and present it to the class.
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information and 
computer security

   Unit Outcome
	 Students will be able to:

	 	 understand and aware of copyright issues;

	 	 recognize national and international laws on copyright.

3.1 information and computer security

In Grade 9, you have studied some of the basic concepts of information and computer security. You know 
that computer viruses can corrupt and damage the computers. Viruses can also open security breaches on 
a computer that allows yet another threat, hackers, into computer system. Do you know that simply by 
the fact of having our school or home computers connected to a network and on the Internet (see Fig. 3.1); 
these are exposed to several information and computer security risks?

Fig. 3.1: Networking of computers exposes information and computer security

	 Information and computer security risks arise from the intentional or unintentional misuse of 
computers, network resources as well as the Internet. These risks may result in the loss of or damage to 
computer hardware, software, confidential information, and data integrity as well as network and Internet 
availability. 

	 Hackers can do a number of things, from stealing your passwords to controlling your computer through 
remote access. So, every student and other computer users must know about information and computer 
security. Remember that violation of information and computer security is punishable.

Unit 3   
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Fig. 3.4: Copying a book is violation 
of copyright

	 All of us must make sure that we are aware of the security risks and develop the ability to know what to 
do in different situations. Figure 3.2 shows the impact of information and computer security on society.

Fig. 3.2: Impact of information and computer security on society

	 In this unit, we will learn about information and computer security.

l	S oftware Copyright

What is copyright?

Copyright is the exclusive legal right that prohibits the copying of intellectual 
property without the permission of the copyright holder. Figure 3.3 shows 
the copyright symbol.
	 Copyright relates to ownership of an original work. An original work 
can be in various forms: text, image, audio recording, video recording, 
computer software, website, etc. Copyright automatically belongs to the 
author(s) or creator(s)— but it may also be assigned to a third party, for 
example, a publishing house. The copyright owner(s) has/have the exclusive rights to prevent any third 
party from doing any of the following without permission:
	 1.	 Copy the work: It includes photocopying (e.g., copying a book), 

scanning of texts or images and reproducing them in electronic 
format, and duplicating audio and video recordings.

	 2.	 Communicate copies of the work to the public: It includes 
making a copy available on a public website and the intranet.

	 3.	 Perform a drama or play, a piece of music or a song before 
the public: It includes making recordings of such performances 
and uploading them to a public website and the intranet.

Fig. 3.3: Copyright symbol
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	 4.	 Make derivative works: It includes making modifications, adaptations or other new uses of a work, 
or translating the work to another media.

	 Remember that unless a work is clearly stated to be copyright-free or out of copyright by virtue of its 
age, it is illegal to download, scan or otherwise copy it for onward dissemination, even if no financial gain 
is there. 

Software Copyright
Computer software is considered a literary work, i.e., books, computer 
programs, e-mails, and databases etc. It is protected by copyright laws. 
Unauthorized copying of computer software is not allowed. This applies 
regardless of whether the original copies of the software have been purchased 
on a medium such as a CD-ROM or DVD (see Fig. 3.5), or downloaded from 
the Web.
	 Neither the networking of software without the proper permission from 
the copyright holder is allowed, nor is the copying of software onto several 
stand-alone computers. If the software is to be networked for simultaneous access by a number of users, 
proper permission has to be taken from the publisher. The software user must check the terms and conditions 
on the packaging of the software or in accompanying documentation—which may be in printed or electronic 
format.
	 Software can easily be copied, so it is very important that an educational institution possesses only 
legitimate copies of all the software it uses. 
	 To summarize, it is illegal for the software users to do the following: 
	 1.	 Lend software so that a copy can be made or to copy software while it is on loan.
	 2.	 Run a software program on two or more computers simultaneously unless the agreement permits 

it.
	 3.	 Copy or distribute the software or accompanying documentation without a licence or permission 

from the copyright owner.
	 4.	 Compel, allow, encourage or request that students/employees make, use or distribute illegal copies 

of software.

Copyright Issues for Software Developers 
Software developers must ensure that they have a written agreement with the software users. In other 
words they must protect their software using copyright (see Fig. 3.6). 

Fig. 3.6: Software developers must copyright their software

Fig. 3.5: Computer software 
is available on DVDs
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	 The written agreement protects them with the copyright issues. Some important issues are: 
	 1.	 An adequate description of the software and associated documentation.
	 2.	 Usage terms and conditions.
	 3.	 The right for the user to copy the software and/or associated documentation.
	 4.	 Permission to modify or alter the software.
	 5.	 The requirement that the user reports to the developer any infringement of copyright.
	 6.	 Sub-licences.
	 7.	 Maintenance/Warranty.

Dangers of Copying Others’ Work
Plagiarism is copying others’ work and presenting it as your own. Some dangers of copying others’ work 
are:
	 1.	 It does not show that you understand the topic you have presented. 
	 2.	 It just shows you can cut and paste.
	 3.	 It makes the software ineligible for free maintenance updates in some cases.
	 4.	 There is always the risk of installing malicious code on your computer.
	 5.	 It affects the rights of others.
	 6.	 It affects the social and economical development of all countries.

You must recognize that the use of others’ property is not proper.

l	N ational and International Laws on Copyright
Copyright law aims to prevent people from taking credit for and profiting from other peoples’ work. 
Ethiopia is not short of laws against copyright infringement. Software copyright law is something that 
affects anyone who uses a computer. It is not uncommon for a person or business to face civil or even 
criminal proceedings for software copyright infringement. At present, it is a complex area of law that is not 
widely understood in some countries. Ethiopia has not signed up the Berne Convention yet. However, the 
creative works may be copyright protected locally and directly in the Intellectual Property Department.

National Laws 
In Ethiopia, copyright is a critical issue which requires serious attention and collective responsibility. The 
problem is now very big and forces the artists, the government and the society to realize its impacts and 
find its solutions. Ethiopia has enacted laws for the protection of literary works through copyright. The 
copyright law provides protection for the following:
	 1.	 Written works
	 2.	 Phonographs and cinematographic films
	 3.	 Theatre and musical pieces
	 4.	 Television and radio works for publication
	 5.	 Paintings
	 6.	 Sculpture and architecture
	 7.	 Maps
	 8.	 Speeches and
	 9.	 Literary work



Unit 3 – Information and Computer Security

	 Information Communication Technology — Grade 10 Student Textbook	 	 69

	 The Copyright and Related Rights Proclamation considers software as a literary work and as such a 
fifty years protection is provided. The author has the right to commercially utilize his/her work within the 
bounds prescribed by law. Again, he/she has the right to maintain his/her copyrighted works by means of 
infringement actions to stop others from encroachment in his/her rights. He/she may take a criminal action 
or a civil action in case of any infringement.
	 In Ethiopia the revised criminal code prescribes five-year prison terms to those who violate the copyright 
law with negligence. A more severe penalty, a prison term of up to 10 years is prescribed against a violator 
if the act is intentional. In addition to this, a fine of 100,000 Birr as moral damage may also be levied on 
the guilty party.
	 There have been efforts made recently to try and tackle the problem of copyright violations. One such 
effort is the establishment of the Ethiopian Copyright and Related Rights Collective Management Society 
(ECRRCMS), which was officially established in November 2009, with Ekubay as its Chief Executive Officer 
(CEO).

International Laws 
While there is no single international copyright law, many countries have agreed to international rules for 
protecting intellectual property from copyright infringement, piracy and counterfeiting. 
	 Some international laws are given below:
	 1.	 Berne Convention for the Protection of Literary and Artistic Works: The Berne Convention requires 

its signatories to recognize the copyright of works of authors from other signatory countries (known 
as members of the Berne Union) in the same way as it recognizes the copyright of its own nationals. 
For example, French copyright law applies to anything published or performed in France, regardless 
of where it was originally created.

	 2.	 EU Copyright and Neighbouring Rights: Copyright and related rights provide an incentive for 
the creation and investment in new works and other protected matter (music, films, print media, 
software, performances, broadcasts, etc.) and their exploitation. This is contributing to improved 
competitiveness, employment and innovation. The field of copyright is associated with important 
cultural, social and technological aspects, all of which have to be taken into account in making a 
policy in this field.

	 3.	 International Copyright Law: Creators and users of copyrighted works should be aware of the 
differences in intellectual property law between nations. Many works are now distributed 
internationally or use components from authors in other nations. No international copyright law 
exists that will protect a work in every country of the world. However, several key international 
treaties that the US has signed protect works from and within member nations.

	 4.	 WIPO Copyright Treaty: The World Intellectual Property Organization (WIPO) Copyright Treaty is 
an international treaty on copyright law adopted by the member states of WIPO in 1996. It provides 
additional protections for copyright which are necessary due to advances in ICT since the formation 
of previous copyright treaties before it. There have been a variety of criticisms of this treaty, including 
that it is overbroad and that it applies a ‘one size fits all’ standard to all signatory countries despite 
widely differing stages of economic development and knowledge industry.

Ethiopia has yet to sign the Berne Convention for Literary and Artistic Works and the World Intellectual 
Property Organization (WIPO) Copyright Treaty.
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l	P rotection
In Grade 9, you have studied that virus scanners are one of the most important tools to help protect your 
computer, for example Norton or McAfee. A firewall helps to block unwanted incoming connections to 
your computer from the Internet. Windows already has a built-in firewall. However, if you feel the need to 
increase your security, you can download a firewall program such as Zone Alarm, or Online Armor Free. 
It is also important to install new Windows updates as they appear on your computer. Often, Windows 
updates will address security issues found in the operating system. 
	 Let us first discuss some important concepts, such as misuse of e-mail and unauthorized intrusion:

Misuse of E-mail
Every person or business that uses e-mail as the main communication tool 
should put together an e-mail etiquette guide. Many of us often forget that 
there is another person on the other end of an e-mail and this leads to misuse. 
Some people may not even be aware of the fact that they are misusing e-mail. 
For example, some people do not sign their name at the end of a message in 
the e-mail.  
	 Some of the common mistakes people often make when using e-mail are:
	 1.	 Asking for receipts of all messages. 
	 2.	 Not adding additional information to the messages you forward. 
	 3.	 Typing a message in bold, capital letters. This is like shouting when talking to someone in person. 
	 4.	 Sending lengthy e-mails. Remember that some things are better discussed over the phone or in 

person.
	 5.	 Overuse of the Carbon Copy feature. 
	 6.	 This leads to the Blind Carbon Copy feature.  It is rude to send an e-mail to one person and bcc 

another without their knowledge.
	 7.	 No inclusion of the appropriate greetings, etc.
	 These are just a few of the common e-mail misuses and there are many more. So, next time when you 
communicate via an e-mail, think before you send and make sure you are not guilty of these common 
e-mail misuses.

Unauthorized Intrusion
One type of information and computer security risk is unauthorized access and use. Unauthorized intrusion 
is the use of a computer or network without permission. Hackers typically break into a computer by 
connecting to it and then logging in as a legitimate user. Some intruders do no damage but they merely 
access data, valuable information or programs on the computer.
	 Unauthorized intrusion is the use of a computer or its data for unapproved or illegal activities. It 
includes a variety of activities such as gaining access to a bank computer and performing an unauthorized 
money transfer for financial gains, etc.
	 Sixth Annual IT Security Survey Report says that incidences of unauthorized intrusions of large 
companies increased significantly in 2010.
	 Some examples of unauthorized intrusion are:
	 1.	 Illegally accessing another person’s data or private system files.
	 2.	 Corrupting, destroying, manipulating or deleting others’ data with malicious intent.

Fig. 3.7: Misuse of E-mail 
is growing
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	 3.	 Creating, storing, sending or viewing pornographic material.
	 4.	 Downloading, uploading and/or executing viruses, malware, scripts.
	 5.	 Using e-mail user IDs other than yours own ID.
	 6.	 Violating safety and/or security measures when using e-mail, chat rooms and other forms of direct 

electronic communications.
	 7.	 Hacking or any other unlawful online activities.
	 8.	 Providing unauthorized persons with passwords and access to computers or networks.
	 For preventing unauthorized intrusion:
	 1.	 Have a written acceptable user policy that specifies the computer activities for which the computer 

and the network may and may not be used.
	 2.	 Use firewall
	 3.	 Access controls
	 4.	 Use intrusion detection software
	 Now let us focus on protection:
	 Use of Internet technology often leads to violation of  copyright laws. Remember that you own everything 
you create, regardless of whether you have filed it with the Copyright Office or not. To protect your 
material from unlawful distribution, make others aware of the terms of use of your intellectual property.
	 For protecting your materials do the following:
	 1.	 Include a prominently displayed statement of ownership with the material that you have posted on 

a Website or posted to someone else (for example, “This image is property of Senya Ali and may 
not be used or reproduced without prior permission”).

	 2.	 Include your e-mail address with the statement so that people can contact you for permission to use 
your material.

	 3.	 Add the “Terms and Conditions of Use” or “Legal Information” on the Web page explaining your policy 
on the use of your material. For example, you may wish to allow reproduction for any personal use as 
long as the material remains unaltered or for social welfare.

	 4.	 Consider registering with the Copyright Office to explicitly protect certain materials. Include 
prominently displayed copyright notices with any copyrighted material.

	 Useful Tip

Protecting Your Material

The copsycape.com Website has both a free and paid service for protecting your material. You can paste your 
material in a URL and the site will check other websites for it or you can use the Copysentry service, which 
will automatically alert you if there are any other websites copying your content.

Use of Password
Your online accounts, computer files, and personal information are more secure when you use strong 
passwords to help protect them. Short, easy-to-remember passwords can be easily cracked using simple 
techniques, and may compromise the security of your website or client data.

Windows XP has password options for its folders and files, and using them is an easy process. Password 
protected files are prevented from unauthorized viewing.
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Fig. 3.8: Copyright violation 
is punishable in Ethiopia

What is a strong password?
The strength of a password depends on the different types of characters (both upper-case and lower-case 
letters, numbers and symbols) that you use, the overall length of the password, and whether the password 
can be found in a dictionary. It should be at least 14 characters long.
	 If the website or service allows long passwords, you could consider using pass-phrases instead of 
passwords. Online password generators are available and can give you completely random passwords of 
any level of complexity.
	 Never use the same password for your e-mail, your computer, or your accounts. If you find it hard 
to remember a long list of strong passwords (as most people do!), you could consider using a password 
manager.

	 Useful Tip

Evaluate the Strength of Your Password

For evaluating the strength of your password, use the tool developed by Microsoft at www.microsoft.com/
protect/fraud/passwords/.

Activity 3.1
Why Should Software be Protected by a Copyright Law?
In small groups, students will discuss “Why should software be protected by a copyright law?” The group leader 
from each group will give a presentation to the class based on their discussions.

Software

Software, or programs, are all the electronic instructions that are used to operate computers and related 
devices. They are divided into two categories: system software and application software. Without software, 
hardware are useless.

Copyright

A copyright is the exclusive legal right that prohibits copying of intellectual property without 
the prior permission of the copyright holder. Ethiopian Intellectual Property Office 
(EIPO)-PO Box 25322, Ras Mekonnen Street, Addis Ababa is the competent 
administration for copyright in Ethiopia. The e-mail address of EIPO is eipo@
ethionet.et. Violation of copyright is punishable in Ethiopia (see Fig. 3.8).

Software Copyright Law

Pirated software is software obtained illegally, for example, an illicit copy of a commercial video game. If you 
get such software from a friend or buy it, then the original copyright owners are not paid for their work. Also 
there is a risk of getting inferior goods and, worse, picking up a virus.   

	 Software copyright law affects anyone who uses a computer and particularly businesses. It is a complex area 
of law that is not widely understood. For example, application software (e.g., commercial software, shareware, 
freeware, rentalware) and system software are copyrighted. In Ethiopia, the law does not permit illegal copying 
of computer software. 

	 Software manufacturers do not sell you their software; rather they sell you a license to become an authorized 
user of it. In paying for a software license, you sign a contract in which you agree not to make copies of the 
software to give away or resell.
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	 Each software company has a different license; there is no industry standard. Various types of licenses exist. 
A software license usually consists of:

	 1.	 Permissions granted by the creator to the user,
	 2.	 Rights granted by the creator to the user,
	 3.	 Restrictions placed by the creator,
	 4.	 Limitations on the creator’s liability,
	 5.	 Warranties and warranty disclaimers,
	 6.	 Indemnity (security against damage or compensation), and
	 7.	 Term/duration of the license.

	 Violation the terms of the license infringes the legal rights of the creator of the software and can lead to legal 
action.
	 The license usually prohibits the following acts:

	 1.	 Modification of the software
	 2.	 Adaptation of the software
	 3.	 Translation of the software
	 4.	 Preparing derivative works from the software
	 5.	 Decompiling the software
	 6.	 Reverse engineering the software
	 7.	 Disassembling the software

	 The Ethiopian Government is expanding ICT infrastructure, which will make people aware of the software 
copyright issues. So, you must understand why should software be protected by a copyright law.

	   Key Concepts
	 	 Information and computer security risks arise from the intentional or unintentional misuse of computers, 

network resources as well as the Internet.

	 	 Copyright is the exclusive legal right that prohibits the copying of intellectual property without the permission 
of the copyright holder.

	 	 Copying others is called plagiarism. It involves using the work of others and presenting it as one’s own.

	 	 Unauthorized intrusion is the use of a computer or network without permission.

	 	 Your online accounts, computer files, and personal information are more secure when you use strong passwords 
to help protect them.

Review Questions

Fill in the Blanks
	 1.	 Violation of information and computer security is ........................... .
	 2.	 ........................... relates to ownership of an original work.
	 3.	 Computer software is considered a literary work and is protected by ........................... .
	 4.	 Never use the same ........................... for your e-mail, your computer, or your accounts.
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State Whether True or False
	 1.	 When the computers are connected to a network and on the Internet, these are exposed to several 

security risks. 
	 2.	 Unauthorized copying of computer software is allowed.
	 3.	 Ethiopia is not short of laws against copyright infringement.
	 4.	 Corrupting, destroying, manipulating or deleting others’ data with malicious intent are examples of 

unauthorized intrusion.

Multiple Choice Questions 
	 1.	 Which of the following is/are the impact of information and computer security on society?
		  (a)	 Employment	 (b)	 Privacy	 (c)	 Health	 (d)	 All of these
	 2.	 Information and computer security is used to protect users from
		  (a)	 Hackers	 (b)	 Hardware failure	 (c)	 Software Piracy	 (d)	 All of these
	 3.	 ........................... is the use of a computer or network without permission.
		  (a)	 Licensed software 	 (b)	 Unauthorized  intrusion	 (c)	 Netiquette	 (d)	 Firewall
	 4.	 A ........................ is a secret code or string of characters that is used to authenticate an authorized user.
		  (a)	 Password	 (b)	 Hacker	 (c)	 Virus	 (d)	 Worm

Match the Following

Column A Column B
1. Information and computer 

security risks
(a) International Law on Copyright

2. WIPO Copyright Treaty (b) Secures online accounts, computer files and personal information

3. Misuse of e-mail (c) Arise from the intentional or unintentional misuse of computers, 
network resources as well as the Internet

4. Strong Password (d) Sending lengthy e-mails

Answer the Following
	 1.	 Explain about copyright issues.
	 2.	 Explain about software copyright. Describe the dangers of copying others.
	 3.	 Give the national and international laws on copyright.
	 4.	 How can copying be protected? Explain use of password.

Suggested Activities
	 1.	 Why software needs to have a copyright law? Discuss.
	 2.	 Discuss how copying affects the right of others and the development of countries in terms of different 

aspects—social and economical.
	 3.	 Work collectively with others and use password appropriately.
	 4.	 Discuss rights and wrongs of indiscriminate copying and software piracy.
	 5.	 Identify the impact of unauthorized intrusion, manipulating or deleting others’ data and prevent misuse 

of e-mail and its social impact.

Field Trip
	 Organize a field trip to various educational institutions or business houses in your city to interact with ICT 

users. Prepare a report on “Information and Computer security” and discuss it in the class.
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Application 
Software

   Unit Outcome
	 Students will be able to:

	 	 know how to create charts and graphs in spreadsheet;

	 	 apply spreadsheet for different applications;

	 	 understand some common uses of database;

	 	 recognize query, form and report in a database application.

4.1 key features of spreadsheets

The spreadsheets are one of the most widely used application software in the world. These are used 
everywhere from a small store to a large manufacturing house. These can be used for calculating accounts, 
managing inventory, managing payroll, managing and analysing the sales and marketing. These software 
are also used to manage household data like recording expenditures. As spreadsheets are much easier to 
learn than programming languages, these can be operated by any user having a moderate knowledge of 
programming.
	 In Grade 9, you have studied about spreadsheets. Let us revise some of the basic concepts.

l	R evision of Spreadsheet
The spreadsheet is an application software which provides the users powerful tools and features to analyze, 
share, and manage the data with ease, for example, Microsoft Excel.

Starting Spreadsheets
MS-Excel 2007 is a GUI based spreadsheet package that is part of Microsoft Office 2007 suite of 
software. 
	 To start MS-Excel 2007, perform the following:
	 Double-click on the MS-Excel 2007 icon on the desktop.

OR
	 Click Start → All Programs → Microsoft Office → Microsoft Office Excel 2007

Screen Elements of Spreadsheets
On starting spreadsheet i.e., MS-Excel 2007, a spreadsheet window appears. The screen elements of 
Excel spreadsheet are shown in Fig. 4.1.

Unit 4   
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Fig. 4.1: Screen elements of Spreadsheet—Excel 2007

 For exploring massive amounts of data, Excel 2007 grid is 1,048,576 rows by 16,384 columns. The 
columns now start from A and end at XFD.

Fill handle is a small black square displayed at the bottom right corner of the active cell. The fill handle 
is used to fill adjacent cells with the same data or consecutive data. The entries that are automatically 
inserted in the adjacent cells are dependent on the contents of the active cell.

Create and Use a Simple Spreadsheet

Creating a Worksheet
To create a worksheet, perform the following steps:
 1. Click the Office Button.
 2. Click the New option.
 3. Double click the Blank Workbook or click on the Create button.
 A new worksheet is created.

Using a Spreadsheet
After creating a worksheet, you can enter data (for example, words, a number, or a formula) in the active 
cell. The spreadsheet can be used as per your need.

Entering and Editing Text

Entering Data
For entering data, perform the following steps:
 1. Select the cell where the data has to be entered.
 2. Type the data. To enter data in active cell, type the characters. Either press Tab key to go to the next cell 

in the same row or press Enter key to go to the next cell in the same column.
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Editing Data
For editing data (in case we have made mistakes or some changes are required), perform the following 
steps:
	 1.	 Double-click the cell, which has to be edited.
	 2.	 Use the Backspace or Delete key to edit the content of the cell.
	 3.	 Press the Enter key.

Change Data in a Cell
After entering data into a cell, you can edit the data by pressing F2 while you are in the cell you wish to 
edit. For example, we wish to change “Shibra” shown in cell A1 (see Fig. 4.2) to “Shibru”.

Fig. 4.2: Changing data in a cell

	 To change data in a cell, perform the following steps:
	 1.	 Move to cell A1.
	 2.	 Press F2. 
	 3.	 Use the Backspace key to delete the “a”.
	 4.	 Type “u”.
	 5.	 Press Enter key. The cell contents change to “Shibru” (see Fig. 4.3).

Fig. 4.3: Cell after changing data

You can also edit a cell by using the Formula Bar or by Double-Clicking in the cell or by typing in a 
cell.
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Saving the Worksheet
For saving a worksheet the first time, perform following steps:
	 1.	 Click the Office Button.
	 2.	 Click the Save As option.
	 3.	 Click the Excel Workbook option. A Save As dialog box appears.
	 4.	 Type the name for the worksheet in the File name textbox.
	 5.	 Click the Save button.

Using the Four Mathematical Operators on Data to Create Custom Formula
In MS-Excel, you can enter numbers and mathematical formulae into cells. When entering a mathematical 
formula, precede with an equal (=) sign. For example, = A2 + A3 can be typed in cell A5 (where cells A2 
and A3 have data to be added).

In MS-Excel, you can find the sum by dragging method and copy by using the fill handle.

	 Now, you have revised the Grade 9 main concepts about spreadsheet. Let us focus on some new 
concepts of spreadsheet.

Definition of a Chart
A chart is a graphical representation of the figures in a spreadsheet. 
	 Charts help in easy understanding of complex or detailed data. These reflect information in such a way 
that it can be easily understood just by having a look at the chart.
	 MS-Excel 2007 supports various types of charts to display data in meaningful ways. When you want to 
create a chart or change an existing chart, you can choose from a wide range of chart subtypes available 
for the different chart types. Figure 4.4 shows a pie chart.

Fig. 4.4: Pie chart

Creating Charts
A picture is worth thousands of words. Popular feature of spreadsheet software is the ability to generate 
charts based on numeric data. In MS-Excel 2007, it is easy to create professional looking charts simply by 
choosing a chart type, a chart layout, and a chart style—all of which are available on the Ribbon. You can 
also take advantage of the powerful Excel charting functionality in other MS-Office 2007 programs, such 
as PowerPoint 2007 and Word 2007.
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Column Chart
Data that is arranged in columns or rows on a worksheet can be plotted in a column chart. Column charts 
are useful for showing data changes over a period of time or for illustrating comparisons among items. In 
column charts, categories are typically organized along the horizontal axis and values along the vertical 
axis.
	 The subtypes of column charts are: Clustered column and clustered column in 3-D, Stacked column 
and stacked column in 3-D, 100% stacked column and 100% stacked column in 3-D, 3-D column, Cylinder, 
cone, and pyramid.   

Bar Chart
Data that is arranged in columns or rows on a worksheet can be plotted in a bar chart. Bar charts illustrate 
comparisons among individual items. The bar charts are generally used when: 
	 1.	 The axis labels are long.
	 2.	 The values that are shown are durations.
	 The subtypes of bar charts are: Clustered bar and clustered bar in 3-D, Stacked bar and stacked bar in 
3-D, 100% stacked bar and 100% stacked bar in 3-D, Horizontal cylinder, cone, and pyramid.

Pie Chart
Data that is arranged in one column or row only on a worksheet can be plotted in a pie chart. Pie charts 
show the size of items in one data series, proportional to the sum of the items. The data points in a pie chart 
are displayed as a percentage of the whole pie (see Fig. 4.4). The pie charts are generally used when:
	 1.	 You only have one data series that you want to plot.
	 2.	 None of the values that you want to plot are negative.
	 3.	 Almost none of the values that you want to plot are zero values.
	 4.	 You do not have more than seven categories.
	 5.	 The categories represent parts of the whole pie.
	 The subtypes of pie charts are: Pie and pie in 3-D, Pie of pie and bar of pie, Exploded pie and exploded 
pie in 3-D. 

l Presenting Data by Chart
The Chart Wizard (which was composed of a series of dialog boxes that provided all the available options 
for creating a chart) of earlier versions is no longer available in Excel 2007. It has been replaced by chart 
options listed under the Insert ribbon. 
	 MS-Excel 2007 has tools for creating effective, dynamic charts to visually represent the data. The new 
Office 2007 Ribbon makes accessing these charting functions even easier and more efficient.
	 To create a chart, perform the following steps:
	 1.	 Open Excel 2007 and either open an existing worksheet or use the default. Enter or create some data 

that supports the creation of a chart, for example Students Marks in ICT (see Fig. 4.5). This data 
should be in the form of a table, with the element values to be charted populating the left hand 
column and the data series, or information about the elements, in the cells across from each element. 
More than one series can be included for each element. Title the data series across the top of the 
table and do not leave any blank spaces in the table.
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Fig. 4.5: Data in a worksheet to be charted

	 2.	 Select the data to be charted (see Fig. 4.6). Left-click and drag a box around the data to select it. 
Make sure to include both the data and the labels.

Fig. 4.6: Selecting data to be charted

	 3.	 Choose the chart type. Select Insert on the Excel 2007 ribbon and then choose from the chart types 
listed in the Charts section (see Fig. 4.7). For a chart type that’s not visible, select the Other Charts 
icon. The chart will be placed on the worksheet near the table of data. By default, the series will be 
listed across the bottom, or “x-axis” and the elements will be listed to the side. The element values 
will be listed on the left, or “y-axis” of the chart.

Fig. 4.7: Selecting chart type

	 4.	 Position the chart. Left-click on any white space on the chart, and move it to the desired location 
(see Fig. 4.8).
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Fig. 4.8: Column chart ready to be placed in the desired location

	 5.	 Now you can format the chart. Right-click on the chart and a variety of options will appear in a 
dialog. Change the font displayed within the chart, change the chart type and select different chart 
data by selecting the relevant item from the list. To change the chart’s appearance, select Format 
Chart Area and then select from the options to change the chart’s Fill, Border Color, Border Styles, 
Shadow and 3-D Format.

l Using Spreadsheet to Process Data
Spreadsheet can be used to process data. In MS-Excel, you can enter numbers and mathematical formulae 
(formulae are equations that perform calculations on values) into cells. Whether you enter a number 
or a formula, you can reference the cell when you perform mathematical calculations such as addition, 
subtraction, multiplication, or division. A formula starts with an equal sign (=). Before using custom formula, 
let us identify the difference between absolute and relative cell references.

Difference Between Relative and Absolute Cell References
A reference identifies a cell or a range of cells on a worksheet and tells MS-Excel about where to look 
for the values or data that you want to use in a formula. With references, you can use data contained in 
different parts of a worksheet in one formula or use the value from one cell in several formulae.
	 Relative Reference: It is the default addressing used by Excel. A relative 
cell reference in a formula, such as A1, is based on the relative position of 
the cell that contains the formula and the cell the reference refers to. If 
the position of the cell that contains the formula changes, the reference is 
changed. If you copy or fill the formula across rows or down columns, the 
reference automatically adjusts. For example, if you copy or fill a relative 
reference in cell B2 to cell B3, it automatically adjusts from =A1 to =A2 
(see Fig. 4.9).
	 Absolute Reference: Use absolute reference when you do not want Excel to change the cell addresses 
relatively, when you copy a formula. An absolute cell reference in a formula, such as $A$1, always refers 

Fig. 4.9: Copied formula with 
relative reference
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Fig. 4.10: Copied formula with 
absolute reference

to a cell in a specific location. If the position of the cell that contains the 
formula changes, the absolute reference remains the same. As mentioned 
earlier, by default, new formulae use relative references, and you may need 
to switch them to absolute references. For example, if you copy or fill an 
absolute reference in cell B2 to cell B3, it stays the same in both cells =$A$1 
(see Fig. 4.10).

Using Custom Formula
Using a custom formula is as simple as the other commands of Excel. To 
write the formula, click on the cell in which you want to have result of the calculation. Type = sign and 
write the formula using cell addresses and arithmetic and logical operators supported by Excel. 
	 A formula in Excel contains cell addresses, operators and built-in functions. Working with formulae is 
very easy in Excel and it does not require a high programming knowledge. For example, in Fig. 4.11, the total 
of marks scored by students has been calculated in cell B8 by using the custom formula =B2+B3+B4+B5+B6. 
The cell B8 contains the sum of B2, B3, B4, B5, and B6 cells.

Fig. 4.11: Using custom formula

Using if condition
If function of Excel is a conditional construct that displays one or the other value in a cell based on the 
condition applied. If the condition is true, one value is displayed otherwise the other value is displayed.
	 The syntax of IF function is:
	 IF (Condition, Value if True, Value if False)
	 The three items between the parentheses are the arguments of IF function. Here,
	 Condition is what you want to test for. 

	 Value if True is what you want to do if the answer to the first argument is TRUE. 

	 Value if False is what you want to do if the answer to the first argument is FALSE. 
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	 For example, open a new spreadsheet, and perform the following steps:
	 1.	 Widen the B column, as we will be putting a message in cell B1.
	 2.	 Now click in cell A1 and type the number 7.
	 3.	 Type the following in cell B1.
	 =IF(A1>=6, “Greater than or Equal to Six”, “Less than Six”)
	 Press the Enter key and the spreadsheet should look as shown in Fig. 4.12.

Fig 4.12: Using if condition

	 In the above example, make sure that all the commas and double quotes are in the correct place; 
otherwise Excel will give an error message. 

Using Built-in Functions
Now you are familiar with the formulae in Excel. It is very easy to write these formulae but, in some 
situations, we have to solve complex problems that are difficult to be solved with these basic formulae. 
Excel has several built-in functions to make your work easy and fast. There are many functions, grouped 
under various categories like: math and trigonometry functions, statistical functions, date functions, text 
functions, etc.
	 Let us learn how to calculate using worksheets:

	 1.	 AutoSum : It calculates the sum of the selected contiguous cells directly after the selected cells. 
For example, 

		  Start Excel and open a worksheet to enter some numbers for addition in a column or a row.
		  Click a cell below the column of numbers or to the right of the row of numbers. 

		  On the Home tab, in the Editing group, click AutoSum button  (see Fig. 4.13). 

Fig. 4.13: Selecting AutoSum
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		  Excel displays a dashed border on the cell range for parameters.
		  Press Enter key and you will get the sum of the numbers in the selected cell (see Fig. 4.14).

Fig. 4.14: Sum calculated using AutoSum

	 2.	 SUM ( ): It adds all the numbers in a range of cells.
		  The syntax of SUM function is:
			   SUM(number1, number2, ...)
		  Here, number1, number2, ... are 1 to 255 arguments for which you want the total value or sum.
		  For example,
		  =SUM(A2:A6) will give the sum of the specified range (see Fig. 4.15). 

Fig. 4.15: Calculation using worksheet

The SUM function can include upto 30 cells or range references.

	 3.	 AVERAGE( ): It returns the average (arithmetic mean) of the arguments.
		  The syntax of AVERAGE function is:
			   AVERAGE(number1, number2, ...)
		  Here, number1, number2, ...   are 1 to 255 numeric arguments for which you want the average.
		  For example,
		  =AVERAGE(A2:A6)  will return the average of the specified range (see Fig. 4.15).
	 4.	 MAX( ): It returns the largest value in a set of values.
		  The syntax of MAX function is:
			   MAX(number1, number2, ...)
		  Here, number1, number2, ... are 1 to 255 numbers for which you want to find the maximum 

value.
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		  For example,
		  =MAX(A2:A6) will return the largest value in the specified range (see Fig. 4.15).
	 5.	 MIN( ): It returns the smallest number in a set of values.
		  The syntax of MIN function is:
			   MIN(number1, number2, ...)
		  Here, number1, number2, ... are 1 to 255 numbers for which you want to find the minimum 

value.
		  For example,
		  =MIN(A2:A6) will return the smallest value in the specified range (see Fig. 4.15).

More Complex Exercises Using +, – ,*, /
We can use Excel to perform advanced calculations using +, –, *, /. For example,
	 1.	 Start Excel. Open a worksheet and move to a cell. Here, we have moved to cell A1.
	 2.	 Type =6–3+12/3*4.
	 3.	 Press Enter.

	 MS-Excel divides 12 by 3, multiplies the answer by 4, adds 6, and then subtracts 3. The answer, 19, is 
displayed in cell A1 (see Fig. 4.16).

Fig. 4.16: Performing calculations

	 To change the order of calculation, use parentheses. MS-Excel calculates the expression in parentheses 
first.
	 1.	 Double-click in cell A1.
	 2.	 Edit the cell to read =(6–3+12)/3*4.
	 3.	 Press Enter.
	 MS-Excel adds 6 minus 3 plus 12, divides the answer by 3, and then multiplies the result by 4. The 
answer, 20, is displayed in cell A1 (see Fig. 4.17).

Fig. 4.17: Changing order of calculations using parentheses
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l Formatting Worksheet

Formatting refers to the act of changing the appearance of data in cells. In MS-Excel, you can format text, 
format cells, adjust columns and rows and print worksheets. Let us apply formatting on a worksheet.

	 1.	 Start Excel. Open an existing worksheet (here we have opened Students Marks in ICT) and click  
cell A1. 

	 2.	 In the Ribbon, click the Bold button  and the Italic button .

	 3.	 Click the drop-down arrow beside the Font Size box. 
	 4.	 When the menu appears, click 20 (see Fig. 4.18). 
	 5.	 In the Font list, click Arial Black. 
	 6.	 Highlight the text in range A3:A7.

 
Fig. 4.18: Formatting a worksheet

	 7.	 Click the Bold button  to make the text bold. 
		  The worksheet will look as shown in Fig. 4.19.

Fig. 4.19: Worksheet after formatting

Activity 4.1
Compute the Rank using the Rank Function taking a given Numerical 

Item as an Example

In small groups students will explain and demonstrate how to compute rank.
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What is Rank?

The rank of a number is its position in a list of numbers.

RANK( ): This statistical function returns the rank of a number in a list of numbers. 

The syntax of RANK function is:

	 RANK(Number, Ref, Order)

The three items between the parentheses are the arguments of RANK function. Here,

Number is the number whose rank you want to find.

Ref is a reference to, or a list of numbers. Nonnumeric values in ref are ignored.

Order is a number specifying how to rank number.

If order is 0 (zero) or omitted, Excel ranks number in descending order. If order is any nonzero value, Excel 
ranks number in ascending order. 

RANK gives duplicate numbers the same rank. However, the presence of duplicate numbers affects the ranks 
of subsequent numbers. For example, in a list of integers sorted in ascending order, if the number 20 appears 
twice and has a rank of 5, then 21 would have a rank of 7 (no number would have a rank of 6).

Example of Computing Rank

To compute rank, perform the following steps:

	 1.	 Open an existing worksheet (see Fig. 4.19) or create a new one.

	 2.	 Click on cell D5—the location where the result will be displayed.

	 3.	 Click on the Formulas tab.

	 4.	 Select More Functions → Statistical from the ribbon to open the function drop down list  
(see Fig. 4.20).

Fig. 4.20: Selecting Statistical in More Functions

	 5.	 Click the drop-down arrow and select RANK from the list to bring up the function’s dialog box. 

	 6.	 Click on cell B5 to choose the number to be ranked (95). 
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	 7.	 Click on the Ref line in the dialog box. 

	 8.	 Drag select cells B3 to B7 in the spreadsheet to enter the range into the dialog box.

	 9.	 Click on the Order line in the dialog box. 

	 10.	 Type 0 (zero) on this line to rank the number in descending order. 

	 11.	 Click OK.

	 12.	 The number 1 should appear in cell D5 since the number 95 is the largest number.

	 13.	 The complete function = RANK (B5,B2:B7,0) appears in the formula bar above the worksheet when you 

click on cell  D5 (see Fig. 4.21).

Fig. 4.21: Computing rank

	   Key Concepts

	 	 Spreadsheet is an application software, which allows us to perform quick and easy calculations on our stored 
data.

	 	 Fill handle can be used for copying cells, copying formulae using relative references, generating series and 
generating auto lists.

	 	 A chart is a graphical representation of the figures in a spreadsheet. 

	 	 If function of Excel, is a conditional construct that displays one or the other value in a cell based on the 
condition applied. 

	 	 Excel has several built-in functions to make your work easy and fast. For example, Sum( ), Max( ), Rank( ), 
etc.

Assessment 4.1

Fill in the Blanks
	 1.	 The ........................... allows users to create tables and financial schedules by entering data and formulae 

into rows and columns arranged as a grid on a display screen. 
	 2.	 There are  ........................... rows and  ...........................  columns in Excel 2007 worksheet.
	 3.	 ........................... charts are useful for showing data changes over a period of time or for illustrating 

comparisons among items.
	 4.	 ........................... refers to the act of changing the appearance of data in cells.
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State Whether True or False

	 1.	 Fill handle is a special utility in Excel, which is mainly used for copying formulas.
	 2.	 A chart is a graphical representation of the figures in a spreadsheet. 
	 3.	 We cannot use spreadsheet to process data.	

	 4.	 Rank function returns the average (arithmetic mean) of the arguments.

Answer the Following
	 1.	 Define a chart and explain the use of charts.
	 2.	 What are the various types of charts supported by Excel? Write steps to insert a chart.
	 3.	 Explain any four built-in functions of Excel.
	 4.	 What do you mean by formatting a worksheet?  Write steps to format text and numbers in the cell of a 

worksheet.

Suggested Activities
	 1.	 Master introductory parts of spreadsheet by revising the Grade 9 main contents.
	 2.	 Explain the use of charts.
	 3.	 Demonstrate how to create the listed charts in Excel.
	 4.	 In mathematics compare the growth of an arithmetic progression with a geometric progression. 

Field Trip
	 Using the Internet or computer magazines, look up information on Microsoft Excel 2010. List any features 

you find. List which of these features appeal to you and describe why they do.

4.2 database application

Every organization maintains data for its business, employees and finance. This data need to be maintained 
in such a manner that it is easily available and can be presented in desired formats. The data also needs 
to be updated regularly.
	 Traditionally data were maintained in paper files. The following are the disadvantages of manual data 
maintenance by using paper files:
	 1.	 Data redundancy
	 2.	 Slow data access
	 3.	 Security problems
	 4.	 Integrity problems
	 The advent of database management system paved a way to overcome these disadvantages.

l Introduction to Database

What is Database?

A database is a collection of related data that is organized, so that it can easily be accessed, managed and 
updated.
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	 For example, a database can contain data about all the students in a school, data about telephone 
numbers in a directory, data about all products in a manufacturing company, or data about weather 
conditions in an area or a city (say Addis Ababa).
	 Microsoft Office Access 2007 is one of the database creation and management programs.
	 It is a Database Management System (DBMS) included with Microsoft Office suite. Interacting with a 
DBMS occurs when one performs daily routine activities, for example, withdrawing cash from the ATM, 
or purchasing tickets using a credit card.

l Uses of Database
A database stores information in an organized way, and makes it easy to get information in and out. In 
today’s world databases are used by websites such as Google.com and Yahoo.com, and in places such as 
banks, libraries and hospitals. 
	 The common areas where data bases are used are:
	 1.	 Government: The government uses a database to store records of people’s data for different purposes, 

for example, census, income tax payments, etc.
	 2.	 Business: Today the business world depends on databases round the clock. Inventory, order 

processing, payroll, accounting, shipping and transportation routing are often tracked within a main 
database that keeps the organization/company functioning. 

	 3.	 Educational Institutions: From elementary schools/colleges to universities, educational institutions 
use the database to keep track of students’ data. Specialized database packages for schools/colleges 
and universities are also available. 

	 4.	 Non-Profit Organizations: Most of the charities and other non-profit groups use a database for 
keeping track of donations, volunteers, hours served in the community, clients helped and other 
information related to the organization. 

	 5.	 Household and Family Management: The database is very useful in household and family 
management for many individuals and families. Many individuals/families use a database to keep 
track of family birthdays, bills and expenses within a home; addresses of friends and relatives; 
movie/DVD collections; and other lists. 

	 6.	 Everyday Life: Some departmental stores keep your information stored in a customer database. 
When you make a purchase, the sales clerk asks for your address or customer account number. 
These collections of data are used to send mailings of special offers, discounts and other deals. 

l Common Database Applications
Databases are used in many applications, covering almost the entire range of computer software. Databases 
are the preferred method of storage for large multiuser applications, where coordination between many 
users is needed. Many electronic mail programs and personal organizers are based on standard database 
technology.
	 Some examples of database applications are: 
	 1.	 Computerized library systems.
	 2.	 Automated Teller Machines (ATMs). 
	 3.	 Flight reservation systems. 
	 4.	 Computerized inventory systems.
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 Any application that involves storing and maintaining a large amount of data in an organized manner 
can be set up as an Access database. For example, customers and invoices, suppliers and purchases, 
inventory and orders, etc.

l Database terminology
Let us discuss some of the useful terms related to database:
 Table: A table in a database is a predefined format of rows and columns that define an entity. It is also 
called a relation. For example, the STUDENT table shown in Table 4.1.

Table 4.1: STUDENT Table

ID Stud Name Father Name Sex Age Phone Number

1 Abraham Nigatu Male 13 222222

2 Beza Yasin Female 12 111111

3 Hana Fuad Female 13 555555

4 Shibru Engda Male 14 444444

5 Maru Tariku Male 13 333333

 Record: A database record consists of one set of tuples in a table. In other words, a row of information 
in a table is called a record.  For example, Table 4.1 has five records.
 Field: A field is a single unit of data stored as part of a database record. Each record is made up of one 
or more fields, which correspond to the columns in a database table. Fields are often called attributes. For 
example, Table 4.1 has six fields.
 Data Type: A data type specifies the type of data that a column in a table represents in a database. 
For example, numeric, character or text, date, logical, etc. For example, in Table 4.1 Stud Name is of text 
type.
 Primary Key: Every table should contain a field that uniquely identifies each record stored in it. This 
field is called the primary key of the table.  Primary keys may consist of a single field or multiple fields 
in combination. For example, in Table 4.1, the student’s unique ID number would be a good choice for a 
primary key. The Stud Name would not be a good choice, as there is always the chance that more than 
one student might have the same name.

l Designing a Database Structure
Before you start creating a database, it is essential to create a good database design. Planning the design 
structure is important, as an improper design will cause changing the design structure. A good database 
design ensures that the database is easy to maintain and store data.
 To plan and design a database, the points to be considered are:
 1. The purpose of the database.
 2. The number of tables and the type of information each table will contain.
 3. Columns that will form each table.
 4. Relationship between tables.    

You can decide your own database structure as per your requirement. For example, one table in a 
customer database might store names and addresses while another table stores the customer invoices 
and another table stores the customer payments.
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l Open an Existing Database
Suppose you are having MS-Access 2007 installed on your computer. There are different methods you 
can use to open existing Access 2007 databases. You can open databases from Windows Explorer or from 
within Access. You can open multiple databases at once, and you can also create desktop shortcuts that 
open database objects directly. 
	 To open an existing database from Access, perform the following steps:
	 1.	 Click Start → All Programs → Microsoft Office → Microsoft Office Access 2007 (see Fig. 4.22).

Fig. 4.22: Starting MS-Access

	 2.	 Click the Microsoft Office Button , and then click Open.
	 3.	 Click a shortcut in the Open dialog box, or in the Look in box, click the drive or folder that contains 

the database that you want to open.
	 4.	 In the folder list, browse to the folder that contains the database.
	 5.	 When you find the database, double-click the database to open it in the default mode specified in 

the Access Options dialog box or the mode that was set by an administrative policy.

l Overview of a Table
A database table contains data about a particular subject (see Table 4.1). In a table the data is arranged in 
rows and columns. To get the most flexibility out of a database; the data needs to be organized into tables 
so that redundancies do not occur. For example, if you are storing information about students, each student 
should only need to be entered once in a table that is set-up just to hold student data.
	 Each row in a table is referred to as a record. Records are where the individual pieces of information 
are stored. Each record consists of one or more fields. Fields correspond to the columns in the table. Fields 
must have a certain data type, whether it is text, date or time, number, or some other type.

l Creating a Table
One must plan and design a table properly for a new database before creating it. You can use Design view 
to create an Access table. Using Design view is the preferred method for creating a table because it provides 
you with the most options and enables you to precisely define your table. In addition to selecting a data 
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type, you can set the other available options in Design view.  Suppose we have to create Table 4.1 in Access. 
Perform the following steps:
	 1.	 Start Ms-Access and activate the Create tab. Click Table Design in the Tables group (see Fig. 4.23).

Fig. 4.23: Clicking Table Design

	 2.	 Access changes to Design view and the Table Tools become available.
	 3.	 Type the field name in the Field Name field.
	 4.	 Press the Tab key.
	 5.	 Click the down-arrow that appears when you click in the Data Type field and then select a data 

type.
	 6.	 Click Primary Key if the column you created is a primary key. A small key appears next to the field 

name.
	 7.	 Press the Tab key.
	 8.	 Type a description. The description is optional.
	 9.	 Press the Tab key. Access moves to the Field Name field.
	 10.	 Repeat steps 3 through 9 until you have created all of your fields (see Fig. 4.24).

Fig. 4.24: Creating a Table

	 11.	 To set field properties, click the field for which you want to set the field properties. Activate the 
General tab in the Field Properties area.  Set the properties you want to set. Repeat until you have set 
all the properties for all fields.
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	 12.	 After finishing the task, click the Save button on the Quick Access 
Toolbar. Access saves the table unless you are saving for the first time. 
If you are saving for the first time, the Save As dialog box appears. 
Type the name you want to give your table. Here, we have saved the 
table as STUDENT (see Fig. 4.25).

	 13.	 Click OK. Access saves the table. 
You can use field names that include spaces, but this can affect how queries have to be written, so it is 
best not to do so.

l Add, Edit, Delete and Sort Records
After creating an Access table, you can add, edit, delete and sort records in it. Before you can perform an 
operation on a record, you must select it. To select a record, click the blank area to the left of the row. To 
select several records, click the blank area to the left of a row and then drag. To select the entire table, click 
the Select All button  in the upper-left corner of the table.
	 In Datasheet view, you can select the field or fields as:
	 To select one field, click it’s header.
	 To select more than one adjacent fields, click the header of one, hold down the Shift key, and then click 
the header of another. The two fields and any fields in between are selected.
	 In Design view, you can select the field or fields as:
	 To Select one field, click the row selector for the field you want.
	 To select more than one field, hold down Ctrl key and then click the row selector for each field.

Adding Records
Adding a new record to an existing Access 2007 database is quite simple. In fact, being able to modify the 
database in this way is one of the reasons why Access is so accessible and easy to use. To add record(s) in 
a table, perform the following steps:
	 1.	 Open the table. Here, we have opened the STUDENT table. Notice that the table contains an empty 

record at the bottom of the table’s data with the word (NEW) in the first column.
	 2.	 Click on that cell in the table and then press the TAB key on your keyboard.
	 3.	 Type the new information you want in that field and then press TAB again. Now type the 

information you want in that cell and continue in this way until you wish to add records to the table  
(see Fig. 4.26).

Fig. 4.26: Adding records

When you add a record in a table, the cursor in the row selector moves down to the next (new) record. 
When you move on to a new record, Access automatically saves the previous record. 

Fig. 4.25: Save As dialog box
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Editing Records
Data stored as records in tables can be modified at any point in time. 
	 To make changes to a record in a table, perform the following steps:
	 1.	 Open the table having the record(s) you want to edit.
	 2.	 Place the cursor in the required cell.
	 3.	 Remove the existing value.
	 4.	 Enter the new data.

		 The value in the field will be changed. Make other changes (if any) and save the table.

Deleting Records
You can delete record(s) from tables if it/they is/are not required.
	 To delete a record from a table, perform the following steps:
	 1.	 Open the table and select the record you want to delete.
	 2.	 Activate the Home tab.
	 3.	 Click Delete in the Records group. A prompt appears.
	 4.	 Click the Yes button.
	 The selected record will be deleted. Similarly delete the other records (if you wish) and save the 
table.

Sorting Records

Sorting is arranging records in a table, so that the records can be retrieved quickly and easily. By sorting, 
you can put a column of information in alphabetical, numerical, or date order. You can sort in ascending 
order (alphabetical from A to Z, lowest number to highest number, earliest date to latest date) or descending 
order (alphabetical from Z to A, highest number to lowest number, latest date to earliest date). You can 
also sort within a sort. 
	 To sort records in a table, perform the following steps:
	 1.	 Open the table. Here, we have opened the STUDENT table (see Fig 4.26).
	 2.	 Click the column label for the column (here, Phone Number) you want to sort. 
	 3.	 Activate the Home tab.

	 4.	 Click the Ascending   or Descending  button in the Sort & Filter group. Here, we have selected 

the Ascending   button. 
	 5.	 Access sorts the column in ascending (see Fig. 4.27).

Fig. 4.27: Sorting the records
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l Overview of Query
Queries are one of the most important features of database management system. The process of accessing 
the database and retrieving data selectively is known as querying. Queries often serve as the record source 
for forms and reports. Query is a database object, which is used for extracting data from one or more tables 
based on specific conditions. The set of records returned by a query is known as Dynaset.

Query Types
MS-Access supports many types of queries. The major categories are:
	 1.	 Select Queries: Retrieve records or summaries (totals) across records. Also includes cross-

tabulations.
	 2.	 Make Table Queries: Similar to Select Queries but results are placed in a new table.
	 3.	 Append Queries: Similar to Select Queries but results are added to an existing table.
	 4.	 Update Queries: Modify data in a table.
	 5.	 Delete Queries: Records are deleted from a table.
	 Select queries are the most common queries and can be used for viewing as well as a data source 
for forms, reports, controls, and other queries. The other queries create or change data and are known 
collectively as Action queries.

l Creating a Query
When you want to build a query for your database, there are two ways to create it.
	 1.	 Either use the Query Wizard, or
	 2.	 Use the Design View.

Creating a Query using Query Wizard
To create a query using Query Wizard, perform the following steps:
	 1.	 Start MS-Access 2007. Click the Create tab on the Ribbon. Click Query Wizard button in the Other 

group (see Fig. 4.28).

Fig. 4.28: Clicking Query Wizard

	 2.	 When the New Query window appears, make sure Simple Query Wizard is selected (see Fig. 4.29).

Fig. 4.29: Selecting Simple Query Wizard
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		  Then click the  button to open the Simple Query Wizard.
	 3.	 Choose table. Here, the Student table is already selected in the Tables/Queries list box (see  

Fig. 4.30). Now you have to select the fields that you wish to display in query results datasheet.
	 4.	 Now double-click Stud Name in the Available Fields list. Stud Name should appear in the Selected Fields 

column (see Fig. 4.30).

Fig. 4.30: Selecting fields from Available Fields list

	 5.	 Click the  button. This should add the Father Name field to the Selected Fields list  
(see Fig. 4.31).

Fig. 4.31: Adding more fields to Selected Fields

	 6.	 Double-click Phone Number. This should add the Phone Number field to the Selected Fields list  
(see Fig. 4.32).
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Fig. 4.32: Adding the last field to Selected Fields

	 7.	 Click the  button twice. 
	 8.	 When the final screen appears, type: Select Query (see Fig. 4.33).

Fig. 4.33: Giving title for the query

	 9.	 Click the  button. The query is automatically saved and executed. It should look as shown 
in Fig. 4.34. 

Fig. 4.34: Result of query
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The Simple Query Wizard does not allow you to include criteria to choose which records you want to 
include in the query datasheet. If you want to include criteria in your query, open it in the Design View 
and add the criteria.

Creating a Query in Design View
To create a query using Design View, perform the following steps:
	 1.	 Start MS-Access 2007. Click the Create tab on the Ribbon. Click Query Design button in the Other 

group (see Fig. 4.35).

Fig. 4.35: Clicking Query Design

		  Access displays the Design View and the Show Table dialog box (see Fig. 4.36).

Fig. 4.36: Show Table dialog box

	 2.	 In the Show Table dialog box, select the table that contains the fields you want to display in the query 
datasheet (here, we select STUDENT table), and then click the dialog box’s Add button.

	 3.	 Click the Close button in the Show Table dialog box.
	 4.	 Double-click a field name in the top pane to display the field name in the bottom pane-the design 

grid. Repeat this process to include any additional fields (see Fig. 4.37).

Fig. 4.37: Adding fields to query
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	 5.	 Click the View button in Views group on Home tab to see the datasheet having the data selected with 
your query (see Fig. 4.38).

	 6.	 Click Save button  on the Quick Access Toolbar or press Ctrl + S. Type a name for the query in 
the Save As box (see Fig. 4.39).

	 	

	 Fig. 4.38: Datasheet showing the data	 Fig. 4.39: Saving a query

	 7.	 Click OK.
Select queries display selected fields from table(s). Action queries make changes to a group of records.

l  Overview of a Form
A form is a database object that you can use to enter, edit, or display data from a table or a query. Forms 
are sometimes called “data entry screens”. You can create a database without using forms by simply editing 
your data in the table datasheets. However, most database users prefer to use forms for viewing, entering, 
and editing data in the tables.
	 Forms provide an easy-to-use format for working with the data, and you can also add functional 
elements, such as command buttons, to them. You can program the buttons to determine which data 
appears on the form, open other forms or reports, or perform a variety of other tasks. For example, you 
might have a form named “Student Form” in which you work with student data. The Student Form might 
have a button which opens a help form where you can enter various types of help for that student (say 
financial help).
	 Forms also allow you to control how other users interact with the data in the database. For example, 
you can create a form that shows only certain fields and allows only certain operations to be performed. 
This helps protect data and to ensure that the data is entered properly.

l Creating a Form
MS-Access 2007 gives you new tools (available in the Forms group on the Create tab) to help you create 
forms quickly, and provides new form types and features that improve the usability of your database  
(see Fig. 4.40).

Fig. 4.40: Forms group for creating forms 
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Different Methods of Creating a Form

In Access 2007, forms can be created using the following tools:

	 Form Tool: It creates a form with a single mouse-click. When you use this tool, all the fields from the 
underlying data source are placed on the form. You can begin using the new form immediately, or you 
can modify it in Layout view or Design view to better suit your needs.

	 Split Form Tool: It shows two views for a form, with the bottom half displaying the form using Form 
view while the same form displays in the top half using Datasheet view. The two views are synchronized 
so that scrolling one view causes the other view to scroll to the same location.

	 Multiple Items Tool: When you create a form by using the Simple Form tool, the form that Access 
creates displays a single record at a time. If you want a form that displays multiple records but is more 
customizable than a datasheet, you can use the Multiple Items tool.

	 Form Wizard: It provides more choices for the form’s design than the Form tool. In the Form Wizard, 
available in More Forms, the user is guided through a series of dialog boxes to generate a form, including 
selecting the fields to be included and the form layout.

	 Blank Form Tool: You can use it to build a form if the wizard or the form-building tools do not fit your 
needs. This can be a very quick way to build a form, especially if you plan to put only a few fields on your 
form.

A view is a way of looking at an Access object. Forms have three views: Form view, Layout view, and 
Design view. You can enter, edit, and view data in Form view. You can modify a form in Layout view 
or Design view.

Creating a form using the Form tool 

We assume that you have already created a table (or a query based on one or more tables), and that you 
want to build a form to view or manipulate the data.

	 To create a new form using the Form tool, perform the following steps:

	 1.	 Start Access. In the Navigation Pane (at the left of the database), double-click the table that contains 
the fields for your form. Here, we select STUDENT table. 

	 2.	 On the Create tab, in the Forms group, click Form (see Fig. 4.41).

Fig. 4.41: Clicking Form in the Forms group

		  Access creates the form and displays it in Layout View (see Fig. 4.42). 
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Fig. 4.42: Form created and displayed in Layout View

You can use the Navigation bar to move through the records on a form. 

	 3.	 Click Save button in Quick Access Toolbar and enter a new name for the form (see Fig. 4.43).

Fig. 4.43: Saving a Form

	 4.	 Click OK.
The newly created form has the same name as the source table by default. You can give the form a new 
name by saving the form. 

l Section of a Form
Access forms have several basic sections (see Fig. 4.42). These are given in Table 4.2.

Table 4.2: Form Sections

Form  Section  Description

Form Header Appears at the top of the first page and displays the form 
title.

Page Header Appears at the top of every page and displays the headings 
(field labels) for each column.
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Page Footer Appears at the bottom of every page and displays the page 
number and total number of pages.

Detail Section Appears between the page header and page footer and 
displays the records from the table or query.

Form Footer This section is optional. Appears on the last page of the form 
and displays summary information such as grand totals.

You can switch the view on and off for an area. In Access 2007, locate the Arrange tab from the ribbon 
bar in the Form’s design view and toward the right (end) look for Show/Hide section. You will see two 
on/off buttons one for a Form and the other for a Page.

l Adding Data using Form
Once you have created a form, adding data to a database becomes simple. The record navigation works 
the same way for forms as it works for tables.
	 To add a record to the database using a form, perform the following steps:
	 1.	 Navigate to a new record, either by using the New Record navigation button (the Navigation Bar is 

located in the bottom left of the form as shown in Fig. 4.44), or the New command in the Records 
group on the Ribbon.

	 2.	 Now add the new data in the form (see Fig. 4.44). The data must be entered using an acceptable 
format. (The format are established when the field properties are set.)

Fig. 4.44: Form for Adding data 

	 3.	 Save the data.

l Formatting a Form

After creating a form, you can apply formatting to it. You should still be in Layout View at this point in 
the process. Click the Format tab on the ribbon (see Fig. 4.45). 
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Fig. 4.45: Tools to format a Form

	 Now use these icons to change the color and font of text, the style of gridlines around the fields, include 
a logo and many other formatting tasks. For example, you can adjust the size of the text boxes to fit the 
data, if necessary. 
	 To use the form, switch to Form View. Click the drop-down arrow on the Views section of the Ribbon 
and select Form View (see Fig. 4.46).

Fig. 4.46: Selecting Form View

Performing Calculations in a Form
Expression: Any combination of mathematical or logical operators, constants, functions, and names of fields, 
controls, and properties that evaluates to a single value. Expressions can perform calculations, manipulate 
characters, or test data. Precede each expression with the = operator.
	 In Access 2007, you can use calculation controls to display the results of a calculation. A calculation 
control object containing a formula is created using a text box control object. It is not stored as a field, each 
time the form is opened the results are calculated dynamically. Display a form in Design view to add text 
box control objects.

Text boxes are the most popular choice for a calculation control because they can display so many 
different types of data.
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	 To add Calculation Control Object to form, perform the following steps:

	 1.	 Start Access. Open the form, for adding calculation, in Design view by right-clicking the form in the 
Navigation Pane, and then clicking Design View.

	 2.	 On the Design tab, in the Controls group, click Text Box  (see Fig. 4.47).

Fig. 4.47: Controls group in Design tab

	 3.	 Position the pointer where you want the text box to be placed on the form, and then click to insert 
the text box.

	 4.	 Do one of the following: 
	 (i)	 Place the cursor in the text box, and then type an expression that calculates a total.
	 (ii)	 Select the text box, press F4 to display the property sheet, and type the expression in the Control 

Source property box. To use the Expression Builder to create the expression, click  next to the 
Control Source property box.

	 5.	 Save the form and then switch to Form view to check the results.

	 1.	 Expression Builder is an Access tool that you can use to create an expression. It includes a list of 
common expressions that you can select.

	 2.	 If you need more room to type an expression in the Control Source property box, press SHIFT+F2 to 
open the Zoom box.

	 3.	 When you sort on a calculation control in a form, ensure that the Format property of the control is 
set appropriately. Otherwise, calculated numeric or date values might sort alphabetically instead of 
numerically.

l Main/Subforms

Form is a graphical user interface for the database. Users can enter, edit and even delete data through 
a form. A subform is a form that is inserted in another form. The primary form is called the main form, 
and the form within the form is called the subform. A form/subform combination is sometimes called a 
hierarchical form, a master/detail form, or a parent/child form.
	 Subforms are especially effective when you want to show data from tables or queries that have a one-
to-many relationship (an association between two tables in which the primary key value of each record in 
the primary table corresponds to the value in the matching field or fields of many records in the related 
table). Subforms can be created along with the form or separately.

Creating Subform

	 To create a subform from an existing form, perform the following steps:
	 1.	 Start Access and right click the form, to which you want to add a subform, in the Navigation 

Pane.
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	 2.	 Select Design View.
	 3.	 Select the Design tab.

	 4.	 Select Subform/Subreport  in the Controls group. Before selecting any controls, make sure that Use 
Controls Wizard is selected.

	 5.	 Click once on your form in the location you want to add the subform (see Fig. 4.48).

Fig. 4.48: Selecting location for Subform

	 6.	 Follow the subform wizard to add the subform.
	 7.	 If you already have a form created that you want to use as your subform, drag it from the Navigation 

Pane to your open form. The main form must be open in Layout View.
	 8.	 Click on the Finish button to complete the SubForm wizard.
	 1.	 Adding a subform during the form creation process links the two more easily than adding the subform 

in a different way.
	 2.	 You cannot create a subform in a form if no relationship exists between the two.

l Overview of a Report
Reports are what you use to summarize and present the data in the tables. A report usually answers a 
specific question, such as “What phone numbers are the students having?” Each report can be formatted 
to present the information in the most readable way possible.
	 A report can be run at any time, and will always reflect the current data in the database. Reports are 
generally formatted to be printed out, but they can also be viewed on the screen, exported to another 
program, or sent as e-mail message.

Creating a Report
Access 2007 has several report generation tools (Report tool, Report Wizard, Blank Report tool) that you can 
use to create both detail and summary reports quickly. The Report button creates a simple report that lists 
the records in the selected table or query in a columnar format.
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	 To create a report using the Report button, perform the following steps:
	 1.	 Start Access and open the Navigation pane.
	 2.	 Click the table or query on which you want to base your report. Here, we select STUDENT table.
	 3.	 Activate the Create tab. Click the Report button in the Reports group (see Fig. 4.49).

Fig. 4.49: Clicking the Report button in the Reports group

	 4.	 Access creates your report and displays your report in Layout view (see Fig. 4.50). You can modify 
the report if you want.

Fig. 4.50: Creating a Report
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	 5.	 Click the Save button on the Quick Access toolbar. Access saves the report unless you are saving for 
the first time. If you are saving for the first time, the Save As dialog box appears (see Fig. 4.51).

	 6.	 Type the name you want to give to your report.

Fig. 4.51: Saving the Report

	 7.	 Click OK. Access saves the report. You can now access the report by using the Navigation pane.
Reports created by using the Report button are plain and simple. You can customize a report to meet 
your needs.

l Sections of a Report
Access reports have several sections (see Fig. 4.50). These are given in Table 4.3.

Table 4.3: Report Sections

Report Section Description
Report Header Appears at the top of the first page and displays the report title.
Page Header Appears at the top of every page and displays the headings (field 

labels) for each column.
Page Footer Appears at the bottom of every page and displays the page number 

and total number of pages.
Detail Section Appears between the page header and page footer and displays the 

records from the table or query.
Report Footer This section is optional. Appears on the last page of the report and 

displays summary information such as grand totals.

l Adding Controls to a Report
Controls are objects that display data, perform actions, and let you view and work with information that 
enhances the user interface, such as labels and images. Some controls are created automatically, such as 
the bound text box control that is created when you add a field from the Field List pane to your report. 
Many other controls can be created in Design View by using the tools in the Controls group on the Design 
tab (see Fig. 4.52).

	

Fig. 4.52: Controls group in Design View

	 To determine the name of a tool, place the mouse pointer over the tool. Access displays the name of 
the tool.
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	 To add a control by using the tools in the Controls group, perform the following steps:
	 1.	 Click the tool for the type of control that you want to add. For example, to create a check box, click 

the Check Box  tool.
	 2.	 Click in the report design grid where you want to position the upper-left corner of the control. Click 

once to create a default-sized control, or click the tool and then drag in the report design grid to 
create a control of the size that you want.

	 3.	 If you do not position the control perfectly on the first try, you can move it by using the following 
procedure:

	 (i)	 Click the control to select it.
	 (ii)	 Position the mouse pointer over the edge of the control until the pointer turns into a four-headed 

arrow .
	 (iii)	 Drag the control to the location that you want.
	 This procedure creates an “unbound” control. If the control is the type that can display data (a text box 
or check box, for example), you need to enter a field name or expression in the Control Source property for 
the control before it will display any data. 

To display the property sheet in Design view: On the Design tab, in the Show/Hide group, click Property 

Sheet  Or Press F4.

l Formatting a Report
The easiest and quickest way to apply formatting is by using the Format tab.
	 To format a report, perform the following steps:
	 1.	 Start Access. Open the report you want to format. Here, we open Student Report.
	 2.	 Click Format → AutoFormat (see Fig. 4.53).

Fig. 4.53: Formatting a Report
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		  Each AutoFormat applies a combination of fonts, colors, and border settings. AutoFormat lets you 
change the entire look of your report in one step, but these do not provide you the fine-grained 
control to apply exactly the details you want. Format the report as you want.

	 3.	 Save the report.
To format a report, open it in Layout View. If you double-click a report in the navigation pane, it opens 
in Report View. Right-click the tab title, and then choose Layout View to switch over.

Activity 4.2
Explain about the Database Object Form, its Primary Use, and Demonstrate 

the Steps Required in Creating Form in Design View 

In small groups students will explain about the database object form, its primary use, and demonstrate the 
steps required in creating form in design view.

Form and its Primary Use

A form is a database object that you can use to enter, edit, or display data from a table or a query. You can 
use forms to control access to data. A form makes easy to use the database. You can also add buttons and 
other functionality to a form to automate frequently performed actions.

	 Forms are like windows through which people see and reach your database. An effective form speeds the use 
of your database. A visually attractive form makes working with the database more pleasant and more efficient, 
and it can also help prevent incorrect data from being entered. 

Creating Form in Design View

To create a form in Design View, perform the following steps:

	 1.	 Start MS-Access 2007 and open the database to which you would like to add a new form. Select Form 
Design in Forms group from the Create tab on the Access ribbon (see Fig. 4.54).

Fig. 4.54: Selecting Form Design

		  This will open a blank form in Design View as shown in Fig. 4.55.

Fig. 4.55: Design Tab in Access



Unit 4 – Application Software

	 Information Communication Technology — Grade 10 Student Textbook	 	 111

	 2.	 Make sure that the Design tab under Form Design Tools is open on the Access ribbon. Click on Property Sheet. 
This will open the Property Sheet panel as shown in Fig. 4.56. 

Fig. 4.56: Property Sheet shown in the Right Panel

	 3.	 In the Property Sheet window, click on the tab labeled Data. From the Record Source dropdown list, select 
the table that contains the fields you want to include in your form. Here, we select STUDENT table  
(see Fig. 4.57). 

Fig. 4.57: Selecting a Record Source

	 4.	 Click on the Add Existing Fields button on the Access ribbon. Now, in the right panel, you will see a list of 
all available fields from the table you have selected in Step 3 (see Fig. 4.58).
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Fig. 4.58: Selecting Add Existing Fields

	 5.	 Click on a field in the Field List panel that you wish to add to the form. Hold down the mouse key and 
drag the field to the position on the form where you want it to be located. After placing the field, you 
can resize both the field label and content boxes by clicking and dragging the boundary boxes around the 
field name. Repeat this process for each field you want to add to the form (see Fig. 4.59).

Fig. 4.59: Adding fields by clicking and dragging

		  At any time during this process, if you want to have an idea of how the final form will look, click on the 
View button on the Access ribbon and select Form View (see Fig. 4.60).



Unit 4 – Application Software

	 Information Communication Technology — Grade 10 Student Textbook	 	 113

Fig. 4.60: Form View

		  To return to your form design in order to make some changes, click View again and choose Design View.

	 6.	 When finished designing the form, click the Save icon in the Quick Access Toolbar (or click the Office 
button and select Save). Enter a name for the form in the pop-up box that appears on the screen (see  
Fig. 4.61).

 Fig. 4.61: Saving Form

	 7.	 Click OK and the new form will be visible in the Forms list.

	      Key Concepts
	 	 A table contains data about a particular topic. In a table, data is arranged in row and column format.

	 	 A database is a collection of related data that is organized, so that it can easily be accessed, managed and 
updated.

	 	Databases are used in many applications, covering almost the entire range of computer software. For example, 
computerized library systems, ATMs, flight reservation systems and computerized inventory systems etc. 

	 	Query is a database object, which is used for extracting data from one or more tables based on specific 
conditions.

	 	 A form is a database object that you can use to enter, edit, or display data from a table or a query.

	 	MS-Access 2007 has several report generation tools (Report tool, Report Wizard, Blank Report tool) that you 
can use to create both detail and summary reports quickly. 



Unit 4 – Application Software

114	  	 Information Communication Technology — Grade 10 Student Textbook

Review Questions

Fill in the Blanks

	 1.	 A ........................... in a database is a predefined format of rows and columns that define an entity.

	 2.	 ........................... is a database object, which is used for extracting data from one or more tables based on 
specific conditions.

	 3.	 In Access, a ........................... is a form that is inserted in another form.
	 4.	 The ........................... button creates a simple report that lists the records in the selected table or query in 

a columnar format.

State Whether True or False
	 1.	 A column of information in a table is called a record.
	 2.	 A data type specifies the type of data that a column in a table represents in a database.
	 3.	 A field that uniquely identifies each record stored in a table is called the foreign key of the table. 
	 4.	 You cannot use the Navigation bar to move through the records on a form. 

Multiple Choice Questions
	 1.	 The formula =$A$1 is using which type of reference?
		  (a)	 Relative			   (b)	 Mixed
		  (c)	 Absolute			   (d)	 None of these
	 2.	 Which of the following function will return the rank of a number in a list of numbers?
		  (a)	 SUM( )			   (b)	 RANK( )
		  (c)	 AVERAGE( ) 			   (d)	 MIN( )
	 3.	 Data duplication is also called
		  (a)	 Data Recovery			   (b)	 Data Error 	
		  (c)	 Data Reply			   (d)	 Data Redundancy
	 4.	 MS-Access 2007 database file names end with the file name extension
		  (a)	 .pptx			   (b)	 .accdb	
		  (c)	 .xlsx			   (d)	 .docx

Match the Following

Column A Column B
1. 	Extension of MS-Excel 2007 files (a) A simple expression created by using operators and 

cell addresses
2. Spreadsheet Formula (b)  .xlsx 
3. Query (c) Automated Teller Machines(ATMs)
4. Database application (d) Used for extracting data from one or more tables 

based on specific conditions
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Answer the Following
	 1.	 Define a database and explain some common uses of database.
	 2.	 Define the following terms in context of a database system:
	 (i)	 Table	 (ii)	 Record	 (iii)	Field
	 (iv)	 Data type	 (v)	 Primary key
	 3.	 What is a form? Explain the use of a form. Give the steps to create a form in Access 2007 using Design 

View.
	 4.	 Explain the following in Access 2007:
	 (i)	 Creating a query	 (ii)	 Manipulating Access Controls
	 (iii)	 Performing calculation in a form	 (iv)	 Creating a subform

Suggested Activities
	 1.	 Decide three own database structures.
	 2.	 Add, edit, delete, and sort records in a table.
	 3.	 Explain about query in general and the different types of query and demonstrate methods of creating a 

query.
	 4.	 Identify the options for creating a form such as Form tool, Split Form tool, Multiple Items tool, Form 

Wizard and Blank Form tool.
	 5.	 Explain and demonstrate the sections of a form in a database.
	 6.	 Perform calculations in a form and create a subform.
	 7.	 Perform report by formatting. 

Field Trip
	 Using the Internet or computer magazines, look up information on Microsoft Access 2010. List any features 

you find. List which of these features appeal to you and describe why they do.
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Using internet

   Unit Outcome
	 Students will be able to:

	 	 understand the history and advantages of the Internet;

	 	 recognize the use of browsers and search engines;

	 	 know downloading and uploading files;

	 	 understand how to design a simple webpage.

5.1 overview of the internet

The Internet is the network of networks around the world (see Fig. 5.1). It is made up of thousands of 
smaller, national, regional, governmental, academic and commercial networks. It is a global network.

Fig. 5.1: The Internet

	 You have studied the basic concepts of using Internet in Grade 9. Let us extend our knowledge about 
the Internet further.

Development of the Internet
The first step towards the construction of Internet was taken by U.S. Department of Defense in 1969, when 
they approved a project named ARPANET (acronym for Advanced Research Projects Agency NETwork). 
This project was started to connect computers of different universities and US Defense in such a manner that 
the network could even survive after a nuclear attack. This was possible by having multiple communication 

Unit 5   
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paths between any two computers in the network. In case one or two paths got damaged, communication 
could proceed through the other paths. The users of this network were able to share data and communicate 
by using short text messages. Soon developments started in this project and several rules of communication 
were developed and adopted by all users of ARPANET.
	 To use ARPANET, a university was required to have a research contract with the Department of Defense. 
Due to this problem, in 1970’s the NSF (U.S. National Science Foundation) created a common network 
called CSNET which allowed dial-up connections to ARPANET. The idea of CSNET was simple but it was 
a grand success. By 1980’s around 200 computers were connected to this network. 
	 Research and development in the field of network resulted into the formation of a new, high-capacity 
and more speedy network called NSFNET. This network got an instantaneous success and forced NSF to 
think for a better and fast version of it. The research led to the creation of a new network called ANSNET 
(Advanced Network Services) in 1992. In 1995, a more advanced version of the network called VBNS (Very 
high speed Backbone Network System) was developed and it replaced ANSNET from the market. In 1995, 
a new name was given to the collection of these networks and is now called THE INTERNET. The number 
of computers being connected to the Internet doubles in less than a year.

l Advantages and Disadvantages
In the history of mankind, the Internet is the greatest development in the field of ICT. Like other inventions, 
the Internet has a number of advantages and disadvantages. The advantages of the Internet are so huge in 
number that they outperform the disadvantages quite easily.

Advantages of the Internet
The Internet provides many facilities to the people. Some advantages of the Internet are given below:
	 1.	 Sharing and collecting information: You can share and collect information on every topic of the 

world on the Internet 24 hours a day. The students, writers, engineers, scientists and many other 
people can interact with one another to get guidance and to share knowledge, etc. Sharing and 
collecting information through Internet is a very easy, cheap (in some cases free of cost) and fast 
method.

	 2.	 E-commerce: E-commerce means conducting business activities online. It is not only widening 
consumers, choice of products and services but is also creating new businesses and compelling 
established businesses to develop Internet strategies. E-commerce has become a fantastic option 
through which you can shop anything.

	 3.	 News: People get latest news of the world on the Internet. Most of the newspapers of the world 
are also available on the Internet via their websites. These websites are periodically or immediately 
updated with latest news when any event happens around the world.

	 4.	 Advertisement: Today, most of the commercial and non-commercial organizations advertise through 
Internet. It is a very cheap and efficient way of advertising. The organizations present their products 
with attractive and beautiful ways to the people all over the world.

	 5.	 Communication: Using Internet you can communicate with others all over the world. You can 
talk by watching to one another; just as you are talking with your friends at your home. Different 
services provided on the Internet for this purpose are:

	 (i)	 E-mail		  	 (ii)	 Chatting
	 (iii)	 Video conferencing		 (iv)	 Internet telephony, etc.
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	 6.	 Formation of communities: Internet helps in formation of communities or forums. Here, a number 
of people can participate in different types of debates and discussions to express their views and 
gather valuable knowledge.

	 7.	 Entertainment: Internet also provides different types of entertainments to the people. You can play 
games with other people in any part of the world. Similarly, you can see movies, listen music, etc. 
You can also make new friends on the Internet for enjoyment.

	 8.	 Online learning: Internet provides the facility for online learning. Many websites have lectures and 
tutorials on different subjects or topics for learning. You can download these lectures or tutorials 
and go through these repeatedly to get a lot of knowledge. It is a very cheap and easy way to get 
education.

	 9. 	Services: A variety of services are offered via Internet, for example job searching, online banking, 
online results, buying movie tickets, airlines and railways schedules, hotel reservations and 
consultation services (e.g., medical help), etc. When you avail these services offline, they become 
more expensive.

Disadvantages of the Internet
Although Internet has many advantages but it also has some disadvantages. The main disadvantages of 
Internet are given below:
	 1.	 Virus threat: Virus is a program that interrupts the usual operation of the PCs. Computers linked to 

the Internet have high probability of virus attacks and as a result of this their hard disks can crash, 
giving the users a lot of trouble.

	 2.	 Spamming: Spamming denotes distribution of unsolicited e-mails in large numbers. They are 
meaningless and they unnecessarily block the whole system. These activities are treated as illegal.

	 3.	 Security problems: The valuable websites can be damaged by hackers and your valuable data may 
be deleted. Similarly, confidential data (like name, address and credit card number) may be accessed 
by unauthorized persons.

	 4.	 Pornography: Pornography is definitely harmful for the children. There are numerous pornographic 
sites available over the Internet and watching any of those can have very bad influence on the 
mental health of the children. These websites damage the character of new generation.

	 5.	 Filtration of information: When a keyword is given to a search engine for searching information of 
a specific topic, a large number of related links are displayed. In this case, it becomes difficult for 
the users to filter out the required information.

	 6.	 Accuracy of information: A lot of information about a particular topic is stored on the websites. 
Some information may be incorrect or not authentic. So, it becomes difficult for the Internet users 
to select the correct information. Sometimes they may be confused.

	 7.	 Wastage of time: A lot of time is wasted by Internet users to collect the information on the Internet. 
Some people waste a lot of time in chatting or to play games. At home, school and offices, most of 
the users use Internet without any positive purpose.

	 8.	 English language problems: Most of the information on the Internet is available in English language. 
So, those people who do not know English may find it difficult to avail the facility of Internet.

l Keywords and Connectors
First of all, let us define keyword and connectors:
	 Keyword: The subject word or words of the topic you wish to find in a web search.
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	 Connectors:  These are symbols and words you can use in conjunction with your keywords to qualify 
their relationships and meaning. For example AND, OR, NOT.

Searching Information
Portals are the websites that provide search engines, plus content and services such as e-mail, shopping 
etc. For example, Google, Lycos, AltaVista, Yahoo! etc. Figure 5.2 shows the Yahoo! portal.

Fig. 5.2: Yahoo! Portal

	 Useful Tip

Find Who is Running Website

Be careful about the information found on the web. To find out who is running a site, go to  
www.internic.com and use the Registry Whois link to search the database of the registered domain names. 
Always remember that the information posted on the web does not mean that it is true.

	 When searching information, it is important to know about different types of searches. You can use 
keywords and connectors in a search on the Internet. Let us discuss about using keywords and Boolean 
operators or connectors in a search for information:
	 Keyword Search: At the top of each portal’s home page is a blank space into which you can type 
a keyword to locate the websites that offer the information you need. For example, if you want to 
search information about “famous Ethiopian Restaurants”, then Ethiopian Restaurants is the keyword. 
This way you do not have to plow through menu after menu of subject categories. The results of your 
keyword search will be displayed in a short summary of documents containing the keyword you typed  
(see Fig. 5.3).
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Fig. 5.3: Using keywords for searching information

	 Searching Using Connectors: Most search sites use symbols called Boolean operators or connector 
words (AND, OR, NOT) between search terms to make information searching more precise than is possible 
with just keyword searching.
	 AND is a connector that connects two or more search words and means that all of them must appear 
in the search results. Use AND to narrow your search. For example,
                                     Ethiopian culture AND History 
	 Both ‘Ethiopian culture’ and ‘History’ will be present in the search (see Fig. 5.4)

Fig. 5.4: Using connector AND for searching information

	 OR is a connector that connects two or more search words and indicates that any of the two may appear 
in the results. Use OR to expand your search. For example,
                                          Ethiopian culture OR History 
	 Any one of ‘Ethiopian culture’ or ‘History’ will be present in the information.
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	 NOT is a Boolean connector. When inserted before a word, it excludes that word from the results. For 
example,

Ethiopian culture NOT History

	 Search will contain ‘Ethiopian culture’ but not ‘History’.

Before you begin searching for information on the Internet, you should identify keywords related to 
your topic. Keywords differ from topic to topic in a search. Searching the Internet is a skill that comes 
with experience.

l Downloading and Uploading Files

Downloading Files
Downloading is transmitting data from a remote computer to a local computer. Downloading enables 
users to save files on their own computers for later use, which reduces the time spent online and the 
corresponding charges. Some downloading sites are: 
	 (i)	 www.moviesanddownloads.com	 (ii)	 www.brothersoft.com
	 (iii)	 www.filehippo.com	 (iv)	 download.cnet.com
	 The Internet has a lot of information. You can download information (e.g., pictures, video clips, sounds 
and software) from the Internet and install it on your computer. Some are copyrighted but many are 
free.
	 Let us download and install TypingMaster Pro a typing tutor from the following address:

http://www.TypingMaster.com/gettmPro.asp
	 We are using Internet Explorer and Windows XP. If you are using a different browser such as Mozilla 
Firefox or a different version of Windows, your screens may look a little different, but the same basic steps 
should work.
	 1.	 Open Internet Explorer and go to the site www.TypingMaster.com to download a typing tutor.
	 2.	 Select Products and click Start Download button on this page. A download dialog box appears. Click 

Start Download option on this dialog box (see Fig. 5.5). 

Fig. 5.5: Clicking Start Download option
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	 3.	 The downloading process starts and after some time the Download complete dialog box is displayed 
(see Fig. 5.6). 

Fig. 5.6: Download complete dialog box

	 4.	 Click the Open button. Some other dialog boxes will appear during the installation process.  
Figure 5.7 shows the Setup Wizard.

Fig. 5.7: Setup Wizard
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	 5.	 Click Next button and then follow the steps given in Setup Wizard. Now click Install button for 
installation. Click Finish button to exit setup.

	 1.	 For using a downloaded graphic file, you can open the file in a graphics package, or paste it in a 
word document. The picture files on web pages are usually stored in either .jpg or .gif format since 
these are compressed, giving small files which are quick to load. 

	 2.	 If the downloaded file is a ZIP file (extension .zip to make quick download), you will need an 
unzipping program to read these ZIP files. Common unzipping programs are WinZip and PKZIP 
etc. 

Uploading Files
Uploading is the transmission of data from a local computer to a remote computer, as from your PC to a 
website you are constructing. It allows users to easily exchange files over networks.
	 Internet offers you to access data from anywhere. You can save your files in some central location on 
the Internet that will allow you to access the files from anywhere.
	 Figure 5.8 shows the website www.easy-share.com which can be used for file uploading.

Fig. 5.8: Website www.easy-share.com for uploading files

	 There are many other websites available on the Internet for uploading files. You can use these websites 
to upload files from your computer. Some of these are:
	 (i)	 www.mirrorcreator.com	 (ii)	 www.megaupload.com	 (iii)	 www.uploading.com
	 (iv)	 www.dotnetnuke.com	 (v)	 www.filefactory.com	 (vi)	 www.mediafire.com

5.2 Definition of WWW

The World Wide Web (WWW) or the Web is an interconnected system of Internet computers (called 
servers) that support specifically formatted documents in multimedia form—sounds, photos, and video as 
well as text. 
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	 A broader definition of WWW comes from the organization that Web inventor Tim Berners-Lee helped 
found, the World Wide Web Consortium (W3C):
	 “The World Wide Web is the universe of network-accessible information, an embodiment of human 
knowledge.”

l Webpage
A webpage is a document on the World Wide Web that can include text, pictures, sound and video.  
Figure 5.9 shows a webpage.

Fig. 5.9: A Webpage

l Website
A computer with a domain name is called a website (site).  The website of your school is probably on the 
campus. Figure 5.10 shows the website www.ethiopianairlines.com. 

Fig. 5.10: Website www.ethiopianairlines.com
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	 The first page you see at a website is like the title page of a book. This is the home page, or welcome 
page, which identifies the website and contains links to other pages at the site. Large websites have a large 
number of pages.

Types of Websites
Websites are of two types: Static and dynamic website.

Static Website
A static website is one that has web pages stored on the server in the format that is sent to a client web 
browser. It is primarily coded in Hypertext Markup Language  (HTML).
	 Visitors are not able to control what information they receive via a static website, and must instead 
settle for whatever content the website owner has decided to offer at that time.

Dynamic Website
A dynamic website is one that changes or customizes itself frequently and automatically, based on certain 
criteria. Dynamic websites can have two types of dynamic activity: Code and Content. Dynamic code is 
invisible or behind the scenes and dynamic content is visible or fully displayed.
	 The main purpose of a dynamic website is automation. A dynamic website can operate more effectively, 
be built more efficiently and is easier to maintain, update and expand. It is much simpler to build a 
template and a database than to build hundreds or thousands of individual, static HTML web pages.

Differences between Webpage and Website
The main differences between a webpage and a website are given in Table 5.1.

Table 5.1: Differences between Webpage and Website

Webpage Website

1. It is a document on the World Wide Web that 
can include text, pictures, sound and video.

1. It is a computer with a domain name.

2. It is a single page. 2. It is composed of a single/multiple pages. 

Uses of the WWW
The Web is the most widely known part of the Internet. Some uses of the WWW are given below:
	 1.	 Web has the social value for all people. In other words, it enables human communication, 

commerce, and opportunities to share knowledge irrespective of their hardware, software, network 
infrastructure, native language, culture, geographical location, or physical or mental ability.

	 2.	 It can be accessed by a number of different kinds of devices, for example, mobile phones, smart 
phones, PDAs (Personal Digital Assistants), interactive television systems, voice response systems, 
kiosks and even certain domestic appliances.

	 3.	 It is used as a communications tool and allows anyone from anywhere to share information, for 
example, blogs, wikis and social networking.

	 4.	 It is a giant repository of linked data as well as a giant set of services that exchange messages, which 
one to use often depends on the application.

	 5.	 It has transformed the way we communicate with each other. In doing so, it has also modified the nature 
of our social relationships. People now “meet on the Web” and carry out commercial and personal 
relationships, in some cases without ever meeting in person.



Unit 5 – Using Internet

126	  	 Information Communication Technology — Grade 10 Student Textbook

l Web Server
Web server is a particular computer on the Internet that hosts websites, serving pages to viewers upon 
request. This service is referred to as web hosting. Every web server has a unique address so that other 
computers connected to the Internet know where to find it on the vast network. 
	 Web hosts rent out space on their web servers to people or businesses to set-up their own websites. The 
web server allocates a unique website address to each website it hosts.

l Web Technology
Web technology is the technology related to World Wide Web. The format used on the web is called 
Hypertext Markup Language (HTML). It is not, however, a programming language.
	 Let us discuss some of the web technologies that relate to the interface between web servers and their 
clients.

HTML (Hypertext Markup Language)

It is a set of special instructions (called “tags” or “markups”) that are used to specify document structure, 
formatting, and links to other multimedia documents.
	 In HTML, every command is surrounded by < and >. And in most commands, you need to tell the web 
browser when to end this command. You do this by putting a slash (/) in front of the ending command. 
Since HTML is not case sensitive, <title> is the same as <TITLE>, which is same as <TITLe>. Next you 
want to decide what you want to put up on your page. Text, links, graphics, and text fields are just a few 
ideas.

HTTP (Hypertext Transfer Protocol)
It is the network protocol used to deliver virtually all files and other data (collectively called resources) on 
the World Wide Web, whether they are HTML files, image files, query results, or anything else. Usually, 
HTTP takes place through TCP/IP sockets. 
	 A browser is an HTTP client because it sends requests to an HTTP server (Web server), which then 
sends responses back to the client.

URL
A URL (Uniform Resource Locator) is the unique address for a file that is accessible on the Internet. A 
common way to get to a Website is to enter the URL of its home page file in your Web browser’s address 
line. The URL contains the name of the protocol to be used to access the file resource, a domain name that 
identifies a specific computer on the Internet, and a pathname, a hierarchical description that specifies the 
location of a file in that computer. For example, consider the following URL of a website about Gambella 
National Park in Ethiopia.
	 Protocol	 Domain name	 Directory name	 File (document) name 
		  (Web server name)	 or path	 and extension 
              http://realethiopia.com/nature/national-parks/gambella-national-park.html
	 Here,	 http:// is Hypertext Transfer Protocol
		  realethiopia.com/ is the domain name
		  nature/national-parks/ is the path 
		  gambella-national-park.html is the particular page or document 
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Locating Information Contents
You can locate information contents on a Web page by interacting with hyperlinks, radio buttons (little 
circles located in front of various options), and fill-in text boxes. Some Web pages have Search boxes which 
can be useful as well (see Fig. 5.11).

Fig. 5.11: Hyperlinks on a Webpage

	 Hyperlinks enable you to navigate the Web by clicking words, icons, pictures or other graphics on a 
Web page. When a hyperlink is pointed, the mouse pointer changes to a pointing hand. At the same time, 
the Web browser status bar shows you the URL associated with the hyperlink to which you are pointing.
	 Text hyperlinks are often underlined or displayed in a different color than the rest of the text on a Web 
page. Graphics-based hyperlinks can be icons, logos, buttons, and photographs etc.

Clicking a hyperlink is just one way to access a specific URL. If the URL of a page to be visited is already 
known, you can type it into the Address bar and press the Enter key.

5.3 Planning and developing Web Pages

Planning is most important for creating a Website, whether your site will have one page or many. 
Collect the information you want to include on your web pages, such as text, images etc. Divide the 
information you gathered into sections. Each section should be a separate web page.
	 If you want to start a business online or just have your own personal website, you will need to design 
a web page, determine any hyperlinks, and hire the space on a web server or buy one of your own. 
Professional web page designers can produce a website for you, or you can do it yourself using a menu-
driven program included with your web browser or a web-design software package such as:
	 (i)	 Microsoft FrontPage	 (www.microsoft.com/frontpage)
	 (ii)	 Macromedia Dreamweaver	 (www.macromedia.com)
	 (iii)	 Macromedia Flash	 (www.brothersoft.com)
	 After you have designed your web page, you can put it on your ISP’s server. Figure 5.12 shows a web 
designing website.
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Fig. 5.12: Web designing website (www.wysiwygwebbuilder.com)

l Web Design Guides (e.g., color, text, image etc.)
Web pages generally contain text, images, videos and music etc. For displaying a page correctly, the web 
browser needs to know about the structure of the webpage, e.g., which part is a heading, which part is 
a list, which part is an image etc. To give the browser this information, we have to write the web pages 
in a language, called Hypertext Markup Language (HTML), the browser will understand. The browser 
translates the HTML into a readable document which is displayed on the web.
	 HTML tells the browser what data to display on the webpage, but it does not tell it what that data 
should look like, e.g., what color the text and background should be, what font to use, how big the text 
should be etc. If we keep the HTML file as it is, the browser simply uses its default styles. But we can 
specify how the webpage should look using another language called Cascading Style Sheets (CSS).
	 One must take time to educate himself/herself before he/she begins web design. Otherwise it may result 
into wastage of time. If the website can engage the users through an interesting and compelling design, 
half the work is done. Be careful when selecting the colors, text and images.  

Color

Select your colors very carefully, as colors affect people’s mood. Bright colors, such as yellow and orange, 
cause you to become more cheerful or happy. Colors such as blue and purple have a calming effect. Dark 
colors, such as brown and black, have a depressing effect.
	 A good rule of thumb is to use colors based on the type of effect you are trying to achieve. However, 
it is always best for your text areas to have a white background with black text.

Text
Text is one of the most important parts of a web page. The way in which you display the text on your 
web page will have a great impact on its success. It can make your page look very professional or very 
unprofessional.
	 When placing text within your web page, always be consistent with your fonts i.e., do not use different 
fonts throughout your pages. The standard fonts used on the Internet are Arial and Verdana as they are 
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the easiest to read on a computer screen. The standard text size is 2. Headlines, which require a larger font 
size, are a bit different. A popular headline font used is Georgia, as it displays nicely in a slightly larger 
font size. 
	 Busy backgrounds make the text difficult to read and draw the attention away from the text. In addition, 
always be consistent with your background theme on each page of your site.

Image
An image might be the focal point of a web page. Your eye is drawn to an image because it is an image, not 
because of the position it has in the layout. So, look at the other elements on the page to make small changes 
(e.g., position and spacing etc.) to the elements and margins around the image to create an interesting 
design. Also the captions should go with each image separately.
	 Align your images. Balance the graphics and text on a page. When you are considering your layout, 
remember that images are a major part of the design, not just afterthoughts.

• Purpose of a Website
A website can be designed for business, sharing information or personal interest. The designer should 
consider a number of things before actually building a website. The first step should be to decide about the 
purpose of the website. i.e., “Why am I building this website?” Clearly defining the purpose of a website 
before its creation will ensure that the website is optimized to achieve the required purpose. 
	 The purpose of a website influences its style, the website technologies required, the hosting costs and 
the budget required for it. So, the purpose of a website must be clearly identified.  Some of the purposes 
of designing websites are:
	 1.	 Making money: A website built to make money will require things like a customer’s payment for 

the purchased items and security features to protect his/her information. For a good impression of 
business the website must give a professional appearance. 

	 2.	 Sharing information: A website may not require as many features for sharing information as is 
meant for business. The designer has to consider if he/she is going to allow visitors to add comments 
or additional resources to the website. This would require additional features from his/her website 
hosting.

	 3.	 For family and friends: Websites for family and friends would have a less formal feel. For this 
type of website the designer has to consider if his/her family and friends will be permitted to 
automatically add to its contents. Again, this would require additional features from his/her website 
hosting.
Whether the purpose is to reach local customers or the entire world, a properly designed website will 
serve any organization well. By determining the purpose, the content and layout of the website can be 
properly developed.

• Designing a Web Architecture
A well designed website will be surely helpful to the website visitors. Suppose you have got a lot of stuff 
that you want to put on the web, and you wish people to look at it. Best option is that you arrange it on 
a single webpage. But if there is a lot of information, it will take too long to load and the website users 
would not be able to find what they want easily. All the information may not be relevant to the users and 
it will require a lot of searching to filter it out. 
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	 For designing web architecture we need to: 
	 (i)	 split  the stuff up, and
	 (ii)	 provide ways for users to find their way through it to get what they want.
	 Some basic patterns (or models) to design web architecture are:
	 1.	 All-in-One: This is the simplest possible model (see Fig. 5.13). All the information is placed on a 

single Home page.

Fig. 5.13: All-in-one model

	 2.	 Flat: In a flat pattern (or monocline grouping) all the web pages are arranged as peers and everyone 
is accessible from every other one (see Fig. 5.14). This is very common for simple websites, where 
there are a few standard topics, such as: Home, About Us, Products, Services, Contact Us.

Fig. 5.14: Flat pattern

	 3.	 Index: An index structure is like the flat pattern, with an additional list of contents (see Fig. 5.15).

Fig. 5.15: Index structure

		  An index is often organized in some way, to make stuff easier to find. For example, a list of files in 
a web directory (the index page), or could be an index of student’s names ordered by last name.

		  Indexes work well when there is a medium amount of data, and also when that data can be ordered 
in a way that makes it easier to scan to what you want.

	 4.	 Strict Hierarchy: A strict hierarchy describes a system where the user can only access a lower-level 
webpage via its parent (see Fig. 5.16).
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Fig 5.16: Strict hierarchy

	 This pattern is applicable to a real-world model where there is a strict parent-child relationship between 
objects, such as arranging web pages for an organization’s offices by their country. For example, let the 
head office of a company be in Ethiopia and a sub office cannot be in more than one country.
	 Although this is a strictly hierarchical real-world model, it does not mean that a strict hierarchy is the 
best way to represent it online, for example, a person can serve in more than one office. 

• Identify Contents for the Website
Content is the ‘stuff’ that makes up a website. This could be words (text), pictures, images or sounds. Web 
content means content in a textual nature. Content therefore in this sense is the ‘information’ a website 
provides.
	 To serve the intended purpose, the site must contain complete and relevant information. Ensuring 
appropriate content will satisfy users and prevent losing potential business. Website content can be broken 
into two categories: general and detailed. 
	 1.	 General Content: This provides a brief overview of the website, organization, products and services, 

and other items. Brief descriptive information helps users in determining that what they seek is 
available, directs them to the appropriate specific data, peaks their interests, informs them of other 
available items at the site, and gives them a feel for the content and layout of the site. 

	 2.	 Detailed Content: This provides users with the specific detailed information on the website, 
organization, products and services, and other items. The layout of the website must ensure easy 
access to the detailed information, and specific information they seek. 

	 A website is a valuable tool for businesses and other organizations when composed of the right material 
(content). So, we conclude that a website having appropriate contents can perform an outstanding job. 

A website can provide useful but irrelevant information like: links to other websites, public service 
notices, or information on Web and Internet items that may interest many expected website visitors. 

Activity 5.1
Designing and Implementing a Simple Web Page

Students in groups will design and implement a simple Web page and present it in the class.

Perform the following steps to plan the Web page:

	 1.	 Open a text editor (preferably NotePad).

	 2.	 Write the basic format, or skeleton, of a HTML page.
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	 3.	 Save it as a HTML file.

	 4.	 View it in a web browser.

Now, perform the following steps to actually create a Web page:

	 1.	 Open a new file by selecting the New command under File in NotePad (see Fig. 5.17). 

	 2.	 Save this file as first.html file. This indicates that the file is an HTML file that will be used on the Web. 

	 3.	 Begin the page with the <html> tag. 

	 4.	 The following tag is <head>. 

	 5.	 Use <title> tag to give title of the page. The title should be related to the information provided by the 
page. The complete tag looks like this:

		  <title>Planning A Trip To Ethiopian National Parks</title>

	 6.	 Close the head tag with </head>.

	 7.	 Use the body tag <body> to start the body of the page. You can use attributes such as bgcolor. The tag 
used here is

		  <body bgcolor=purple>

		  This sets the background color of the page.

	 8.	 The title tag alone puts a title in the title bar, so to add a title within the page let us use Heading 1, aligned 
in the center of the page and white in color:

		  <h1 align=center><font color=White>A Trip to Ethiopian National Parks </h1></font>

	 9.	 An image adds life to a Web page. To insert an image use the image tag. We want to surround the image 
with paragraph tags so there would be space between the text and the image and want to align the image 
to the center of page. The tag looks like this: 

		  <p align=center><img src=“Gambela.jpeg”></p> 

		  You can give the name of another picture here, instead of Gambela.jpeg (if you want) from your 
computer.

	 10.	 The page contents should be readable. So, pay attention to the color and size of text to be used. 

		  <font face=“arial, geneva” color=green size=+1><b>Attractions</b> </font>

		  After this tag, add the text you want. Lastly, do not forget to put the </font> tag. 

	 11.	 Let us use <ul> tag for an unordered list to show details, also select blue, and arial/geneva font.

		  <p><font face=“arial, geneva” color=blue>

		  The font tag is not closed here because we want to continue using this font in the following text. 

	 12.	 The <ul> tag starts the list and to add bullets use the <li> tag. This list item tag does not need to be 
closed. After completing the list end it with </ul> 

      <p> <ul>

            <li> Gambela National Park

            <li> Bale National Park

            <li> Awash National Park

            </ul>

	 13.	 End the font tag from Step 11 like this: </font>. End the paragraph from Step 12 like this:

		  </p></font>
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	 14.	 End the paragraph from Step 11 like this: </p>

	 15.	 End the body like this: </body>. 

	 16.	 Lastly, end the html tag like this: </html>. Don’t forget to save your file. 

		  The HTML coding is shown in Fig. 5.17.

Fig. 5.17: HTML coding for a Web page

Now open the web browser and select the file first.html using following sequence of  steps:

FILE → OPEN → BROWSE → C:\My Documents\FIRST.HTML 

The page will look in the Web browser as shown in Fig. 5.18.

Fig. 5.18: Web page after implementation
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	      Key Concepts
	 	Some advantages of the Internet are: Sharing and collecting Information, E-commerce, News, Advertisement, 

Communication, Formation of communities, Entertainment, Online Learning, Services etc.

	 	Downloading is transmitting data from a remote computer to a local computer.

	 	The World Wide Web (WWW) or the Web is an interconnected system of Internet computers (called servers) 
that support specifically formatted documents in multimedia form—sounds, photos, and video as well as 
text. 

	 	A computer with a domain name is called a website (site). Websites are of two types: Static and dynamic 
website.

	 	The purpose of a website influences the style, the website technologies required, the hosting costs and the 
budget required for it.

Review Questions

Fill in the Blanks
	 1.	 Computers linked to the ........................... have high probability of virus attacks and as a result of this 

their hard disks can crash, giving the users a lot of trouble.
	 2.	 ........................... is the subject word or words of the topic you wish to find in a web search.
	 3.	 ........................... is the transmission of data from a local computer to a remote computer, as from your 

PC to a website you are constructing.
	 4.	 A ........................... is a document on the World Wide Web that can include text, pictures, sound and 

video. 

State Whether True or False
	 1.	 People cannot get latest news of the world on the Internet.
	 2.	 Most search sites use symbols called Boolean operators (OR, AND, NOT) between search terms to make 

searching more precise than is possible with just keyword searching. 
	 3.	 Web server is a particular computer on the Internet that hosts websites, serving pages to viewers upon 

request.  
	 4.	 Website content can be broken into two categories: general and detailed. 

Multiple Choice Questions
	 1.	 Which of the following is/are advantage(s) of the Internet?
	 	 (a)	 Sharing and collecting information	 (b)	 E-commerce 
	 	 (c)	 Entertainment	 	 	 (d)	 All of these
	 2.	 Which of the following is not a Boolean operator?
	 	 (a)	 AND	 	 	 (b)	 OR
	 	 (c)	 GOT	 	 	 (d)	 NOT
	 3.	 ........................... is transmitting data from a remote computer to a local computer.
	 	 (a)	 Downloading	 	 	 (b)	 Uploading	
	 	 (c)	 Home Page	 	 	 (d)	 Dynamic Website



Unit 5 – Using Internet

	 Information Communication Technology — Grade 10 Student Textbook	 	 135

	 4.	 A unique address of the website is referred to as
		  (a)	 University Related Locker	 (b)	 Uniform Resource Locator
		  (c)	 Union Resource Locality	 (d)	 File Transfer Protocol

Match the Following

Column A Column B
1. HTTP (a) Security problems

2. Disadvantage of Internet (b) Static and dynamic 

3. Types of websites (c) It has the social value for all people

4. Use of WWW (d) Hypertext Transfer Protocol

Answer the Following
	 1.	 What is Internet? List its advantages and disadvantages.
	 2.	 What is the use of keywords and connectors in a search? Explain with examples.
	 3.	 Define the following terms:
	 (i)	 Webpage	 (ii)	 Website	 (iii)	 Web Server	 (iv)	Web Technology
	 4.	 List some uses of the WWW.
	 5.	 How will you design a simple Webpage and implement it?

Suggested Activities
	 1.	 Explain the brief history of the Internet.
	 2.	 Describe with examples, how to select a keyword.
	 3.	 Explain how pages belong to a person, organization or government. One day they might have their own 

web page!
	 4.	 Demonstrate locating information contents.
	 5.	 Explain and demonstrate how to incorporate the features of a design into a webpage.
	 6.	 Describe how the Internet can be searched to find information and comment on how this information 

could be used by people.

Field Trip
	 Visit some reputed educational institutions and business houses to prepare a list on the following topic and 

present it in your ICT class.
	 How has the Internet affected our lives? 
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Control and 
Learning with Logo

   Unit Outcome
	 Students will be able to:

	 	 understand the logo language;

	 	 recognize techniques in programming using the logo language.

6.1 CONTROL AND LEARNING WITH LOGO

In Grade 9, you have learnt about LOGO (Logic Oriented, Graphics Oriented) language. You already 
know that, LOGO is one of the easiest and simplest computer languages. We can perform various functions 
using LOGO such as drawing figures, typing text and performing calculations. To perform any action, 
LOGO uses a triangle shaped turtle that moves on the computer screen. The LOGO turtle can draw and 
perform actions when you give a command. The LOGO commands are also known as primitives.
	 A LOGO procedure is a set of Logo commands which are given to perform a particular task. In this 
Unit, you will learn about using variables in writing Logo procedures and creating recursive procedures 
in Logo. The version of LOGO that we are using is MSW LOGO (Windows based), which is available 
from Softronics, Inc. as a freeware on the Internet.

Starting LOGO

To start Logo, perform the following steps: 
	 Click Start → All Programs → Microsoft Windows Logo → Microsoft Windows Logo

OR

	 Double click on the MSW Logo icon  on the desktop of your computer.
	 The MSWLogo Screen will appear. Now, you can use the primitives, perform calculations and write 
procedures as per your requirement. 

Exiting LOGO
To exit LOGO, type BYE in Command Input Box.

Unit 6   
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l Using Variables
A variable is the name of a memory location that contains a value.  
	 In the RAM (Random Access Memory) of a computer each memory location has an integer address 
associated with it. The memory locations store data used by programs and these are given symbolic names. 
Once a variable has a name, we can use and manipulate it.
	 In LOGO, variables are given names which are strings of letters. For example, NUM, LEN, SIZE, X 
etc.
	 Defining Variables: The variables in LOGO are defined with the MAKE statement. For example,
	 MAKE “NUM 50  ; variable NUM is assigned a value of 50 
	 MAKE “LEN 20   ; variable LEN is assigned a value of 20 
	 MAKE “X :X + 1   ; variable X is incremented by 1 

Using Variables in Writing Procedures
In Grade 9, you have written LOGO procedures using:
	 1.	 the Input Box.
	 2.	 the Editor window.
	 In LOGO, variables can be “attached” to the procedure names. Variables are used for making a procedure 
more flexible. You must remember that a : (colon) is used before a variable in Logo procedures. You must 
not use Logo keywords as variables. Consider the following examples:
	 Example 1: Write a procedure to draw a square which lets the user enter a length for the side. 
	 TO SQUARE :LEN	 ; LEN is the length of the side
	 ; Procedure SQUARE has a variable :LEN
	 CS	 ; Clear Screen
	 REPEAT 4 [FD :LEN RT 90] 
	 HT	 ; Hide Turtle
	 END 
	 Type the following in the Command Input Box (there must be atleast one blank space between Square 
and value of Len to be given) and press the Enter key to run the procedure:

SQUARE 50 

This draws a square of side length 50 on the graphics screen as shown below:

	 What does the LEN value produce? 
	 This draws a square of the side of length inputted by the user.

In the above example, the : (colon) tells LOGO that :LEN is a  variable rather than procedure name.  We 
have also used :Len with FD primitive also, that is, where the variation is required.
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	 Example 2: Write a procedure to create circles with a variety of radii.
	 TO CIR :R	 ; R is the radius of circle
	 ; Procedure CIR has one variable  :R
	 	 CS	 ; Clear Screen
		  CIRCLE  :R
	 	 HT	 ; Hide Turtle
	 END 

	 Type the following in the Command Input Box and press the Enter key to run the procedure:

CIR 60
This draws a circle of radius 60 on the graphics screen as shown below:

	 Example 3: Write a general procedure for drawing regular polygons having two variables, N the number 
of sides and LEN the length of its side. 
	 TO POLY :N :LEN	 ; N is the number of polygon sides and  LEN is length of the sides
	 ; Procedure POLY has two variables :N and :LEN
	 	 CS	 ; Clear Screen
	 	 REPEAT :N [FD :LEN RT : 360/N]
	 	 HT	 ; Hide Turtle
	 END
	 Type the following in the Command Input Box and press the Enter key to run the procedure:

POLY 5 40
This draws a pentagon of side length 40 on the graphics screen as shown below:

	 Example 4:  Write a procedure to create rectangles with varying lengths of side.
	 TO RECTANGLE :L :B	 ; L is the length and  B is the breadth 
	 ; Procedure RECTANGLE has two variables  :L and :B
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		  CS	 ; Clear Screen
	 	 REPEAT 2 [FD : L  RT 90 FD :B] 

	 	 HT	 ; Hide Turtle

	 END 

	 Type the following in the Command Input Box and press the Enter key to run the procedure:

RECTANGLE 100 50
This draws a rectangle of length 100 and breadth 50 on the graphics screen as shown below:

l Using Recursive Procedures
Recursion is the process where a procedure calls itself. It is available in nearly all computer languages 
including LOGO. A recursive procedure is a procedure that uses itself as one of its parts.

	 In Logo, the easiest way to get a computer to do something over and over (and over and over) 
is recursion. A Logo procedure is called recursive if it calls itself as a sub procedure. In other words, a 
recursive procedure repeats itself. 

	 If the last statement in a procedure is a call to this procedure itself again, then the computer will never 
stop running the procedure. There are two ways to stop recursion:

	 1.	 Click HALT to stop running the program.

	 2.	 Use a condition inside the procedure to stop it after a certain number of repetitions. For example, 
using a counter in the procedure. 

Creating Recursive Procedures 
As mentioned earlier, you can create recursive procedures in LOGO. Consider the following examples:

	 Example 1: The following procedure draws a square of side length 100 using an infinite recursion. 

	 TO SQUARE1

	 ; Procedure SQUARE1 uses infinite recursion

		  FD 100 RT 90

	 	 SQUARE1            ; Call to procedure SQUARE1 itself

	 END

	 Type the following in the Command Input Box and press the Enter key to run the procedure:



Unit 6 – Control and Learning with Logo

140	  	 Information Communication Technology — Grade 10 Student Textbook

SQUARE1 
This draws a square of side length 100 on the graphics screen as shown below:

	 It will run until you click HALT to stop it!
	 In this procedure, the first two lines are drawing a square with side 100. But before the program ends, 
LOGO meets the word SQUARE1 again. The word ‘SQUARE1’ starts it all over again, so we get an endless 
loop with the square of length of side 100 is drawn at the same place again and again.
	 Example 2: The following procedure draws squares of sides of varying length LEN using an infinite 
recursion. 
	 TO SQUARE2 :LEN
	 ; Procedure SQUARE2 uses infinite recursion
	 	 REPEAT 4[FD :LEN RT 90]
	 	 SQUARE2 :LEN+10               ; Call to procedure SQUARE2 itself
	 END

	 Type the following in the Command Input Box and press the Enter key to run the procedure:

SQUARE2 1
This draws squares of varying lengths on the graphics screen as shown below:

	 It will run until you click HALT to stop it!
	 In this procedure, the first two lines are drawing a square with the side you have given. 
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	 But before the program ends, LOGO meets the word SQUARE2 again, this time with ten units added 
to the side. The word ‘SQUARE2’ starts it all over again, so we get an endless loop with the square getting 
bigger and bigger. 

Using a Condition to Stop Recursion
We probably would like a procedure to run a fixed number of times rather than going on forever. We can 
stop a procedure by using a ‘conditional’ line. For example, edit the procedure SQUARE2 by using in an 
extra line as follows: 

EDIT “SQUARE2

	 TO SQUARE2 :LEN
	 ; Procedure SQUARE2 uses recursion and stops conditionally
	 	 REPEAT 4[FD :LEN RT 90]
	 	 IF :LEN > 300 [STOP]
	 	 SQUARE2 :LEN+10	 ; Call to procedure Square2 itself
	 END

	 Type the following in the Command Input Box and press the Enter key to run the procedure:

SQUARE2 1 
This draws squares of varying lengths as shown below:

	 What do you observe? LOGO checks how big the length of side LEN is every time the program loops. 
If the answer is greater than 300, the program is stopped. 
	 Example 3: The following procedure countdowns from a given number. 
	 TO COUNTDOWN :NUM	
	 ; Procedure COUNTDOWN uses recursion
	 	 IF :NUM = 0 [STOP]	 ; Condition test
	 	 LABEL :NUM FD 20 RT 5	 ; LABEL command prints value of : NUM and moves turtle
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	 	 COUNTDOWN :NUM–1	 ; Procedure call also reduces the value of :NUM by 1
	 END
	 Type the following in the Command Input Box and press the Enter key to run the procedure:

COUNTDOWN 10
This will give the following output:

The process where a LOGO statement calls or runs itself is called RECURSION. A recursive procedure 
is one which ‘turns back on itself’.

  Activity 6.1
Produce a Simple Snow Flake Outline

Students in groups will produce a simple snow flake outline and present it in the class.

	 To produce a simple snowflake outline, perform the following steps:

	 1.	 Start LOGO and open the Editor window.

	 2.	 Type the following procedures:

			   TO TRIANGLE	 ; Procedure TRIANGLE to create a triangle 

				    ST	 ; Show Turtle

				    REPEAT 3 [FD 20 RT 120]

				    HT	 ; Hide Turtle

			   END

			   TO HEX 	 ; Procedure HEX to create hexagon using the TRIANGLE procedure

				    REPEAT 6 [TRIANGLE RT 60]   ; Call to procedure TRIANGLE

			   END

			   TO SNOWFLAKE  ; Procedure to create snowflake using the HEX procedure

				    REPEAT 6 [HEX FD 40 HEX BK 40 RT 60 HEX]   ; Call to procedure HEX

			   END
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	 3.	 To run the procedure SNOWFLAKE, type the following in the Command Input Box and press the Enter 
key:

			   Snowflake

		  The following output will be displayed on the Graphics screen:

	      Key Concepts
	 	LOGO is one of the simplest and easiest computer languages.

	 	 A LOGO procedure is a set of Logo commands which are given to perform a particular task.

	 	 Variables are used for making a procedure more flexible.

	 	 Recursion is the process where a procedure repeats itself.

Review Questions

Fill in the Blanks

	 1.	 The LOGO commands are also known as ...........................
	 2.	 A ........................... is the name of memory location that contains a value.
	 3.	 A LOGO procedure is called ........................... if it calls itself as a sub procedure.
	 4.	 To exit LOGO, type ........................... in Command Input Box.

State Whether True or False
	 1.	 LOGO is the most difficult computer language.
	 2.	 We can use variables in LOGO procedures.
	 3.	 Recursive procedures cannot be written in LOGO.
	 4.	 We click HALT to stop the running of a LOGO program.

Multiple Choice Questions
	 1.	 MSW LOGO uses simple ........................... commands.
		  (a)	 English			   (b)	 Planning	
		  (c)	 Discussion			   (d)	 All of these
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	 2.	 Which of the following LOGO primitive clears the screen and returns the mouse to its home position?
		  (a)	 FD			   (b)	 LT	
		  (c)	 CS			   (d)	 PU
	 3.	 In LOGO, when accessing a variable’s value you must put a ........................... in front of the variable 

name. 
		  (a)	 =			   (b)	 :
		  (c)	 ?			   (d)	 *
	 4.	 All LOGO procedures begin with “To” and end with ........................... .
		  (a)	 ;	 	 	 (b)	 Stop
		  (c)	 Exit			   (d)	 End

Match the Following

Column A Column B
1. MSW LOGO (a) are ignored by MSW LOGO

2. Variables (b) is the process where a LOGO word calls or runs itself

3. Lines with a semicolon (;) in front (c) is graphical in nature

4. Recursion (d) make a LOGO procedure more flexible

Answer the Following
	 1.	 How will you use variables in writing procedures in LOGO? Explain with suitable examples.
	 2.	 Write a LOGO procedure using variable to draw circles.
	 3.	 What will the following LOGO procedure do?
	 	 TO SPIRAL :SIZE :ANGLE
	 	 	 IF :SIZE > 400 [STOP]
			   FD :SIZE RT :ANGLE
	 	 	 SPIRAL  :SIZE+2 :ANGLE
		  END
	 4.	 How will you create a recursive procedure in LOGO? Explain with suitable examples.

Suggested Activities
	 1.	 Create rectangles with varying lengths of sides.
	 2.	 Produce a simple snowflake outline.
	 3.	 Have full version of the LOGO language.
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glossary

A

	 Absolute Reference: Commonly used in 
spreadsheet applications, it is a formulated cell 
reference that will not adjust when used to calculate 
the sum of specific cells.
	 Access: A database program which is a part of the 
Microsoft Office suite of programs.
	 Application Software: A program that is designed 
to perform specific tasks.

B

	 Backup: To copy files or data to a second source or 
media so as to safeguard it. 
	 Blog: (Slang term for a Weblog) A blog is a personal 
journal that can be accessed publicly and allow people 
to comment on the previously posted comments.
	 Browser: Software program that allows the user to 
find and read encoded information in a form suitable 
for display especially on World Wide Web.

C
	 Cell: Intersection of a row and column in a 
worksheet.

	 CD-ROM (Compact Disc Read-Only Memory): 
A durable and low cost circular optical storage device 
widely used to store large amounts of information.
	 Copyright: New technologies have raised all kinds 
of new issues relating to copyright—mainly because it 
has become so easy to copy materials from a variety of 
digital sources.
	 CPU (Central Processing Unit): A processor on 
an IC chip (called a microprocessor) that serves as the 
‘brain’ of the computer. 

D
	 Database: A structured collection of data that can 
be used for a variety of purposes.
	 Data Communications: The moving or sharing 
of encoded information between two or more data 
sources using an electronic medium.

	 DBMS (Database Management System): 
Application software which enables the storage, 
modification, retrieval, and querying of data in a 
database.
	 Distribution List: Also called a mailing list, is a 
collection of e-mail addresses that allows you to e-mail 
multiple people at one time.
	 Domain Name System: An addressing system 
in which abbreviations are used to indicate the type 
of organization or entity instead of whole name, for 
example, .edu for educational institution.
	 DVD: Digital Versatile Disc or Digital Video Disc.

E
	 E-Commerce: Buying and selling or business 
transaction conducted on the Internet.
	 E-Mail: Stands for Electronic Mail. This is a system 
of relaying messages across the Internet, from one 
Internet user to another.
	 EPROM: Erasable Programmable Read-Only 
Memory (“ee-prom”). It is a memory chip whose 
contents can be erased by a mechanism using ultraviolet 
light and reprogrammed for other purposes.

F
	 Forms: Used to provide an easy to use interface for 
user to enter, view and modify data in a table.
	 Format Painter: Helps to copy the format that has 
been applied to text and apply it to another.
	 Freeware: This is a shortened version of Free 
Software. Programmers offer their work without 
wanting pay in return.
	 FTP (File Transfer Protocol): A software protocol 
for exchanging information between computers over a 
network.

G
	 Gigabyte (GB): 2 to the 30th power (1,073,741,824) 
bytes. One gigabyte is equal to 1,024 megabytes. 
	 GIGO: It is an acronym that stands for Garbage In, 
Garbage Out.
	 Google: A popular search engine.
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	 GUI (Graphical User Interface): A program 
interface that takes advantage of the computer’s 
graphics capabilities to make the program easier to 
use. Well-designed graphical user interfaces can free 
the user from learning complex command languages.

H
	 Hacker: A person who spends his/her time trying 
to gain access to information stored on other people’s 
computers all around the world.
	 Hardware: The physical equipment used in a 
computer system, such as the CPU, peripheral devices 
and memory.
	 Home Page: The initial page of a site on the World 
Wide Web.
	 HTML (Hypertext Markup Language): It is a 
collection of structuring and formatting tags used to 
create Web pages.
	 HTTP (Hypertext Transport Protocol): The 
standard protocol for transferring hypertext documents 
on the World Wide Web. 
	 Hyperlinks: A word or graphic display on one 
web page that allows a computer to shift to another 
related web page.
	 Hypertext: A method of storing data through a 
computer program that allows a user to create and 
link fields of information at will and to retrieve the 
data non-sequentially.

I
	 Icon: A picture or symbol to represent a command 
on a computer screen.
	 IDE (Integrated Development Environment): 
A programming environment integrated into an 
application.
	 Internet Explorer: A browser produced by the 
Microsoft Corporation and supplied together with the 
Windows operating system.
	 IT (Information Technology): The development, 
implementation, and maintenance of computer 
hardware and software systems to organize and 
communicate information electronically.
	 Integrated Circuit (IC): A circuit of transistors, 
resistors, and capacitors constructed on a single 
semiconductor wafer or chip, in which the components 
are interconnected to perform a given function.
	 Internet: The Internet is a network of networks 
all of which use the same set of communications 
protocols. 
	 Intranet: A private network for communications 
and sharing of information that, like the Internet, is 

based on TCP/IP but is accessible only to authorized 
users within an organization. An organization’s 
intranet is usually protected from external access by a 
firewall.
	 ISP (Internet Service Provider): A company that 
provides access to the Internet.

J
	 JAVA: A high-level programming language 
developed by Sun Microsystems.
	 Joystick: A device that looks a bit like a gear lever 
in a car. This is connected to a computer and is used 
mainly for controlling the cursor in fast action games.

K
	 Kilobyte (KB): This is about a thousand bytes of 
space. In reality, it is two to the 10th power or 1,024 
bytes.

L
	 LAN (Local Area Network): A network that 
links together computers and peripheral equipment 
within a limited area, such as a building or a group of 
buildings.
	 Language Processor: Software that converts a 
high level language or assembly language code into 
machine understandable form.
	 Login: To attach to a computer using the user’s 
ID.
	 LOGO (Logic Oriented, Graphics Oriented): 
A high level programming language specifically 
designed for its ease of use and graphics capabilities. 

M
	 Megabyte (MB): About a million bytes of space. 
Actually it is 2 raised to the 20th power or 1,048,576 
bytes of space.
	 Memory: Internal storage areas in the computer.
	 MODEM: Stands for MOdulator and DEModulator. 
It is a device that changes data from digital (computer 
language) to analog (phone line language) and then 
back again.
	 Motherboard: The main circuit board of a 
microcomputer.
	 MS-Access: Database application software, 
provided by Microsoft.
	 MS-Excel: Spreadsheet application software, 
provided by Microsoft.
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	 MS-PowerPoint: Presentation software, provided 
by Microsoft.
	 MS-Word: Word processing application software, 
provided by Microsoft.

N
	 Navigation: It is the process of finding the way, 
i.e., navigating, around a series of menus within a 
computer program or finding the way around the 
World Wide Web by means of a browser.
	 Netiquette: The rules of etiquette that apply when 
communicating over computer networks, especially 
the Internet. 

O
	 Offline: Not connected to a computer or network 
of computers.
	 Online: Connected to a computer or network of 
computers, especially the World Wide Web.
	 Outlook: A popular e-mail program, part of the 
Microsoft Office suite of programs.
	 Output: Anything that comes out of a computer 
after being processed.
	 Output Device: A device that translates information 
processed by the computer into a form that humans 
can understand.

P

	 PDF (Portable Document Format): A technology 
developed by Adobe and was designed to capture all 
of the elements of a printed document and place it in a 
single image file.
	 Pen Drive: A secondary storage device that can be 
used to easily transfer files between USB-compatible 
systems.
	 Portal: A Webpage, website or service that acts as 
link or entrance to other websites on the Internet.
	 Printout: Anything produced on a printer after 
being processed by a computer program.
	 Primary Key: A set of one or more values in a 
database that uniquely identifies a record in a table.
	 Primitives: The LOGO commands are known as 
‘Primitives’.
	 Procedure: The sequence of actions or instructions 
to be followed in solving a problem or accomplishing 
a task. It may be used at one or more points in a 
computer program.
	 Programmable Read-Only Memory (PROM): 
A special memory chip that is blank when first 

purchased. It can be written by the user by using a 
special hardware program. Once the data is written to 
it, it cannot be erased or changed.
	 Protocol: A set of rules governing the format of 
messages that are exchanged between computers.

Q
	 Query: Used to retrieve information on a certain 
condition from a database.

R
	 RAM (Random Access Memory): A volatile 
computer memory available to the user for the 
temporary storage and manipulation of data. 
	 Relative Reference: The default reference in a 
spreadsheet package.
	 Reports: Used to present data in a printed format.
	 ROM (Read-Only Memory): A memory in which 
program instructions, operating procedures, or other 
data are permanently stored, generally on electronic 
chips during manufacture, and that ordinarily cannot 
be changed by the user or when power is switched 
off.

S
	 Scroll Bar: A widget found in graphical user 
interface and used to show and control which portion 
of a document is currently visible in a window. A 
window may have a horizontal or, vertical scroll bar, 
or both.
	 Scanner: A device used to convert hard copy, e.g., 
a printed page, photograph or photographic negative, 
into a form that can be stored on a computer.
	 Server: This is a mainframe computer that serves 
the other computers attached to it.
	 Sheet Tab: In spreadsheet applications, this refers 
to a tab at the bottom of a worksheet that acts as a 
means to identify or access different sheets within a 
workbook.
	 Slide Show: Used to display the slides in a desired 
sequence.
	 Source Code: Program code written in a high level 
language.
	 Social Networking: A term applied to a type of 
website where people can seek other people who share 
their interests, find out what’s going on in their areas 
of interest, and share information with others.
	 Source data: Data for which the chart is prepared.
	 Software: The set of instructions used to direct 
the operation of a computer, as well a documentation 
giving instructions on how to use them.
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	 Spreadsheet: A document which helps to organize 
data in rows and columns that intersect to form cells.
	 System: A combination of the hardware, 
software, and firmware. A system typically consists 
of components (or elements) which are connected 
together in order to accomplish a specific function or 
set of functions.
	 System Software: It is a set of master programs 
that keeps the computer system working. 

T
	 Task bar: The bar that contains the start button 
and appears by default at the bottom of the desktop.
	 TCP/IP: Acronym for Transmission Control 
Protocol/Internet Protocol, the suite of communications 
protocols used to connect hosts on the Internet.
	 Terabyte (TB): 2 to the 40th power 
(1,099,511,627,776) bytes.
	 Trojan: A type of computer virus that is loaded 
into an unsuspecting users system via a host program 
such as a free game.
	 Turtle: A triangular shape pointer used in LOGO 
that helps in drawing figures.
	 Twitter: A microblogging facility that allows users 
to post very short texts (maximum 140 characters) 
containing snippets of information about what they are 
doing at a given moment, news items, links to websites 
or comments on events.

U
	 Uploading: It means transmitting data from a local 
computer to a remote computer, as from your PC to a 
website you are constructing.
	 UPS (Uninterruptible Power Supply): It is a 
backup power unit that provides continuous power 
when the normal power supply is interrupted.
	 URL (Uniform Resource Locator): A protocol for 
specifying addresses on the Internet. It is an address 
that identifies a particular file on the Internet, usually 
consisting of the protocol as http, followed by the domain 
name.

V

	 Videoconferencing or Video Conferencing: A 
computer-based communications system that allows 
a group of computer users at different locations to 
conduct a “virtual conference” in which the participants 
can see and hear one another as if they were in the 
same room participating in a real conference.

	 Virus: A program or piece of code that is loaded 
onto your computer without your knowledge and 
runs against your wishes.

W
	 W3C (World Wide Web Consortium): An 
international non-profit organization which acts as a 
resource centre for the World Wide Web, and is active 
in setting technical standards.
	 WAN (Wide Area Network): A network in 
which computers are connected to each other over 
a long distance, using telephone lines and satellite 
communications.
	 Webcam: A camera connected to a computer and 
linking it to the Internet.
	 Web page or Webpage: A single, usually hypertext 
document on the World Wide Web that can incorporate 
text, graphics, sounds, etc.
	 Web server: A computer that runs specific software 
to serve web pages to the Internet.
	 Web site: A connected group of pages on the 
World Wide Web regarded as a single entity, usually 
maintained by one person or organization and 
developed to a single topic or several closely related 
topics.
	 Wizard: A utility that provides guided sequence to 
perform complex task easily and quickly.
	 Word Processor: Software that processes textual 
matter and creates organized documents.
	 Workstation: The computer attached to the 
Internet.
	 WWW (World Wide Web): Series of servers or 
computers that are interconnected through hypertext.
	 WYSIWYG: What You Say Is What You Get.

X
	 XML (eXtensible Markup Language): It is a markup 
language, not limited to Web documents.

Y
	 YouTube: A website to which we can upload our 
own video clips and view video clips uploaded by 
others: http://www.youtube.com.

Z
	 Zip Disks: The disks with a special high-quality 
magnetic coating that have a capacity of 100, 250 or 
750 megabytes.
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